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Preface

SPSS Data Entry isatool for fast and flexible survey design and data collection,
offering a drag-and-drop interface for devel oping both printed and online data entry
forms. Data Entry also helps prepare your datafor analysis because when you specify
the questions and responses that appear on your forms, you also define the variables
you'll useto run analyses.

SPSS Data Entry is designed to be used with statistical software from SPSS Inc.
Y ou can read your Data Entry filesinto and out of SPSS programsat will. Throughout
the documentation, tips and techniques are described to help you get the maximum
benefit from both Data Entry and your data analysis software.

Data Entry Builder and Data Entry Station

You can purchase Data Entry Builder by itself or in combination with multiple copies
of Data Entry Station, depending on your needs.

m DataEntry Builder includes everything that you need to build custom forms, enter
data, and check datafor accuracy using rules.

m DataEntry Stationisascaled-down version of SPSS Data Entry intended only for
entering or checking data. If you have alarge team, buying one or more copies of
Data Entry Station in combination with Data Entry Builder can speed the data
entry process by allowing more people to get involved.

Serial Numbers
Your seria number isyour identification number with SPSSInc. You will need thisseria

number when you contact SPSS Inc. for information regarding support, payment, or an
upgraded system. The seria number was provided with your SPSS Data Entry package.



Customer Service

If you have any questions concerning your shipment or account, contact your local
office, listed on the SPSS Web site at http: //mww.spss.com/worldwide/. Please have
your serial number ready for identification when calling.

Training Seminars

SPSS Inc. provides both public and onsite training seminars. All seminars feature
hands-on workshops. Seminars will be offered in major cities on aregular basis. For
more information on these seminars, contact your local office, listed on the SPSS Web
site at http://mww.spss.com/wor ldwide/.

Technical Support

The services of SPSS Technical Support are available to registered customers of SPSS
Data Entry. Customers may contact Technical Support for assistance in using SPSS

DataEntry or for installation help for one of the supported hardware environments. To
reach Technical Support, seethe SPSSWeb site at http: //mwww.spss.com, or contact your
your local office, listed on the SPSS Web site at http: //www.spss.com/worldwide/. Be
prepared to identify yourself, your organization, and the serial number of your system.

Tell Us Your Thoughts

Your comments are important. Please let us know about your experiences with SPSS
Data Entry. We especialy like to hear about new and interesting applications using
SPSS Data Entry. Please send e-mail to suggest@spss.com, or write to SPSS Inc.
Marketing Department, Attn.: Director of Product Planning, 233 South Wacker Drive,
11th Floor, Chicago, IL 60606-6412.

Contacting SPSS

If youwould liketo be on our mailing list, contact your local office, listed on the SPSS
Web site at http://www.spss.com/wor ldwide/.
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Chapter

Data Entry Overview

SPSS Data Entry is a powerful tool for fast, accurate data entry—and much more.
When you need data fast and clean, you need SPSS Data Entry.

Design survey questionnaires. Data Entry is a powerful tool for building forms and
guestionnaires. You can choose from a number of sample surveysto help you get
started, copy preformatted questions from question libraries, or build your own forms
from scratch. You can also generate forms from existing SPSS datafiles.

Create paper and online forms. You may find that you can use the same form in print
that you use online, or you can devel op aternate versions of aform—one optimized
for online data entry, the other used for your printed questionnaire. You can map
guestions on both formsto acommon set of variables so that if you later make changes
to one of your variables (for example, to thewording of aquestion), questions on both
forms are updated automatically.

Successful surveys begin with well-defined questions. Too often, researchers consider
how to enter and analyze their data only after they’ve mailed their questionnaires. In
Data Entry, as you create your questions and responses, you also define the variables
you'll use to conduct your analyses. Theresult is datathat are not only clean but also
ready to analyze.

Fast, efficient data entry. Data Entry has a number of featuresto speed online data
entry. You can create Skip & Fill rulesto automatically fill in specific questions based
on previous responses or use Table Entry view to quickly enter datainto atabular grid
similar to a spreadsheet.

Enter clean data. Create Validation rules to ensure that data are entered correctly the
first time, or use Checking rulesto screen for logical inconsistencies (for example, if
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amale respondent claimsto be pregnant, you most likely have an error). You can also
check for errorsin your existing data files. Double-entry verification is available using
the file compare facility.

Analyze your data using statistical software from SPSS. SPSS Data Entry is designed to
be used with statistical software from SPSS Inc., maker of powerful tools for data
analysis. You can read your Data Entry files into and out of SPSS programs at will.
Throughout the documentation, tips and techniques are described to help you get the
maximum benefit from both Data Entry and your data analysis software.

Steps for Using SPSS Data Entry

Forms

A typical user conducting a survey would work through the following steps:

m Build aform or questionnaire, complete with questions, variables, and rules.
m Distribute or administer the questionnaire.

m Collect, enter, and clean data.

m  Anayze the data using statistical software from SPSS.

Alternatively, you can use the checking facility to check your existing datafiles or
generate aform from an existing datafile.

A file can have one form or many forms, each composed of questions. The form
toolbox includes tools to create custom questions with different types of response
contrals, including multiple response questions, and tool s to quickly arrange groups of
questions in atabular matrix. You can also add text annotations, pictures, and other
elements.

Data Entry Builder allows you to use the same form for online data entry that you
use for your printed questionnaire, which saves you time. (For online data entry, you
can use either Data Entry Station 4.0 or the Data Entry Enterprise Server 4.0.) You can
also develop aternate versions of aform—one optimized for online data entry, the
other used for your printed questionnaire, and both linked to acommon set of variables.
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Figure 1-1
Use the same form online and in print
Customer Satisfaction Survey
Product (select all that apply) Would you recormend this product?
O Fax Machine O Yes
O Copier O Mo
Howe would you rate your averall Did the product ever fail to operate?
satisfaction with this product? O Yes
O ery satisfied O Mo Jf no, skip to the next section

O Sr\mn...lnn¢ ik

o & Online Entry Form =] E3

ov File Edit “iew Data Bules Help
oo M4 ko] £]

Customer Satisfaction Survey

Product (select all that apply) Wiould you recommend this product?

O s O ves

O Copier O Mo

How weould you rate your overall Did the product ever fail to operate?
satisfaction with this product? O Yes

QO very satisfied O Mo Ifno, please skip to the next section
O Somewhat satisfied

O Somewhat dissatisfied Did you contact us to fix the problem?

O very Dissatisfied O Yes

QO No Answer O Mo

-
1| | 3

Ready (372 BiSkip&FilOn  [AutoCheck:On 2
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Questions and Variables

Questions are the foundation of any survey and the building blocks of dataentry forms.
Each question on aform has one or more controls that allow users to enter aresponse.
A number of control types are available, including text boxes, check boxes, option
buttons, and drop-down lists.

Figure 1-2
Variables displayed in Builder window
4 Builder [_ (O]
File Edit “iew [nzet Bulez Help
] == e s = A ﬁl %|EIE
El ? I)(- | | |<,.'.-.,|| Farmss j E=t
Wariable/S et | Label | Farmnat | File Order =
ﬂg $product Product
ﬂa $shop Shopping Locations
@ BIRTH Birth v'ear Murnber[F4.0] 1
< COMTFAIL Contact Becausze of Problem Mumber(F2.0] E
@ COFIER Copier Murnber[F2.0] 16
< EDUC Education Lewel Mumber(F2.0] 12
@ FalL Product Operation Failure Murnber[F2.0] ]
< F Fax Machine Mumber(F8.0] 15
@ FIMCOME Farnily Income Murnber[F2.0] 13 o
#» PROBMEET Ewpectations Mumber(F2.0] T
@ QAL Overall Cuality Murnber[F4.0] 3
% RECOMMD Recommend Product Mumber(F2.0] 2
@ REGIOMN Region Murnber[F2.0] 14 P
1 I _'I_I
Feady T

Answersto questions are stored in variables. The variables are created as you define
your questions so that you' |l be ready to enter dataand run your analyseswhen thetime
comes. For example, the question Date of purchase? might be bound to avariable
named pdate. In fact, you can think of a question as a representation of one or more
variables on aform.
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Rules

Rules can validate data as they are entered, check logical relationships between
variables, or automaticaly fill in or skip over specified questions. You can add rulesto
your forms to ensure that data are clean as they are entered or use the data checking
facility to identify problems with existing data files. Beyond simple data validation,
rules can check logical relationships between variables (for example, if gender equals
mal e, then pregnant must be no) or speed data entry by automatically filling in data
based on responses to specific questions.

Figure 1-3

Rule Wizard

HAule Wizard - Start

Thiz wizard creates one or more miles, Rules operate
during data entry and checking.

w'hich twpe of rule would vou like to create?

€ Walidates a single variable [Walidation]

LChecks a logical relationship between
variahles [Checking)

Give the rule a name: Irule'l

& Sets values of variables, and skips ta
questions [Skip & Fill]

TRa454

Iy Do you want to see the wle that the wizard
generates? Click on the pencil ba view it.

< Hack Heut » Cancel Help
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Collecting, Entering, and Cleaning Data

You can gather dataviatraditional mail or by conducting interviews over the phone or
in person. Use Data Entry Builder or Data Entry Station to enter responses from
interviews or printed questionnaires. Purchase multiple copies of Data Entry Station to
increase your team’s productivity by distributing the task of entering data among team
members, even across multiple sites.

For example, suppose you have several offices conducting phone interviewsin
different parts of the country. At the end of each day, each site sends you afilevia
e-mail containing the cases entered that day, and you merge the data from all of the
sitesinto asingle file (using the Add Files utility).

Once the data are entered, you can use the data checking facility to identify and
report errors. Y ou can clean the datain either Data Entry or your statistical software
program. If you want to be doubly safe, double-entry verification is also available.

Analyzing Data Using SPSS Software

SPSS Data Entry isdesigned to be used with statistical softwarefrom SPSSInc., maker
of powerful tools for data analysis. Whether you need simple reporting and summary
statistics or in-depth analysis using advanced statistical procedures, such as Factor,
Reliability, or Cluster Analysis, SPSS offers products to meet your needs.

Figure 1-4
Cases displayed in SPSS Data Editor

Data Editor _ O] x|

Eile Edit Yiew Data Transform  Statistics  Graphs  Utltes  Window  Help

28|38 B o] 5| =|k| & £l BEE [ 2

| 5
fax copier satisf recommd fincome
1 M Yfasg Somewhat satisfied Yes $35000 to $44 9
2 Mo Yas Yery satisfied Yes $26 000 to $34 9
3 Wesg Yeg Yery satisfied Yes $35 000 to $44 9
4 Yes Mo | Somewhat dissatisfied Mo $E5 000 to $74 9
L] o

|SF'SS Frocessor is ready | | o
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Data Entry savesdatain a standard SPSS datafile, a spreadsheet-like format with rows
and columns. Each row is a case, and each column is avariable. For example, if you
ask 100 people 10 questions, you'd have adata file with 100 cases (rows). The number
of variables that you have depends upon the types of questions and your survey. For
example, if your survey has 10 questions, and each question has 5 check-box answers,
your survey will have at least 50 variables. Each case has information about one
submitted survey, and variables store the answers to questions.

Throughout the documentation, ti psand techniques are described to hel p you get the
most from both Data Entry and your data analysis software.

Data Entry Product Components

Depending on your needs, you can purchase Data Entry Builder by itself or in
combination with multiple copies of Data Entry Station. You can aso purchase the
SPSS Data Entry Enterprise Server.

Data Entry Builder

Data Entry Builder includes everything that you need to build custom forms, enter data,
and check datafor accuracy using rules. Builder offers an easy-to-use graphical
environment for defining variables and questions, developing custom forms, and
creating Validation, Skip & Fill, and Checking rules to ensure that the data are clean.
Sample surveys and question libraries are also included. If you're aloneresearcher or a
one-PC shop, asingle copy of Data Entry Builder should have everything that you need.
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Figure 1-5
Form window, Builder window, and toolbox

& Forml [_ (O] x|

Fil= Edit “iews Layout Bules Help

(6] SR omle] o] 20| | alE ==

$ Builder [_[OIx]

File Edit “iew Insert Rulez Help

D= 2= 2= nlﬁl_lgl fﬁ|§|g
|_?|X|i"'|$:| |<AIIFDrms> -

Mame | Title | Comments |

D Form1 Form1

Ready l_ A
Data Entry Station

Data Entry Station is a scaled-down version of SPSS Data Entry intended only for
entering or checking data. While you cannot use Data Entry Station to create new
surveysor datafiles (these tasks must be donein Data Entry Builder), you can add data
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toanexisting file. Similarly, you can userulesto check your datain Data Entry Station,
but to create new rules, you'll need Builder.

Itisexpected that Data Entry Station will be purchased in combination with at |east
one copy of Data Entry Builder (since you can't use Station to create surveys). If you
have alarge team, buying one or more copies of Data Entry Station in combination
with Data Entry Builder can speed the data entry process by allowing more people to
get involved.

SPSS Data Entry Enterprise Server

You can purchase SPSS Data Entry Enterprise Server if you havealargeteamor if you
wish to deploy surveys over the Web. The SPSS Data Entry Enterprise Server provides
two powerful tools for data collection: the Network Server and the Web Server. The
Network Server is designed for teamwork. A team member may play more than one
role during the course of a survey, but every member is able to work more efficiently.
For any survey that will be deployed at your site, team members may include:

Survey designer. The team member who devel ops the survey form, including the
guestions, valid responses, and rules. (This may be the same person as the survey
administrator.)

Survey administrator. The team member who deploys and maintains the survey. The
administrator may be responsible for exporting the survey files from Data Entry
Builder, and registering the survey master files with the Data Entry Network Server,
which is used by the entire team. Once the files are registered, users of both Builder
and Station can submit cases.

Survey analyst. The team member who analyzesthe survey data, usually with the SPSS
for Windows application. This person uses the data collected in the survey’s master
.sav file, or other data sources. (This may be the same person as the survey designer.)

System administrator. The team member who is responsible for installing the Data
Entry Network Server. The system administrator is also responsible for the computer
system that hosts the Data Entry Network Server. This person may aso administer the
data sources at your site.

The Data Entry Web Server displays your survey as HTML. When an Internet or
intranet user answers your survey and submits the information, the Data Entry Web
Server collectsthe dataand sendsit to the Network Server, whereitissaved in amaster
filein .sav format. When your survey is complete, you can open the .sav filein SPSS
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for dataanalysis or in SPSS Data Entry Builder for cleaning. For moreinformation on
the SPSS Data Entry Enterprise Server, refer to the SPSSData Entry Enterprise Server
User’s Guide.

Question Libraries and Sample Files

Data Entry Builder includes several question library files with fully formatted sample
guestions that you can copy and paste into your forms. The librariesinclude examples
of categorical questions, as well as open-ended questions, demonstrating how these
types of questions can be implemented in Data Entry using text boxes, check boxes,
option buttons, and drop-down lists. Multiple response questions and tabular response
item matrices are al so included.

Y ou can copy questions from the library into your form and use them asthey are or
customize each to your particular needs. The emphasis is on demographics, but by
modifying the question text and responseitems, the questionsin thelibraries may serve
asthe starting point for ailmost any type of survey.

A number of fully formatted samplefilesare also included with Data Entry Builder.
Each demonstrates a simplified solution for a given scenario.

Y ou can access the question libraries viathe Edit menu in Builder. The samplesare
installed in the same directory as your Data Entry software.

Where to Go from Here

m For an introduction to using Data Entry, see Chapter 2 or the online tutorial. (To
run the tutorial, start Data Entry and select Tutorial from the Help menu.)

To define questions and variables for a new survey, see Chapter 4 and Chapter 7.
To use the question libraries, see Chapter 9.

To create aform from an existing datafile, see Chapter 4.

To customize your forms, see Chapter 10.

To create Validation, Checking, or Skip & Fill rules, see Chapter 11.

To enter data, see Chapter 14.

To use the data checking facility to check for errorsin your existing datafiles, see
Chapter 15.



Quick Tour

In this chapter, you will learn how to:

m Create a short survey using three different question types.

m Createasimple Skip & Fill rule.
m Savethefile
m  Enter datainto the survey.

Figure 2-1
Quick Tour survey

o/ quickt_sav - Forml
Fil= Edit Wiew Data Bules Help

=] B3

=H| SR %wlal |~ 2|6 ==K =0

14 4] s P[] @] £ ]

1. How often do you travel overseas?
O Mever

O Every Other Year

Q) Every Year

O Twice a Year or More

2. Last overseas destination:

3. Which of the following continents would you consider visiting?

[ Europe

O Australia

O Asia

O Sauth America

O Africa =
1] | ;IJ
Ready [4/4  RESkip&FilOn  [Aute 7
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Starting Builder

Figure 2-2
Windows Start menu

@ ACCEssOries »
(B adobe ’
@ Adobe Acrobat 4.0 4
@ Capture Professional v 4
@ ClearCase 4
@ Clementing 5.2.1 4
@ Metwork Associates WirusScan MT  F
(3 metal ’
§ ﬁ Internet Explorer
Mew OFfice Document

— Microsoft Excel

% Open Office Document (W] Microsoft Word
[@) windows Explorer

@ Sz gk e @ Java 2 Runtime Environment 4
E ta Entry 4.0

E Programs

@ Documents L4

% Settings 4

@ Search L4

@ Help

Run...

Qa Eject PC

Shut Dawn,.

igljstart |

» From the Windows Start menu choose:

Programs
SPSS Data Entry 4.0
SPSS Data Entry Builder
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Figure 2-3
Form window, Builder window, and toolbox
&' Formil [_ (O] x|

Fil= Edit “iews Layout Bules Help

(6] SR omle] o] 20| | alE ==

$ Builder [_[OIx]

File Edit “iew Insert Rulez Help

D= 2= 2= nlﬁl_lgl fﬁ|§|g
?lx-l*"lﬁq:l |<AIIFDrms> -

Mame | Title | Comments |
D Form1 Form1
Feady o

When you open Builder, ablank form is displayed. You can open an existing file or
start working with the blank form to create a new file. The Builder window is where
you will view and manage your forms, questions, variables, and rules. The Form
window iswhere you will create your forms. You will use thetoolbox to add questions,
lines, rectangles, and pictures to your forms.
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There are several different types of questions that you can create, depending on
what sort of data that you want to collect. The questions are covered in more detail in
Chapter 4. For this survey, you will learn how to create an option button question, a
text box question, and a multiple response check box question.

Turning on Automatic Question Numbering

Before you create any questions, you can decide whether you want your questions
automatically numbered. If you delete, cut, or paste questions, your question numbers
automatically update to reflect the change.

To turn on automatic question numbering:

» Click onyour form to select it.

Figure 2-4
Changing the AutoNumber property in the Properties window

&' Properties - Form1

False -
BackColor
Comment Falze
Faont Arial
M arme Farm1

MumberDielimiter |4 - "' [period)
MumnberLeselShow | 1 lewvel show - v
MurnberStartdt 1
MumberStyle 0-1414a1.4
TitleBar Farm1
WindowStyle Fixed

» Inthe Properties window, change the AutoNumber property to True.

When the AutoNumber property isset to True, any question that you create will contain
aquestion number. For now, set your form’s AutoNumber property back to False. Later
in the Quick Tour, you will learn how to manually add question numbers.
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Creating an Option Button Question

The option button question is used when you want to ask a question that will require
one answer and will provide the respondent alimited number of responses. Each
response is one option button. The first question in your survey is How often do you
travel overseas? The possible responses are Never, Every Other Year, Every Year, and
Twice a Year or More.

You will use the form toolbox to create the option button question. If the toolbox is not
visible, from the menus choose:

View
Toolbox

Figure 2-5

Selecting option buttons from the well
B4 Forml
File Edit Miews Lapout HBules Help

=E| 3|l 2lelel ool 2|al & §le

R RN EREEEE | T oolbox __ E7 | B8

SHERRESEHHIR . B

D R ERRERRTRRTE . |- | il

S BRIANETT

"':::::::::::::::::::::::::::::::::::i':::: {F;"‘{“‘;"‘;“"
RO P ey 3}{1

» Move the mouse pointer over the option button question tool and hold down the | eft
mouse button to display the option button well.

» Drag and release the mouse in the option button well to specify one column of four
option buttons.
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The cursor changes to indicate that the option button tool is selected.

» Click on the form to create the question.

Note: If you want to move your question, simply click on the question container, which
is the box surrounding the question, and drag to another place on the form.

Figure 2-6
Created option button question

& Forml M=l B3

File Edit “iew Layout Hules Help

Cuestion Text (WARIDDOT)
O Responseltem
O Responseltem?
O Responseltem3
O Responseltemd

D'esigh 4
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Figure 2-7
Editing the question and response text

&/ Forml [_ (O] x|

File Edit “iew Layout HRulez Help
| | Sl slel@| || 2@ = o=k =

1. How often do you travel overseas?
QO Never
O Every Other Year

: O Every Year

IO Fes S Hlt»-'rr|4

-
Ready FE1877 _— Desion |

To edit the question text and response text, double-click on them.
For the question text, type How often do you travel overseas?

For thefirst option button, type Never. For the second, type Every Other Year. For the
third, type Every Year. For the fourth, type Twice a Year or More.

When you create questions using the tool box, variables are automatically created at the
same time.

To define the variable for the question, right-click on the question and choose Variable
Properties.
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Figure 2-8
Selecting Variable Properties from the context menu

& Forml M=l E3
File Edit “iew Layout Bules Help

1. Howe often do you travel overseas?
- O Newer
‘m O Every Other Year
- O Every Year

O Twice a Year or More

Align ta Grid
Order

Properties
W arisble Pro

™.
. -
128 Pesion 4

The Variable Properties window is displayed. Each tab in the Variable Properties
window allows you to define a different aspect of the variable.

Figure 2-9
Variable Properties window

Variable Properties: TRAVEL

General | Formall Valuesl Mizzing \-"aluesl Walid \-’aluesl

Wariable name: ITFI.-’-‘«VEL Aliaz |

Wariable label: |1. How often do you bravel overseas?

Question text: W Link with wariable label

1. How aften da pou travel overseas? ;I
-]

Default value: ISystem missing j

Comments:

Cloze Help
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The Variable Label area and Question Text areawill aready show How often do you
travel overseas? If you edit the question text, the changes will appear on your form and
vice versa.

» Type TRAVEL inthe Variable name area. Variable names are restricted to eight
characters.

» Click the values tab.

Figure 2-10
Variable Properties window: Values tab
Yariable Properties: TRAVEL E
Generall Format  Walugs |Missing Valuesl ‘alid Valuesl
Value Value Label Link Response kem -
1| Mever [ |Mewer
2 |Every Other Year [+ |Every Cther “ear
3 |Ewery Year [ |Every Year
4 |More than Twice 5 Yesr | [ |More than Twice a Year
[
[
[
[
C A
— Check Box Yalue Mapping
Checked: I'I Unchecked: IIJ
Cloze | Help |

The changes that you made on the form to the option buttons are displayed in the
Response Item column. Note that each option button control on the form represents a
response item in the Variable Properties window. You don’t have to make any further
changes.

» Click the valid Values tab.
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Figure 2-11
Variable Properties window: Valid Values tab

Generall Formatl Valuesl Missing Values  Valid Values |

Check. the types of values to be accepted. All others are flagged during
entiy and checking. If none are checked. all values are walid.

Check all that apply:

V¥ dalues which are labeled and response items

[ User-defined missing values

™ System-miszsing value

Range of values:

Lower bound: I Upper bound: I

[T Al values must be whaole numbers

Cloze I Help

» Select Values which are labeled and response items.

Thiscreatesasimple Vaidation rule that limits entered datato the four response items
that you defined: Never, Every Other Year, Every Year, and Twice a Year or More.

» Closethe Variable Properties window.

Connection between Questions and Variables

Questions and variables are not the same thing in the program, but they are closely
related. You can use the program without ever understanding this connection, but the
many different methods for adding and removing responses from questions and
variables will make more sense to you if you do.

A questionisarepresentation of avariableon aform, and the question text and response
items displayed in questions are actually stored in the variable bound to the question.
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This makes it easy to keep your questions and forms up to date and provides
multipleways of doing things. Y ou can edit question text and response choicesdirectly
onyour form or in the Variable Properties window. Either way, the result isthe same.
Similarly, if you want to remove one of the buttons in an option button question, you
can select and delete the button right on the form or del ete the corresponding response
item in the Variable Properties window. The result is the same, so use whichever
method is convenient for you.

Creating a Text Box Question

Use the text box gquestion when you want to ask a question that will require a text
answer. The second question of your survey is Last overseas destination.

» Click the text box question tool from the toolbox.

» Click on the form to create the question.

Figure 2-12
Created question

& Form1 =] E3

File Edit “iew Layout Bules Help
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- O Twice a Year or More
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» Double-click on the question and type Last overseas destination:.

Figure 2-13

Editing the question text
I[= B3

& Form1
File Edit “iew Layout HRulezs Help

1. How often do you travel overseas?

O Mever
O Every Other Year

) Every Year
O Twice a Year or More

1 |
Ready 18,120 _ Design v

» To definethe variable, right-click and choose Variable Properties.

» IntheVariable Propertieswindow, type DESTIN for the variable name. (The question
text that you entered on the form is already displayed.)
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Figure 2-14
Variable Properties window: Format tab
Yariable Properties: DESTIN E2

General Format |Values| iszing Valuesl " alid Valuesl

SPSS Dizplay Format [Type]

" Numeric

" Comma

" Dot

" Scientific notation Characters: Iﬁ
' Date

" Dallar

= Cystom curmency

* String

Sample
IVABCDEFGHIJKLM

Cloze Help

» Click the Format tab.
» Choose String as the variable type and specify the number of characters as 50.

» Closethe Variable Properties window.

Customizing Your Form

You can change the properties of your form or question to alter the appearance and
functionaity of your form. You can:

m  Change the font, size, and color of text.

Apply custom styles to questions, such as raised, flat, or sunken.
Change the border style, color, and width.

Change the position and alignment of text within controls.
Enable or disable questions and contrals.

Require respondents to answer a question or select a certain number of responses
for amultiple response set.
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To view the properties for an item:

» Click ontheitem.

» From the Form menu choose;

View
Properties

Figure 2-15

Properties window
&7 Properties - Questionl
B ackColor
BackSyle Opague
BarderColor
BorderSiyle 0-Mone
Barderadidth 0 - HairLine
Enabled True
Entrybode DoubleE ntry
Height 43
Left 7B

M Question]
Murnber Falza
MumberLocation |0 - Left
MumberH estart Falza
Required Falze
SpecialEffect 0 - Flat
StatuszBarT ext
Top 24
Y ariable WAR0000
*izible True
Width 138
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Builder Window

Figure 2-16
Builder window

4 Builder [_[O]

File Edit “iews |nzert Bules Help
D|=(@] S]] & e[ n|n|_|g| '—’£|Elﬂ
El? Ix- | | |<.-’-‘«|| Foirrs

[A] DESTIN 2 Last Dverseasdestination. Stling[.-’-‘«D] . 2
1| | *
Ready NUM i

The Builder window allows you to access the objects that make up your file.

» From the Builder window menus choose:

View
Variables

You can see alist of your variables.

» Double-click DESTIN to view the properties of the variable. Close the Variable
Properties window.

» From the Builder window menus choose:

View
Rules

You can see the Validation rule that you created for TRAVEL.
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Creating a Multiple Response Set

When you have a question that may require more than one response, you can create a
multiple response set. When you create a multiple response set, you create a variable
for each response.

Thethird question in your survey is Which of the following continents would you
consider visiting? The possible responses are Europe, Australia, Asia, South America,
and Africa. Use the check box question tool to create the question.

Thetool well allows you to specify the number and arrangement of the check boxes.

» Movethe mouse pointer over the check box question tool and hold down theleft mouse
button to display the check box well.

» Drag and release the mouse in the well to specify one column of five check boxes.
Figure 2-17
Using the check box well

& Forml [_ O]

Fil= Edit “iews Layout Bules Help

............ ;I
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» Click on the form to create the question.

Figure 2-18
Created check box question

& Forml
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Edit “iew Layout Rulez Help
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Ready

Toolbox

-------- 4]
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Quick Tour

» Double-click on the question text and type Which of the following continents would
you consider visiting?

» For the check boxes, type Europe, Australia, Asia, South America, and Africa.

» To define the multiple response set, from the Builder window menus choose:

View
Vari

ables

When you want to define several variables at once, the Builder window provides easy
access to the variables.
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Figure 2-19
Builder window
$ Builder [_[O]x]
File  Edit “iew |nzet BRules Help
D@ ZE] &[] »le] 2] ﬁl @|§|g
El? I)(- | | |<,.'.-.,|| Forms> j = e
Wariable/S et | Label | Farmnat | File Order
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[A] DESTIN 2. Last overseas destination: String[&50] 2
< TRAVEL 1. Howe often do pou travel overzeasy MumberF8.0] 1
@ WaRO000T  Europe Murnber[F2.0] 3
< VARDDOODZ  Australia MumberF8.0] 4
< VARDDODZ  Asia Mumber(FB.0] 5
@ WAROO004  South America Murnber[F2.0] B
< VARODOOS  Africa Mumber(F8.0) 7
4| | i
Feady HUM 5

When you created the check box question, you created a multiple response set, which
appears in the Builder window as $set001. The set consists of five variables. Each
check box represents a subquestion with its own variable, since each check box is
storing aresponse to the question. You will have to define your set and then define each
of the variables.

» Inthe Builder window, double-click $set001 to view the properties of the set.
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Figure 2-20
Set Properties window: General tab
Set Properties: $TRIP E3
General | Membersl

MName: $ [TRIP Alias: Ilrip
Label: |3. which of the follmwing continents would vou consider wizsiting?
Question text: W Link with zet label
3. which of the fallowing continents would you consider viziting? ;I

Counted value for dichatomies: I‘I 'I
Caomments:
Cloze | Help |

To change the set name, type TRIP in the Name text box. All sets must start with a $,
which is automatically provided for you.

Typetrip inthe Aliastext box. Because of the naming conventions of JScript, whichis
the language the program uses to make rules, sets must have an alias.

The counted value for dichotomiesis the number stored in the check box representing
the selected variable. When you are performing statistical anaysis, your analysis
software will know which responses were chosen because their variables will have the
counted value stored inside of them.

To specify the counted value, select 1 from the drop-down list.

Click the Members tab.
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Figure 2-21

Set Properties window: Members tab

Set Properties: $set0001 E3

General Members |

M arme | C. | Label | Farmnat | File Order |
[ vaR00001 On F&o 3
] v4R00002 On Fa.0 4
[ vaR00003 On F&0 &
] # vAR00004 On Fa.0 G
[ # vaR00005 On Fao 7 ‘l
O TRavEL OFf Ho.. Fz0 2

Inzert Mew Wariable |

Cloze | Help |

You can seethefive variables, which are represented on your form by each of the check
boxes. If you wanted to add another member, you could use the Insert New Variable
button.

» Click the General tab in the Set Properties window.

» Todefineyour variables, in the Builder window, click var00001.

» Change the name from var0001 to europe. Since the variable name already conforms
to JScript naming conventions, you need not specify an alias.

» Changethe names of the other variables. Change var00002 to austral, var0003 to asia,
var0004 to southam, and var0005 to africa.

» Close the Variable Properties window.
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Adding Question Numbers

You can manually add question numbers to questions.
» Hold down the Shift key and click on each question to select your three questions.

» From the Form menu choose:

Layout
Numbering
Add Question Number

Question numbers are added to your question. If you were to delete one of the
guestions, your gquestions would automatically renumber. If you add a question, your
new guestion will not have a question number. Questions are not automatically
numbered unless you set the form’s AutoNumber property to True.

Saving Your Data File

Now that you have created variables, you can save your datafile.

» From the Builder window menus choose:

File
Save
Figure 2-22
Save As dialog box

Save As K E3
Savejn: Ia Data Ertry

S
custzat zav

File name: Iquickt.sav Save

Save az ype: IData File [*.zav] ﬂ |

Cancel

» Type quickt.sav and click Save.
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Creating a Skip & Fill Rule

Skip & Fill rules allow you to skip questions that are not applicable for certain cases
and fill in valuesfor questions based on previously entered values. You will now create
arule so that when aperson enters Never for question 1, the program will automatically
enter Not applicable to question 2 and skip to question 3.

From the Form window menus choose;

Rules
Rule Wizard...

Figure 2-23
Rule Wizard dialog box
Rule Wizard - Start

Thiz wizard creates one or more rules. Rules operate
during data entry and checking.

wihich type of e would you like to create?
" Validates a single variable [Validation)

Checks a logical relationship between
varniables [Checking)

Give the rule a name: Ilu|e1

= Sets values of vanables, and zkips to
quesztions [Skip & Fill]

TRa454

@ Do you want to zee the wle that the wizard
= generates? Click on the pencil to view it.

< Each | Hewt » Cancel Help

» Select Skip & Fill rule and click Next.
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You can learn about Validation and Checking rules from the online rules tutorial or
from Chapter 11 and Chapter 12.

Figure 2-24
Rule Wizard - Skip & Fill Assignments dialog box

Rule Wizard - 5kip & Fill Assignments

Select the guestion which firez a Skip & Fill rule. The rule is fired when a value iz entered into the
zelected question(z). Click on the box ta zelect the guestion.

Question Mame | Check | Farm Mame | Question Text

[ & Question] On Form 1. How often do vou travel overseasz?

Oabl Question2  Off Farrm1 2 Lazt overseas destination:

O W Question?  Off Farm1 3. which of the following continents would you col
1] | i

[Questionz which already have Skip & Fill rulez are nat included in this list.

< Back | Mewut » | Cancel | Help |

» Inthe Skip & Fill Assignmentsdialog box, select the check box next to question 1 and
click Next.
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Figure 2-25
Rule Wizard - Skip & Fill Rule

Rule Wizard - S5kip & Fill Rule: Expression 1 of 1

If
-4 Select the value label
Wariables: Operatars:

[TRavEL x| [isLabeled =] & Valusfsk [Never =l

£ ariahles I vI
— Combinations
Click on & button to add a relation: And | Or |

Wars. TRAVEL IzLabeled["Never"]]

|Jze the right mouze button to delete, group, or ungroup zelected relations.

—Then Else
V Skip to a Question... | x Skip to a Question... |
B, Fill Values... | Fill ¥ alues... |
< Back | Heut » | Finish | Cancel | Help |

» Inthe Variables drop-down list, select TRAVEL.
» Inthe Operators drop-down list, select IsLabeled.

» Inthe Valuesdrop-down list, select Never.

Asyou make your selections, therule script iswritten in the Expression window in the
middle of the Rule Wizard. Your ruleistied to question 1. When you enter Never in
question 1, the rule is activated. The next step isto tell the rule that when Never is
entered in question 1, it should fill Not Applicable for question 2 and then skip to
question 3.

» Inthe Then areaof the Rule Wizard, click Fill Values.
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Figure 2-26
Fill when Expression is True dialog box
Fill when Expression is True E3
V Ta fill a wariable, specify the value in the value colurn,
Variable Value =
TRAWEL
DE=TIM Mot Applicable
EURCPE
ALUSTRAL
=
SOUTHAM
AFRICA, —
i
Press the Clear button to delete the il Clear |
Help | Contiriue | Cancel |

In the text area next to DESTIN, type Not Applicable.

Click Continue.

In the Then area of the Rule Wizard, click Skip to a Question.

Figure 2-27
Skip when Expression is True dialog box

w'hen the exprezsion i True

' Go to next guestion on current form

& Skip to question: IQuestinnS j

on form; IF.;.mﬂ j

[ Goto nest case

Help Contifue Cancel




36

Chapter 2

>
>

>

Entering

In the drop-down list of questions, select Question3.
In the drop-down list of forms, select Form1.

Click Continue.

In the Rule Wizard, click Finish.

When you enter Never in question 1, the program will fill in Not Applicable in question 2
and automatically skip to question 3.

From the Builder window menus choose:

View
Rules
Figure 2-28
Rules in the Builder window

4 Builder [ [O)x]

Fil= Edit “iew Ingert Bules Help

] =3 = 1N e e el =] n|r=-|_|g| fﬁ|§|£
Bl?lx-l!"‘_l |<.-’-‘«IIF-:-rms> -

M ame | Type
2% Form1_Question] Skip & Fill
=1 TRAVEL W alidation
Ready NUM i

The rule named Forml_Questionl isthe rule you just created. A Skip & Fill ruleis
named after the question it is attached to. The rule named TRAVEL is the Validation
rule you created in the Variable Properties window as part of this Quick Tour. A
Validation rule is named after the variable it is attached to.

Data

Now you are ready to enter data.
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» From the Form window menus choose:
View
Form Entry
Figure 2-29
Form Entry view

&/ Forml [_ (O] x|

File Edit “iew Data Rules Help
2|d SR swe(@| o] 2|6 =[x @[z o)

TR P M px| @] £ ]

1. How often do you travel overseas? j
QO MNever

O Every Other Year

& Every Year

O Twice a Year or More

2. Last overseas destination: | Ireland
1] | _'l_l
Ready [T/ i Skip&Fil: On  [Auto Chec 7

Entering Data in Form Entry View
» Usethe mouse or the arrow keysto select an answer for the first question.
» Pressthe Tab key to move to the second question.

» Inthetext box, type the location of your last overseas destination and
press the Tab key.

» Usethe mouse to select an answer for the first question.
» Pressthe Tab key to move to the second question.

» Inthetext box, type alocation.
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>

Entering

>

>

To save your file, from the File menu choose:
File
Save

Note: If you try to save your file or switch to another view when no option is selected
in the first question, you will receive avalidation error. The Validation rule that you
created in the Variable Properties window will not permit you to save afile or switch
views without answering the first question. If you receive the aert, you can use the
Navigation toolbar’s back arrow to move to the previous case. Then, you can save your
file or switch the view.

Data in Table Entry View

From the Form window menus choose;

View
Table Entry

Each column in Table Entry view represents a variable. Each row is acase.

Figure 2-30
Table Entry view

ISi[=] E3

i el 5%

& Forml
File Edit ¥“iew Data Hulez Help

g L= =1 Y e A =
CIKEE b [Mpk| o] £

de=tin
Ireland
Peru

travel
Ewery “ear]
Every Other “ear

-

& [ [ra] =

Merver
Ewvery Other Yes

Twvice & Year

|«

(372 BESkip&FilOn  [Auto Check: T

Click on thefirst cell in the bottom row.
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A new caseisinserted.

Click the arrow in the cell and select aresponse from the list.
Press the Tab key to move to the next cell.

Type alocation.

Press the Tab key to add this case and move to the next case.

Closing Your File

>

From the Builder window menus choose:
File

Save
File

Close

Opening Your File in SPSS

>

Now that you have afew casesin your file, you can see what your file looks likein
SPSS.

From the Windows Start menu choose:
Programs
SPSS for Windows

Note: Builder is designed to be used with statistical analysis software programs from
SPSSInc.

From the Data Editor menus choose:
File
Open
Data

Select quickt.sav and click Save.
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Figure 2-31
Builder file in SPSS

Data Editor =] E3

File Edit “iew Data Transform  Statistice Graphs  Utilities  ‘wWindow  Help

= (8| =] »| 5] =[b| sl Fl=| B @

travel destin var var

Ewery Year | Ireland

Every Other | Peru

1

2

3| Ewery Year | Kenya

KN 2

|SPSS Processor is ready i

In SPSS, you can analyze your data, delete variables, edit your file, or save the file to
be exported into a number of spreadsheet and database programs. Any changes that
you make to the file will be reflected when you open the file again in Builder. For
example, if you delete avariable while in SPSS and save thefile, you will find that
when you open your filein Builder, both the question and the variable are no longer in
thefile. It isawaysagood ideato make a backup copy of your file before you change
itin SPSS.

To close SPSS, from the Data Editor menus choose:
File
Exit
You have completed the first part of the Quick Tour. To learn how to create a question
that can receive more than one answer or a Skip & Fill rule, keep reading.

Where to Go from Here

To define questions and variables for a new survey, see Chapter 4 and Chapter 7.
To create aform from an existing data file, see Chapter 4.

To customize your forms, see Chapter 10.

To create Validation, Checking, or Skip & Fill rules, see Chapter 11.

To enter data, see Chapter 14. Y ou can also open the sample survey for areference
on how to set up your file.
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Working in Builder

While you work in Builder, you will use:
® The Builder window

Design and Entry views

The Form window

The toolbar

The Properties windows

Builder Window

Figure 3-1
Builder window

4§ Builder M=l E3

File Edit “iew [nzert Hulez Help

D|=(d]| SR #w(e) n|n|_|§| rﬁ|ﬂ|g
I_?lx-li'“lﬁl |<.-’-‘«||Fnlms> - ==

Mame | Title | Comments |
D Online Orline Form Form Optimized for0 nline Entry
. Print Printing Farm Farm Optimized far Printing

Ready [ [HUM 4
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The Builder window provides a base for working with your file. Within the Builder
window, you can display and access the forms, questions, variables, and rules that
make up your file.

m  Usethe View menu or toolbar to specify whether you want to display forms,
questions, variables, or rules in the Builder window.

® Double-click on the name of aform, question, or variable to go to that element or
access its properties.

m UsetheFile menuto create anew file, open an existing file, or print formsin your
file.

m  Usethe Insert menu to insert new forms, variables, or multiple response sets.

m  Usethe View menu to switch among the Design, Form Entry, and Table Entry
views.

m Click on acolumn within the Builder window to sort the items in the Builder
window.

Design View, Form Entry View, and Table Entry View

Design view. In Design view, you design forms, questions, variables, and rules. You can
add questionsto the form or select and modify existing questions, variables, and rules,
change the tab order, or make any changes to the design of the form, questions,
variables, and rules. Thedesign view also providesyou withan HTML preview option,
which allows you to preview how your survey will look online. However, you cannot
add cases to the data file, modify existing data, or run rules.

Form Entry view. You can enter data and use the data-checking facility to check for rule
violationsin an existing datafile. You can use the Tab key to move between questions,
moving freely through the form and adding or modifying data as you wish. However,
you cannot make any changes to the form properties without switching back to Design
view.

Table Entry view. Table Entry view is an aternative to Form Entry view for entering
data. Data are displayed in a spreadsheet-like format, where cases are rows and
guestions are columns, allowing you to view and print multiple cases.
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To Switch between Views

From the Form or Builder window menus choose;

View
Form Entry (Table Entry, Design)

Working with Multiple Builder Windows

Figure 3-2
Two Builder windows

@ custsat.say - Builder [_ O] =]

File Edit “iew Inzert Hulez Help

sl = ENE I R E ﬂlﬂlil_l_lfi =] I
El? Ix. | | |<.-’-‘«II Formzs

Y ariable/Set | Label | Format | File Order -
3% $product  Product
|ﬂ $shop Shopping Locations
<# SATISF Owerall S atizgfaction Mumber(F2.0) 1 |
@ RECOMMD Recommend Product Murmber(Fz.0] 2
< QAL Overall Guality Mumber(F4.0) 3
@ USE Frequency of Use Murmber(Fz.0] 4
<& FalL Froduct Operation Failure Mumber(F2.0) ]
@ COMTFAIL Contact Because of Problem Murmber(Fz.0] B =
| | LIJ
Readw [ [NUM[ 2
4 quickt.sav - Builder H=] 3

File Edit “iew |nget Bulez Help

) =)= e e n|n|_|_| [
El 2 Ix- | | |<.~’-‘n.|| Forms: j =n

Wariable/Set | | ahel Farmnat | File 0 =

ﬂg $TRIP wihich aof the follawing continents wauld pou consider visiting?

< TRAVEL How often do pou travel overseasz? MumberF8.0] 1

[A] DESTIN Last Overseas Destination: String[A50] 2
#EUROPE  Ewrope MumberF8.0] 3

@ AUSTRAL  Australia Mumber[FE.0] 4 -
<Hr A1 Agia MumberF8.0] &

®| SOUTHAM  South America Nrmber[FB.D] B _ILI
4 3

Ready [ [NOM 4
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You can have more than one file open at atime, which can be useful for cutting,
copying, and pasting between the files and comparing them. When you open morethan
onefile, each file hasits own Builder window, listing the elementsin that file. When
multiple Builder windows are displayed, be sure you arelooking in the correct Builder
window for the file that you want to access.

Figure 3-3

Two files: One in Design view, one in Table Entry view

/7 Online Entry Form

File Edit “iew Lavout Bules Help

M[=] E3

= e e e e s P

Customer Satisfaction Survey

O Fax tlachine
O Copier

QO Very satisfied
O Somewhat satisfied

QO Yery Dissatisfied
O MNa Answer

Howw weould you rate your overall
satisfaction with this product?

Product (select all that apply)

Wyould you recommend this product?

O Yes
O Mo

Did the product ever fail to operate?

QO Yes

Fil= Edit “iew Data Rules Help

&/ Formil =]

O Somewhat dissatisfied @IEI élal %IEEIEI nlml ‘@lml

S K 7

IRINE > vk @] £

travel

destin

calif

austr kenmya

aly —-

Ewery Cther Year

Irelanc

hore than Twice a

Feru

Mewver,

Kenya

| o=

Ewvery Cther Year

Mot Applicakle

=ir=1

e = =] =]
. =1

1«1

Ready

o

[8/8

B4 Skip & Fil: On

|Aut0 i

When you have two files open, you can switch views freely within afile. For example,
you can have onefile open in the Design view, while the other fileis open in the Form
Entry or Table Entry view.
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Inserting Forms, Variables, Sets, and Rules

Figure 3-4
Inserting a variable
4 Builder [ [O) %]
File Edit Wiew QEEI® Bulez Help
Imi[=31=] émmm
E ? X i-" tultiple Responze Set e =
—————————  Rule.. .
ariable/Set Procedue. | Format | File Dlderil
$shop —
@ BIRTH Birth Y'ear Murnber[F4.0] 1Al
@ COMTFAIL Contact Because of Problem Murnber[F2.0] B
#» COFIER Coopier Mumber(F8.0] 16
@ EDUC Education Level Murnber[F2.0] 12
<#r FaIL Product Operation Failure Mumber(F2.0] ]
® Fa Fau Machine Murnber[F2.0] 15
@ FINCOME Family Income Murnber[F2.0] 13
@)I FROBMEET Expectations Number[FE.D]I 7 _Iﬂ
4 »
Mew Variable MLM i

You can usethe Insert menu in the Builder window to insert objectsinto your file. You
can insert forms, variables, multiple response sets, rules, and procedures. The Insert
menu is helpful for creating objects quickly, particularly variables.

Managing Objects

The Builder window is an easy place to work with your file objects. You can:
m  Define variables and multiple response sets.

m  Copy and paste forms, variables, rules, and sets. If you have multiple files open,
each hasits own Builder window, allowing you to copy and paste between Builder
windows.

m  Copy and paste variable or set properties. If you have multiplefiles open, each has
its own Builder window, allowing you to copy and paste between Builder
windows.

m Delete variables, questions, forms, and rules.
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Toolbars

Each window has atoolbar that provides quick and easy accessto common tasks. Some
windows have more than one toolbar. Hold the mouse pointer over atool to display a
Tool Tip that briefly describes what the tool does.

Figure 3-5
Toolbar with ToolTip Help

Wiew

Bl? Iﬁ !‘“lﬁl |<.-’-‘«|| Farms:
ariables

To Show or Hide a Toolbar

» From the menus choose:

View
Toolbars...

» Inthe Show Toolbars dialog box, select the toolbars that you want to show (or hide).

You can aso control the size of the toolbar buttons and the display of the Tool Tips.

Figure 3-6

Show Toolbars dialog box

Show Toolbars [ x|
Wiindow Type: 0K |
[ Builder =

Cancel |

Toolbars:
(W] Standard Help |
(] iz

¥ Show Tooltips

[ Large Buttons




47
Working in Builder

To Move a Toolbar
» Click anywhere in the toolbar outside the toolbar buttons.

» Drag the toolbar where you want it.

m Dragging the toolbar to the left or right side of the window attaches a toolbar
vertically to that side.

m  Dragging the toolbar to the top or bottom of the window attaches the toolbar
horizontally.

m  Dragging the toolbar anywhere other than the window borders creates a detached,
floating toolbar.

m  Dragging the sides or corners of afloating toolbar changes the shape and
arrangement of tools (vertical column, horizontal column, or rectangular).

Form Toolbox

You use the form toolbox to add questions, text labels, and picturesto forms. Tools are
available for creating questions with different types of response controls as well as
annotations and pictures. Hold the mouse briefly over atool for adescription of thetool.

Figure 3-7
Form window toolbox

B4 Forml !EIE

File Edit “iew Layout HRulez Help

Slu| Sl slmle] o] 2(e] sl o=l R

EEEEHEEEETHEHERERERERERIE | |-

o e

S | w | LI_I
R P

For detailed information on creating questions with the toolbox, see Chapter 4.
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To Display the Form Toolbox

» To show (or hide) the toolbox, from the Form window menus choose:

View
Toolbox

The toolbox includes tools for adding questions, pictures, and annotations to forms.
» Hold the mouse briefly over atool for a description of the tool.
» Click atool with the mouse to select the tool.

» After selectingatool, click ontheformto add the question, text 1abel, or pictureto your
form.

You can drag the toolbox to the top, bottom, or side of the window to dock it like any
other toolbar or leave it as afree-floating palette. For more information on creating
questions with the toolbox, see Chapter 4.
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Working in Builder

The Properties window allows you to specify properties of forms, questions, contrals,
and toolbox tools. Properties determine the appearance, position, and behavior of form
objects and tools.

Figure 3-8

Properties window
&5 Properties - Questionl E3
BackColor
BackStyle Opaque
BorderColor
BarderStyle 0-Mone
Borderafidth 0- HairLine
Enabled True
Entrytdode DoubleEntmy
Height 43
Left A

[uestion

M umber Falze
MumberLocation [0 - Left
MumberR estart Falze
Required Falze
SpecialE fect - Flat
StatuzB arT ext
Top 24
Wariable WAROOO01
Wizible True
Width 138

m  The Propertieswindow always displays properties of the currently selected objects
or tool box tools. If multiple objectsare selected, properties common to both objects
are displayed.

m  Theleft column displays the name of each property; the right column displaysthe
current value.

Click on any property and press F1 for help on that property.
Changes to properties are updated immediately on the form.
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To Set Properties for a Form, Question, Control, or Tool

Figure 3-9
Setting default properties for a question tool

File Edit Miews Lapout HBulez Help

=H| Sl 2lelel olc] 2l = 5l

#: Properties - Option button question m
| AutoSizeT oFit False Py | R labl}e |
Autohrap Falze ~ |EE m!ﬁﬁ .
NeackCor 717 10 — ption butkan
] i o BRIAETT
i CaptionPogition - Right — ! Sl wee | L] D = "J_'j
'— | Enabled e s o
__H_ Font i T U
FantColar
Height
Harizontaldlignment 1 - Left "‘
HorizontalSpace 13
MHumberLocation - Left
QuestionB ackColor |
[QuestionB ackStyle
QuestionBorderCalor
DuestionBorderStyle -]

» Todisplay (or hide) the Properties window, from the Form window menus choose:
View
Properties
» Select one or more objects on aform, or select atool in the form toolbox.
Properties of the selected objects or tool are displayed.

» Change propertiesin the right column of the Properties window.
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For some properties, you simply type avalue; for others, you make selections from a
drop-down list or double-click to open adialog box.

» PressF1 for help on the selected property.

Changesto default tool properties are applied to objects subsequently created with the
tool.

Asashortcut, you can access the Properties window by right-clicking on an object
and selecting Properties or by pressing Alt-Enter when working in the Form window.

Setting Properties for Multiple Objects

To set properties for multiple objects, hold down the Shift key as you click on objects
with the mouse. Properties common to all selected objects are displayed in the
Properties window, alowing you to modify them with a single action.

Variable Properties Window

The Variable Properties window allows you to define your variables. You can access
the Variable Propertieswindow from the Builder window or from aquestion on aform.

Changes made in the Variable Properties window are applied immediately—you
don’'t need to close the window after making changes. Y ou can edit multiple variables
by selecting them one after another in the Builder window, without closing the
Variable Properties window between each selection.
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Figure 3-10
Variable Properties window
Wariable Properties: SATISF E3
General | Format I Walues I Mizzing Y aluez I Walid Values I
Wariable name; ISATISF Alias: |
Wariable label: IHow would vou rate pour overall zatisfaction with this prao
Questiontest: [~ Link with wariable label
4. How would pou rate wour overall zatisfaction with thiz product’? ﬂ
Default value: IU j
Entry Type: IDnubIe Erter ﬂ
LComments:
Cloze Help

To Define Properties for a Variable or Set

» To access Variable Properties from the Builder window, from the menus choose:

View
Variables

» Inthevariablelist, right-click on avariable or multiple response set and select
Variable/Set Properties.

» Toaccessvariable propertiesfrom aquestion on aform, right-click onthe question and
select Variable Properties.

See Chapter 7 for more information on defining variable properties.



Chapter

a

Questions

Questions are the foundation of any survey and the building blocks of data entry
forms. Each question on aform has two visible components:

m  Question text.
m  One or more response controls that allow the user to enter aresponse.

A number of control types are available, including text boxes, check boxes, option

buttons, and drop-down lists. Most response control types display enumerated

response items (for example, yes or no) from which the user can choose.
Answersto questions are stored in variables. In fact, you can think of aquestion as

arepresentation of one or more variables on aform. The question text and response

items displayed in questions are also properties of the variable bound to the question.

Figure 4-1

Questions on a form

J Online Entry Form M=l E3

File Edit “iew Data Hules Help

M o Die] & ]

Customer Satisfaction Survey j
Product (select all that apply) Would you recommend this product?
e Q Yes

O Copier Q No

Howe wiould you rate your overall Did the product ever fail to operate?

satisfaction with this product? O Yes

O Very satisfied QO Mo I ho, please skip b the next section

O Somewhat satisfied

O Somewhat dissatisfied Did you contact us to fix the problem?

QO “ery Dissatisfied Q Yes

Q Mo Answar Q Mo
1] | _'|_I
Ready [3/2 RESkip&Fil: On  [Auto Check: On W
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Question Numbering

Before you create any questions, you can decide whether you want your questions to
be automatically numbered. When you set your form’'s AutoNumber property to True,
al questions that you create are numbered. If you delete, cut, or paste questions, your
guestion numbers automatically update to reflect the change.

The question numbers are controlled by the tab order of your form. The tab order
specifies the sequence in which users can move through questions on the form by
pressing Tab (or Shift-Tab) in Form Entry or Table Entry view. By default, the tab
order corresponds to the order in which your questions are created. Tab order may
become an issue if you change the order of questions on the form. When you opt to
automatically number your questions, you will have to keep your tab order up to date.
For more information on tab order, see Chapter 10.

If you have already created questions, the procedure for obtai ning question numbers
isdlightly different. For more information on adding question numbers to existing
forms, numbering static text, or customizing the appearance of question numbers, see
Chapter 5.

To Turn on Automatic Question Numbering
» Click your form to select it.

» Inthe Properties window, set AutoNumber to True.

Adding Questions to Forms

You can add questions to aform using the form toolbox or by dragging existing
variables from the Builder window onto aform.

Figure 4-2
Form toolbox
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Questions

m |f you're starting a new project, using the form toolbox is probably the easiest

method. Asyou add each question to the form, avariable or mul
isautomatically created.

tiple response set

m |f you prefer, you can first define your variables in the Builder window and then
drag variables from the Builder window onto a form to generate questions based
on those variables. Y ou can a so use this method to generate aform from an

existing datafile.

To Create Questions and Variables Using the Form Toolbox

If the form toolbox is not visible, from the Form window menus choose:

View
Toolbox

» Inthetoolbox, click the desired question tool to select the tool.

» Click on the form to create the question.

Figure 4-3
Clicking on a question tool
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Figure 4-4

Clicking on the form to create the question
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Asyou add each question, a variable or multiple response set is automatically created.
» Todefinevariable properties, right-click on the question and select Variable Properties.

» To change question properties, right-click on the question container and select
Properties.

Note: You can aso change response control properties.
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Tool Wells

Tool wells alow you to create questions with more than one response control—for
example, agroup of option buttons or a multiple response question with several check
boxes or drop-down lists.

Figure 4-5
Option button tool well
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Hold the mouse pointer briefly over atool and presstheleft mouse button until the well
appears. Then, drag and release the mouse in the tool well to indicate the number and
arrangement of controls. The well expands as you drag, alowing you to specify as
many rows and columns as you want (to the limits of your screen).

To Create a Question with Multiple Response Controls

>

If the form toolbox is not visible, from the Form window menus choose:
View
Toolbox

Move the mouse over the desired question tool and hold down the left mouse button to
display the tool well.

Drag and release the mouse in the tool well to specify the number and arrangement of
response controls.
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Figure 4-6
Specifying the arrangement of controls
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The well expands as you drag, allowing you to specify as many rows and columns as
you want.

» Click the mouse on the form to create the question.

Figure 4-7
Creating the question
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Asyou add each question, a variable or multiple response set is automatically created.

» To definevariable properties, right-click on the question and select Variable Properties.

To Require a Response for a Question or Set

An occasion might arise when you want to create a question that a respondent must
answer. You can set a property for the question to ensure that the respondent or data
entry clerk will not be able to skip that question. For sets, you can require that the
respondent select a certain number of responses.

To create a question that requires a response:
» Create your question or set.
» Right-click on the question or set container and select Properties.
» For aquestion, in the Properties window, set the Required property to True.

» For aset, in the Properties window, specify a number for the RequiredAnswerCount
property.

Tips for Creating Questions with the Form Toolbox

m  The default properties of new questions depend on the properties of the tool used
to create the question. To reduce the amount of time you spend customizing
guestions, specify tool properties before you create questions.

®  Toadd severa questions of the sametype, select thetool by double-clicking rather
than single-clicking or hold down the Shift key as you drag and release the mouse
in the well. The tool remains selected after you add a question, allowing you to
repeatedly click on the form to create several questions of the same type.

m  To specify the type of variable created for the question, click on the form with the
right (rather than left) mouse button when you create the question.

m  To specify the exact size and shape of the question, drag the mouse on the form
rather than clicking.
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Default Tool Properties

You can customize the behavior of each tool by specifying the default properties
applied to objects created with that tool.

For example, suppose you want all of the questions on your form to have a specific
background color or border style. Rather than modify each question after you createit,
set the appropriate property for your question tools before you create questions. This
can save you alot of time by reducing the need to modify questions after you create
them.

Changes to default tool properties are applied to all objects subsequently added to
the form with the tool. Tool properties are saved with the form, so you can specify
different defaults for different forms. Newly created formsinherit tool defaults from
the last open form.

Tip: To set the default font for all questions added to aform, click on the form
background and set the Font property for the form in the Properties window. The
specified font is applied to all questions and text subsequently added to the form.

To Set Default Tool Properties

You can use the Propertieswindow to specify default properties for new questions and
objects created with toolbox tools.
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Figure 4-8

Default properties for the option button questions
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In the toolbox, click on the desired tool.

To display the Properties window, from the menus choose:

View
Properties

Questions

Specify the desired propertiesin the right column of the Properties window.

The properties are subsequently applied to all objects created with the tool.
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Auto-Creating a Form

The Auto-create feature allows you to automatically create aform, maximized for
entry in Table Entry view. To use Auto-create, you must have defined variables, either
from an .sav file created in Builder or in another program from SPSS. You can use .sav
filesthat already have forms.

Figure 4-9
Auto-create dialog box
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When you auto-create aform, the questions are created in the order in which the
variables were created, which is listed in the Builder window as the file order. Auto-
creating aform creates aform that is maximized for efficient dataentry in Table Entry
view. Autotab is set to True so that after you enter an answer, you move automatically
to the next question. Value labels appear instead of response items as you enter data.
For example, if you have a question where the response item is yes, instead of yes you
see the value label, or 1.

Tip: If anumeric text box question is not defined properly, it will default to 8. So if you
enter onedigit, Autotab won’t work becauseit isexpecting eight digits. When defining
numeric variables, make sure that the length is set properly so Autotab will work.
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To Auto-Create a Form

» From the Form menu choose:

Layout
Auto Create Questions...

P Select either Create all questions as text boxes Or Create questions based on default types.
Tip: Creating all questions astext boxes makesit easier to enter datain Table Entry view
for those who prefer the keyboard to the mouse.

» If you want to edit the form, deselect Open in Table Entry Mode.

Note: If you open afile that contains only variables, the Auto-create dialog box opens
automatically. If you do not want to auto-create aform, click No.

To Create a Question from an Existing Variable or Set

You can drag or paste an existing variable or multiple response set from the Builder
window onto aform to create a question. Thisis the only method that allows you to
create a question bound to an existing variable.
Figure 4-10
Dragging a variable onto a form
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In the Builder window, from the menus choose:
View
Variables

Select one or more variables or multiple response sets.

To select multiple variables, hold down the Shift key or Ctrl key asyou click on the
variables.

Hold down the left mouse button while dragging the selected variables from the
Builder window onto aform.

Move the mouse to the desired position on the form and rel ease the mouse button.

To specify aresponse control type other than the default, drag and drop variablesusing
the right mouse button rather than the left, and select the desired control type from the
context menu.

Figure 4-11
Question created from an existing variable
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Tips for Creating Questions from Existing Variables

m By default, the response controal type for the question depends on the type of
variable and whether or not response items or value labels are defined.

m  To specify acontrol type other than the default, drag the variables onto the form
with the right mouse button rather than the | eft. Y ou are then prompted to select a
control type. If you use this method to drag multiple variables, the program
attempts to apply your selection to all variables.

m  Thequestion text and response items specified for the variable are displayed in the
guestion. (If question text and response items are not specified, the corresponding
variable labels and value labels are substituted.)

m  All other question properties depend on the tool properties (as when creating
guestions using the toolbox). For example, to adjust the vertical space between
guestions or controls, adjust the Vertical Space property for the option button
question tool before dragging the question onto the form.

m  Copying and pasting a variable using the Edit menu is the equivalent to dragging
the variable onto the form.

®  When creating a question from a multiple response set, select the set itself in the
Builder window—you don’t need to select the variables within the set unless you
want each variable to aso appear in a separate question.

Specifying the Response Control Type

By default, when you generate a question from an existing variable or multiple
response set, the type of response control depends on the type of variable or set and
whether or not response items or value labels are defined.

To specify a control type other than the default, drag and drop the variable or set
onto the form using the right mouse button, and select the desired control type from
the context menu. If you use this method to drag multiple variables, the program
attempts to apply your selection to all variables. Y ou cannot create long text boxes
using this method.
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Figure 4-12
Selecting the response control type
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Creating Questions from Multiple Response Sets

By default, when you generate a question from an existing multiple response set, the
type of response control depends on the variables composing the set and whether itis
amultiple category set or a multiple dichotomy set.

To specify acontrol type other than the default, drag and drop the multiple response
set onto the form using the right mouse button, and select the desired control type from
the context menu. If you use this method to drag multiple sets, the program attemptsto
apply your selectionto all variablesin all sets.

Tip: When creating a question from a multiple response set, select the set itself in the
Builder window—you don’'t need to select the variables within the set unless you want
each variable to also appear in a separate question.

Questions and Variables

When you create questions using the toolbox, you also create variables (and multiple
response sets, if needed) because you can’t have a question without a variable or set.
In fact, you can think of a question as a representation of avariable or multiple
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response set on aform. For example, a question asking the respondent to rate overall
satisfaction might be bound to a variable named SATIS.

Figure 4-13
Question representing a single variable

Howe weould you rate your overall
satisfaction with this product?

O Wery satisfied

O Somewhat satisfied
O Somewhat dissatisfied
O Wery Dissatisfied

O Mo Answer

Questions that allow the user to choose more than one response represent a set of
variables, referred to as a multiple response set. For example, a question such as
Which stores do you shop in? might be bound to a set of variables named $shop, with
a separate variable in the set for each type of shop.

Figure 4-14
Question representing a multiple response set

Which stores do you shop in?
O Cepartment
O Office Product Store

O Consumer Electronic Store

Understanding the Connection between Questions and Variables

Questions and variables are not the same thing in the program, but they are closely
related. You can use the program without ever understanding this connection, but the
program will make more senseif you do.
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A question is arepresentation of avariable on aform. When you create questions
using the form toolbox, you also create variabl es; the question text and responseitems
displayed in questions are actually stored in the variable bound to the question.

This makes it easy to keep your questions and forms up to date and also provides
for multiple ways of doing things. Y ou can edit question text and response choices
directly on your form or in the VVariable Properties window. Either way, the result is
the same.

Y ou can also have different questions on different forms that are tied to the same
variable. The questions can look different (for example, one might be formatted as a
group of option buttons and the other as a drop-down list), but they share the same
guestion text and the same set of response choi ces because these attributes are stored
in the variable.

To Define Variable or Set Properties

>

Note: You cannot view or edit the variables for long text boxes.

To accessthe Variable Propertieswindow from aquestion on aform, right-click on the
guestion and select Variable Properties.
Figure 4-15
Accessing variable properties from a question
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To access variable properties from the Properties window when aquestion is selected,
double-click the Variable property.
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» To access variable properties from the Builder window, from the menus choose:

View
Variables

» Then, right-click on avariable or multiple response set and select Variable/Set

Properties.

For more information on defining variable properties, see Chapter 7.

Variable Properties That Affect Questions

Questions shareimportant properties with the variables (or multiple response sets) that
they represent, including question text, response items, datatype, and values. You can
modify these propertiesin the Variable Properties window. Any changesto variable

properties are reflected in all questions bound to that variable.

Figure 4-16
Question text displayed in the Variable Properties window
General | Farmat I Walues I Mizzing Values I Walid Values I
Wariable name: W Hlias: |
Y ariable Jabel: IHDW would wou rate your overall satizfaction with thig pro
Question text [ Link with variable label
4, How vaould pou rate vour overall zatisfaction with this product? ;I
[
Default value: IU j
Entry Type: IDnubIe Enter ﬂ
Comments;

Cloze Help
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Question text. Text to be displayed in questions is bound to the variable (for example,
in Figure 4-16, How would you rate your overall satisfaction with this product? is
bound to the variable SATISF). You can edit the question text on the form or in the
Variable Properties window (General tab).

Figure 4-17
Response items specified for a variable
Wariable Properties: SATISF
General I Fomat alues | tizzing W alues I Walid W alues I
Value Value Label Link Response Hem =
0 |Mo Anzver [ Mo Anzveer
1 [Wery satisfied [ |“Wery satizfied
2 |Somewhat satizfied [ |Somewhst sstisfied
3 |Somewhat dissatizfied [ |Somewhst dissstisfied
4 [Very dizsatizfied [ |Wery dizsstisfied
5 |Don't knowy [ |Dont know
[
[
u -l
— Check Box W alue Mapping
Checked: |1 Unchecked: ID

Cloze I Help |

Response items. Enumerated responses that users can choose from are displayed as
option button captions or itemsin a drop-down list or list box. You can edit response
items directly on the question or in the Variable Properties window (Values tab).

Data format, variable values, and valid values. The type of data—and in some cases, the
specific values—that a question can accept depends on the variable bound to the
question. For example, if aquestion isbound to anumeric variable, you can’t enter yes
(unless yes has been specified as aresponse item for the variable). Similarly, a
Validation rule defined for a variable affects all questions bound to the variable.

See Chapter 8 for more information on how multiple response sets are represented
in questions.
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Automatic Update of Question and Variable Properties

Changesto avariableareautomatically reflectedin al questionsbound to that variable.
Thismakesit easy to keep your forms up to date, even when you create several versions
of aform.

For example, suppose you want to create several versions of a questionnaire, each
with the same questions but with the sequence of questions changed to make sure the
order in which questions are presented doesn’t bias the responses. To do this, you
create one form and then make a copy. The result is two separate forms, each with a
complete set of questions. Y ou can rearrange questions on one form, and even change
the appearance of one or more questions, without affecting the other.

However, both forms are still bound to the same underlying variables, so any
changes made to a variable' s properties are automatically updated in all questions
bound to that variable. (The same variable can be represented in several questions on
severd forms.)

For example, if you decideto change the wording of one of your questions, you need
to make the change only once. This is because question text is a property of the
variable. When you edit the question text for avariable, all questions bound to that
variable are automatically updated. Similarly, if you change the type of variable or
create a Validation rule for the variable, the change affects the behavior of every
guestion bound to the variable.

Tip: If you have several questions on several forms bound to the same variable, you
can't change the question text or response items from one question without changing
all other questions bound to that variable. However, you can use the clipboard to
“clone” aquestion by copying the question and pasting it back to the same form you
copied it from. Theresult is a separate question bound to a separate variable.

Why Share Properties?

Question text and response items are shared between questions and variables because
they define the substance of aquestion, which you typically want to preserve acrossall
forms that share that question. Properties that define the appearance, rather than the
substance, of aquestion (for example, thefont size or whether the question isformatted
asadrop-down or list box) are not shared, so you can customize the appearance of each
guestion on each form as needed.
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Copying and Pasting Questions

You can copy and paste questions between forms in the samefile, between formsin
different files, or from the Builder window to aform. Simply select the questions that
you want to copy and then drag or use the Edit menu to paste them into the desired form.

When you copy a question, the variable or multiple response set bound to the
guestion may or may not be pasted. The result depends on whether you paste to the
same form, adifferent form in the samefile, or adifferent file, and whether avariable
or set of the same name dready existsin thefile.

To Copy Questions between Forms

You can copy questions from one form to another or make a copy of aquestion on the
same form. The forms can be in the samefile or in a different file.

If you want to copy questions between forms in different files, open both files.

On oneform, select the questions that you want to copy. (To select multiple questions
on aform, hold down the Shift key as you click with the mouse or drag the mouse to
draw arectangle around multiple objects.)

From the Form window menus choose:
Edit
Copy
On the form where you want to paste the questions, from the menus choose:
Edit
Paste

Alternatively, you can drag selected questions from one form to another. This method
alows you to specify the exact position of questions on the target form.

Tip: You can “clone” aquestion by copying and pasting it back to the same form. The
result is a separate question bound to a separate variable.



73

Questions

To Paste Questions from the Builder Window to a Form

You can select questions in the Builder window and copy or drag them onto aform.
Theform can beinthe samefileastheorigina questionsor adifferent file. If you want
to copy alarge number of questions, using the Builder window may be easier than
copying questions directly between forms.

» If you want to copy questions from one file to another, open both files.

» From the Builder window menus choose:
View
Questions

» Select the questions that you want to copy. (Y ou can select multiple questions using
the Shift key; however, all of the questions you select must be on the same form.)

» From the Builder window menus choose:
Edit
Copy
» On the form where you want to paste the questions, from the menus choose:
Edit
Paste

Alternatively, you can use the mouse to drag the selected questions from the Builder
window onto the form.

To Move a Question from One Form to Another

You can move a question from one form to another by cutting and pasting using the
Edit menu.

» If you want to move a question to aform in a different file, open both files.
» Ontheoriginal form, select the questions that you want to move. (To select multiple

guestions on aform, hold down the Shift key asyou click on questions with the mouse
or drag the mouse to draw a rectangle around multiple objects.)
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>

From the Form window menus choose;
Edit
Cut
On the form where you want to paste the questions, from the menus choose:
Edit
Paste

When you use this method to move a question to a different file, the variable bound to
the question is not removed from the original file.

How Questions and Variables Are Copied

When you copy aquestion, the variable or multiple response set bound to the question
may or may not be pasted along with the question. The result depends on whether you
paste to the same file or to a different file and whether a variable or set of the same
name already existsin thefile.

Pasting a question to the same form. |f you paste a question into the same form you
copied it from, anew variableis created for the question. The result is a new question
with properties similar to the original question but bound to a separate, newly created
variable. Thisisaquick way to create several questions (and variables) with similar
properties.

Pasting a question to a different form in the same file. If you paste aquestion to adifferent
form in the samefile, only the question is pasted, since the variable already existsin
thefile. Theresult isanew question bound to the same variable asthe original question
(since the same variable can be represented on several forms).

Pasting a question to a different file. If you paste aquestion to aform in adifferent file,
both the question and variable are pasted. If avariable with the same name already
existsin the file, the pasted variable is renamed to avoid a conflict.

Rules associated with questions and variables. Skip & Fill rules are copied along with
guestions, and Validation rules are copied along with variables.
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Copying Questions from Question Libraries

The question libraries are a collection of files containing ready-to-use questions on
topics such as general demographics, customer satisfaction, and customer preferences.
Thevariables attached to the questions are defined, including val ue label sand response
items. You can access the question libraries from the Edit menu.

Y ou can copy questions from the library into your form and use them asthey are or
customize each to your particular needs. By modifying the question text and response
items, the questionsin the libraries may serve as the starting point for almost any type
of survey.

For more information on how to use the question libraries, see Chapter 9.

Cutting and Deleting Questions

When you cut or delete a question from aform, the variable or multiple response set
bound to the question is not cut from the data file. You can delete the variable or
multiple response set in the Builder window.

Avoiding orphaned variables. \Whenever you delete questionsfrom aform, be awarethat
you may be leaving orphaned variables behind. For example, suppose you create a
guestion with the toolbox, immediately realize you made amistake, and then select and
delete the question. Although the question has been deleted, the variable created with
the question remains. Over time, your data file may become cluttered with unneeded
variables.

To avoid this situation, use Undo (on the Edit menu), rather than Delete, to remove
guestions immediately after creating them. If you use Undo, the variable or multiple
response set created along with the question is also removed.

To Remove a Question Using Undo

You can use Undo Create New Object(s) on the Edit menu, rather than Delete, to
remove questions after creating them (for example, if you create a question and
immediately realize you don’'t want the question). When you use Undo, the variable
created for the question is also removed. This method will avoid cluttering your file
with orphaned variables.
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» After creating the question, from the Form window menus choose:

Edit

Undo Create New Object(s)

Figure 4-18

Using Undo Create New Object(s) to remove a newly created question

ES| Forml

Eileyiew Layout Hules Help

Undo Create Mew Object(z]

Chl+Z

| 2]08 = slofe R[S

EI Eeda [t

= iyl SRR .
Copy Chrl+C ROO007) R
Baste Chil+v il
Delete Del P
Select Al Clrl+2, Crr
Dther Respanse Chl+R g .

M atriz

4 I " Question Library

Find. .
Replace...

Crl+F
Chil+H

Multiple Undo. You can undo multiple actions by repeatedly selecting Undo Create New
Object(s) on the Edit menu, essentially backing through your actions one step at atime.
For example, if you create three questions one after another, you could select Undo

three times to remove all three questions.

To Delete Questions and Variables in the Builder Window

» From the Builder window menus choose:

View
Questions

» Select one or more questions and press the Delete key. (To select multiple questions,

hold down the Shift key or Ctrl key as you click with the mouse.)
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To delete the variable or multiple response set bound to the question:

» From the Builder window menus choose:
View
Variables

» Select the variables or multiple response sets and press the Delete key.

When you delete a variable or multiple response set, any questions still bound to the
variable or set are also deleted. Thisis because a question cannot exist without the
underlying variable or set.

Question Examples

This section provides examples of the different types of questions that you can create
during a session, along with specific instructions for creating each type of question.
The sample questions can also be found in the file Manual examples.sav, which is
installed in the same directory as your software. You can copy and paste the sample
guestions onto your own forms and customize them as needed.

Response Control Types

Every question has one or more controls that allow the user to enter aresponse. A
number of response control types are available, including:

Text boxes
Long text boxes
Option buttons
Check boxes
List boxes
Drop-down lists

Other response

A question can have one response control or many. In most cases, if a question has
more than one response controal, it represents a multiple response set rather than a
single variable.
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Response controls may appear different in print than online; not all control types
are appropriate for a printed form. See the descriptions of individual control types
for details.

Text Boxes

Text box controls allow usersto type a custom response. The length and format of the
response depends on the variable bound to the question.

A text box control is not the same as atext annotation, which istext on aform that
is not bound to any variable. Y ou add text annotations to forms using the text tool.

Figure 4-19
Text box question

Date of purchase |

The value entered must either match the format of the variable bound to the question
(specified in the Variabl e Properties window) or match aresponse item defined for the
variable. For example, if the variable type is numeric, the user can enter any numeric
value but cannot enter yes unlessyesis specified as aresponse item for a specific value
(for example, 1 = yes).

The display format for the typed value depends on the variable. Available formats
include numeric, string, date, currency (dollar or custom), and scientific notation. If the
variabletypeis string, any string is accepted (letters or numbers) unlessit exceeds the
maximum length (up to 255 characters). If you need to accommodate more characters,
create along text box control instead.

Tip: To format text boxes so they print as underlines on a printed form, change the
Border Style property for the text box to Underline in the Properties window.

To Create a Text Box Question

» |f thetoolbox isnot visible, from the Form window menus choose:

View
Toolbox



79

Questions

» Click the text box question tool to select the tool. (Hold the mouse pointer over each
tool for a description.)

» Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse
on the form rather than using asimple click.

m  To edit the question text directly on the form, double-click on the text.

®  To modify variable properties, right-click on the question and select Variable
Properties.

Tip: A text box is not the same as atext label, which istext that is not bound to any
variable. You add text |abels to forms using the text tool.

Long Text Boxes

Long text box controls allow users to enter open-ended responses. These differ from
regular text box controls because the user can enter more than 255 string characters.

Figure 4-20
Long text box question

How else can we improve our senice:

=]

u o

The value entered must be astring. Any string is accepted (letters or numbers) unless
it exceeds the maximum length (up to 4,000 characters).

Long text boxes do not have a one-to-one correspondence with avariable, as other
controlsdo. DataEntry Builder actually creates multiple variablesto accommodate the
responsesfor long text boxes. One variable actsasan index for therest of the variables,
which contain the response text. Each of these content variables holds 255 characters.
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The name of the index variable has the format @nn, where nn is a sequential number
(for example, @01). Each name of acontent variable hastheformat @nniiii, whereiiii
isanumber indicating the variable' sindex (for example, @010001, @010002, and so
on). Do not modify any of these variables.

To Create a Long Text Box Question

» |f thetoolbox is not visible, from the Form window menus choose:
View
Toolbox

» Click thelong text box question tool to select the tool. (Hold the mouse pointer over
each tool for a description.)

» Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse
on the form rather than using a simple click.

m To edit the question text directly on the form, double-click on the text.

Note: You cannot edit the variables for long text boxes. Do not try to modify the name
or the properties for the variables, which aways begin with the at sign (@).

Option Buttons

Option buttons offer users a choice between mutually exclusive options. In agroup of
option buttons, only one button can be selected. Because users can select only one
response, option button groups always represent asingle variable rather than amultiple
response set.
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Figure 4-21
Option button question

Hiow would you rate your averall
satisfaction with this product?

O Very satisfied

O Somewhat satisfied
O Somewhat dissatisfied
O Very Dissatisfied

O Mo Answer

Each option button represents one of the response items for the variable bound to the
guestion (Variable Properties window, Values tab). You cannot remove an option
button from a question without removing the corresponding response item from the
variable. However, you can set the Visible property to False for an option button to
suppress display of the button. For example, if the variable has the response item did
not answer, you' |l probably want to suppress that item from a printed questionnaire.

Default selection versus no selection. \When entering data, none of the buttonsin an
option button group is selected by default. However, once the user selects abutton, the
selection can be changed but not removed using standard keyboard controls. Torestore
the question to itsinitia state, select Delete Value from the Edit menu.

If you want one of the buttons in the group to be selected by default, set the default
value for the variable bound to the question to match the value for the corresponding
response item. (The default value and response items are specified in the General tab
and Valuestab, respectively, of the Variable Properties window.)

Tip: To create an asymmetric arrangement with five buttons in two columns, create a
guestion with six buttons and del ete one of the buttons.

To Create an Option Button Question

» |If thetoolbox is not visible, from the Form window menus choose:

View
Toolbox
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Move the mouse pointer over the option button question tool and hold down the left
mouse button to display the tool well.

Drag and rel ease the mouse in the tool well to indicate the number and arrangement of
option buttons. The well expands as you drag, allowing you to specify as many rows
and columns as needed.

Click on the form to create the question.

m To edit the question text or button captions directly on the form, double-click on
the text.

m  To modify variable properties, right-click on the question and select Variable
Properties.

m  To suppressthedisplay of one of the buttonsin the group, set the Visible property
to False for the control in the Properties window.

Check Boxes (All That Apply)

Check boxes are controls that can be turned on or off and are useful for representing
dichotomous (yes or no) questions. For example, a common use of check boxesisto
represent the variables in a multiple dichotomy set—each check box represents a
variable within the set and can be individually selected or deselected.

Figure 4-22
Check box question

Which stores do you shaop in?
O Department
O Office Product Store

O Cansumer Electronic Stare

Changing the default value. When entering data, check boxes are neither selected nor

deselected by default (thisindeterminate state is visually indicated in Entry view by a
gray mark inside the check box). To change this, set the default value for the variable
bound to the check box to the “ unchecked” or “checked” value. (The default, checked,
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and unchecked values are specified in the General tab and Values tab, respectively, of
the Variable Properties window.)

To Create a Check Box Question

» If thetoolbox is not visible, from the Form window menus choose;

View
Toolbox

» Movethemouse pointer over the check box question tool and hold down theleft mouse
button to display the tool well.

» Drag and release the mousein thetool well to indicate the number and arrangement of
check boxes.

» Click on the form to create the question.
m  To edit the question text or caption directly on the form, double-click on the text.

®  To modify variable properties, right-click on the question and select Variable
Properties.

®  To change the values stored in the variable when the check box is selected or
deselected, modify the checked and unchecked values (Variable Properties, Vaues
tab). Y ou can also edit the default value for the variabl e to change the default state
for the check box.

Drop-Down Lists

Drop-down lists alow the user to choose from alist of responses. Thelist is displayed
only when the user clicks on the control, saving space on the form. The user must
choose one of the options from the list—a custom value cannot be entered.

Because the drop-down list is displayed only when the control is selected, thistype
of control is not appropriate for a printed form. Use option buttons instead.
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Figure 4-23
Drop-down list

What is your highest level of education? j

Mo answer

Mever attended high school
Some high school

High school

Some College

College Graduate

Fost Graduate

Post graduate

Dan't know

Refused

Items on the list correspond to response items for the variable bound to the question
(Variable Properties, Values tab). You can specify the sequence of response items and
suppress the display of individual response itemsin the List Items dialog box.

To Create a Drop-Down List

» |f thetoolbox is not visible, from the Form window menus choose:
View
Toolbox

» Click the drop-down list question tool to select the tool. (Hold the mouse pointer over
each tool for a description.)

» Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse
on the form rather than using asimple click.

m To edit the question text directly on the form, double-click on the text.

m To specify theitemsthat appear in the drop-down list, select the drop-down control
and double-click the List Itemsfield in the Properties window.

m  To modify variable properties, right-click on the question and select Variable
Properties.
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Single-Selection List Boxes

Single-selection list boxes display alist of responses from which the user can choose
only one. List boxes occupy more space on forms than drop-down lists but may allow
for faster entry of data because the user doesn’t need to select the control in order to
view or select itemsfromthelist. If thelist of itemsistoo long to be completely visible,
scroll bars are displayed.

Figure 4-24
List box

Family income

Less than $20,000
520,000 to §24 999
§25,000 to §34 990
$35.,000 to §44 999
§45 000 to §54 990
£55,000 to §R4 999
565,000 to §74 999
§75,000 or more

Items on the list correspond to response items for the variable bound to the question
(Variable Properties, Values tab). You can specify the sequence of response items and
suppress the display of individual response itemsin the List Items dialog box.

To Create a Single-Selection List Box Question

>

If the toolbox is not visible, from the Form window menus choose:

View
Toolbox

Click the single-selection list-box question tool to select the tool. (Hold the mouse
pointer over each tool for a description.)

Click on the form to create the question.

Optionally, you can specify the size and position of the question by dragging the mouse
on the form rather than using a simple click.
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To Specify the Responses in a List Box or Drop-Down List

m To edit the question text directly on the form, double-click on the text.
m  Tomodify propertiesfor aquestion or control, right-click on the control and select

Properties.

m To specify thelist items, select thelist box control and double-click the List Items

field in the Properties window.

m  To modify variable properties, right-click on the question and select Variable

Properties.

List Items allows you to specify the items displayed in adrop-down list or list box.

Figure 4-25
List ltems dialog box
Visible Caption | [ ox |
v |Moanswer C |
[¥ |Mewver attended high school 4|ance
¥ | Some high school Help |
¥ |High school
[ |Some College A|
¥ | College Graduate
[v  |Post Graduate v|
[¥ | Post graduate
v  |[Don't know
v  |Refused

Mew [tem |

Delete |

Create adrop-down or list box question.

On the form, right-click on the drop-down or list box control and select Properties.
In the Properties window, double-click in the List Itemsfield.

Inthe List Items dialog box, use the buttons and arrows to add, delete, and move

individual items.
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» To hidealist item without removing it, deselect the Visible check box.

Ordinal Scale with Endpoint Labels

You can use the option button question tool to create a button scale with endpoint
labels.

Figure 4-26
Button scale with endpoint labels

How satisfied are you with your job?

Highly unsatisfied [} [} [} [} [} Highly satisfied

m  The question represents a single variable. Each point on the scale represents a
specified value for the variable.

m  The endpoint labels Highly unsatisfied and Highly satisfied are separate labels
(added with the text toal).

m Hide the caption for each button by resizing each button control so the captionis

not visible.

Alternatively, you can use a scale button matrix for this type of question.

To Create an Ordinal Scale Question with Endpoint Labels

>

>

Create an option button question with a single row of buttons.

Double-click on the question text to edit the text. Y ou can a so edit the response items

if desired.

Select all button controls and use the Properties window to set the AutoSizeToFit
property to False.

Select each button control and resize the control so the caption is no longer visible.
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» Usethetext tool to add the endpoint labels.

Figure 4-27
Resizing an option button control

Howe satisfied are you with your job?

Highly unsatisfied O o] :5:% QO Response O Response  Highly satisfied
EEEm

Alternatively, you can use a scale button matrix for thistype of question.

Scale Button Matrix

A scale button matrix isaset of questions that shares acommon set of response items.
The matrix provides a mechanism for aligning questions on the form and displaying
shared response text in column labels. In addition, you can modify a scale button
matrix to display a numeric scale rather than buttons in each row.
Figure 4-28

Scale button matrix

Please rate your sales representative on the following characteristics:

Excellent Wery Good Good Fair Foor
Helpfulness a a ] 3 a
Promptness a a ] 3 a
Knowledoe of product a a a a a
Figure 4-29
Matrix with numeric scale displayed
Please rate the imporantance of the following product characteristics:
Imporant Mot Important
Reliahility 1 Z 3 4 5
Frice 1 2 3 4 5
Range of features 1 2 3 4 5

See Chapter 6 for instructions on creating a scale button matrix.
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Multiple Responses Coded As Dichotomies

When you want to receive ayes or no answer to aspecific set of subquestions, you can
use a multiple response set coded as dichotomies. A set coded as dichotomiesis
composed of the set and as many variables as needed to ask the subquestions.

Multiple dichotomy sets can be represented as check boxes, list boxes, text boxes,
or drop-down lists.

Figure 4-30
Question with multiple responses coded as dichotomies

Which of the following products do you own?
O Fax Machine

O Copier

O Computer

O Laser Printer

See Chapter 8 for instructions on creating multiple response questions.

Multiple Responses Coded As Categories

When you want to receive open-ended responses or responses sel ected from predefined
categories, you can use a multiple response set coded as categories. A set coded as
categories asks aquestion and provides anumber of text boxesto collect the responses.
Each text box represents a variable that is part of the set. You can also use single-
selection list boxes or drop-down list boxes to display predefined categories.

Figure 4-31

Question with multiple responses coded as categories

In order of frequency, please list the three
stores you use for purchasing high tech
eguipment.

See Chapter 8 for instructions on creating multiple response questions.
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Questions with an “Other” Response

Sometimes you will want to ask a question for which you cannot list all of the possible
responses. You can use the other response to give respondents the option of using a
response not listed in the question.

When you create a question with an other response, an additional variable bound to
the question is created. The additional variable does not appear in the Variablelist in
Builder, although it does appear in Table Entry view and will appear when you open
thefilefor analysisin software from SPSS Inc. The additional variable hasan aliasthat
you can usein rules. The aliasis the name of the original question’s variable plusthe
letter 0. For example, if you have a question tied to the variable shop and you add an
other response to that question, the alias for the other response’ s variable is shopo.
Figure 4-32
File in Table Entry view

B Forml (O] x|
Fil= Edit Wiew Data Bules Help

={a| Sl b(ele] || 2l o sfE el
MKEE >|>||Hc|o|_|_|

HEARABT | OTHERDD2| MYS5T ROMANCE SCIFI |/
1 Other Direct b ail 0 0 0 o |
2 0 0 0 0
3 0 0 0 0_
4 -
[4] | i
FUBAMEN: [3/3 F.,_“i‘ Skip&Fil: On  |Auto Chec

Using the other response for option button and list box questions simplifies data
analysis. You will have to run afreguency only on the additional variable, since the
responses to the questions are stored in that variable.

You can create an other response in three ways:

m  Usethe Other tool in the toolbox.

m Right-click on an eligible question container and select Other Response.

m  Select an eligible question container and from the Edit menu, choose Other
Response.
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You can add an other response to option button questions, check box sets, single-
selection list box questions, and drop-down list box questions. You cannot add an other
response to a matrix, atext box question, or atext box set.

A question can have only one other response. Y ou cannot copy and paste an other
response from one question to another question.

Figure 4-33
Option button question with an “other” response

Howe did you hear about our company?
O Radio'Tv Ad

2 Newspaper Ad

O Internet

2 Personal Recommendation

S —

Figure 4-34
Check box multiple response set with an “other” response

What types of fiction books do you read? (Select all that apply.)
O Literature
Ol hystery
CORomance
O Science Fiction

o N

Figure 4-35
Single-selection list box with an “other” response

Which public amenity do you use the most?

Swimming Pool
Bike Path

Library
Caornrmunity Center
Park

Other

L ]




92

Chapter 4

Figure 4-36
Drop-down list box with an “other” response

How do you prefer to shop?

I - |
hall

Mail Order Catalog

Cinline

Television Home Shopping
Other

To Create a Question with an “Other” Response

» Select an eligible question container (either an option button question, acheck box set,
asingle-selection list box question, or adrop-down list box question).

» From the Form menu choose;
Edit
Other Response

Alternatively, you can use the Other tool from the toolbox or right-click on the question
container and select Other Response from the context menu.
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Customizing Questions
and Controls

You can modify the size, position, appearance, and behavior of questions and other
form objects using several methods:

Use the mouse to select, position, and resize questions and controls.

Use the Properties window to modify properties of questions and contrals.
Use the Layout menu and to arrange, align, and group questions and controls.
Use the toolbox to add question numbers to created questions.

Use the Properties window to change the properties of question numbers.

To Select Questions and Controls on Forms
Figure 5-1
Selecting a question with the mouse

& Forml =] E3

File Edit “iew Layout HRules Help

(8| SR tl@| of-| 26| = o R[]

: Q Excesded expectations
S+ Wy Met expectations
0 € Fell short of expectations
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To select aquestion, click on the question border.
To select a control within aquestion, click directly on the control.
To select multiple objects, hold down the Shift key as you click on the objects.

To select al of the abjectsin arectangular area, hold down the left mouse button
and drag the mouse to draw arectangle around the objects.

To edit text directly on the form, double-click on the text.
To select aform, click on the form background.

Primary selection. If you select multiple objects, the object that you select first isthe
primary selection. If you use the Layout menu or formatting toolbar to align objects,
the objects are aligned relative to the primary selection.

If you select multiple objects by dragging arectangle, the top-1eft object isthe
primary selection.

Figure 5-2
Drag the mouse to select all of the objects in a rectangular area
& Forml H=] B3

File Edit “iew Layout HRulez Help

(8| slR| e o] 25| = ok 2

- Exceeded expectations

-1 0 O Met expectations
21 |Q Fell shart of expectations
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Properties window

&7 Properties - Questionl E3
B ackCalar
BackSiyle Opague
BarderColor
BorderStyle 0-MNone
Borderw/idth 0 - HairLine
Enahbled True
Entrybdode DioubleEntry
Height 43
Left 7e
l!g [uestionl
Mumber Falze
Mumberlocation |0 - Left
MumberF estart Falze
Required Falze
SpecialEffect 0-Flat
StatuzBarT ext
Top 24
Y ariable WaR00001
Vigible True
Width 138

Customizing Questions and Controls

To Modify Properties for a Form, Question, or Control

» To display the Properties window, press Alt-Enter, or from the Form window menus

choose:;

View
Properties

» Select the form objects for which you want to specify properties.

» Specify the desired value for each property in the right column.

For some properties, you can choose from alist of choices. For others, you can double-

click to open adialog box.

m  Asashortcut, you can a so access properties by right-clicking on aform object and
selecting Properties.

m  To set properties for multiple objects, hold down the Shift key as you select the
objects on the form. Properties common to all selected objects are displayed,
allowing you to modify them with asingle gesture.
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m  Changes to properties are updated immediately on the form. Y ou don’t need to
close and reopen the Properties window for changes to be applied.

To Edit Text on a Form

Figure 5-4
Editing form text

& Form1 [_ (O] =]

File Edit “iew Layout HRulez Help

(8| SR 4lw(@ o] 26| = ok 2

Dl problem resolution meet e
% Exceeded expectalions
-+ 0 O Met expectations

D100 Q) Fell shart of expectations

» To edit text directly on the form, double-click on the text.
m  Press Enter to commit changes.
m Press Esc to cancel changes and restore the original text.
m Press Ctrl-Enter to insert a carriage return (so that text will wrap to the next line).
|

Before editing text, you may want to enlarge the text control by dragging the
selection handles so that more text will be visible as you type.

To edit text in the Properties window, click on the Text or Caption property (as
appropriate) and type the desired text.

Positioning and Aligning Questions and Controls

You can align and resize questions and controls using the mouse, the Properties
window, the Layout menu, or the formatting toolbar.
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To Move a Question or Control

Figure 5-5
Moving a question

& Forml H=]

File Edit “Wiew Lawout Bulez Help
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O Exceeded efxpectatinns
-+ W3y et expectations
10 Fell short ofiexpectations

» Select the questions or controls that you want to move.

To select multiple objects, hold down the Shift key as you click on the objects.

» Hold down the left mouse button to drag the selected objects.

®  When you move or resize controls within a question, the question frame expands
as needed.

® When you move a question, controls within the question also move.

To specify the exact position of a question or control, modify the Top and Left
propertiesin the Properties window.
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To Resize a Question or Control

>

Figure 5-6
Resizing a question

& Forml M=l E3

File Edit “iew Layout Bules Help

23| SlR| $R(@| of-| 26| = &l@Ek 2=
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1 Did problem resaolution meet expectations? :

O Exceeded expectations
-+ Oy Met expectations
. O Fell short of expectations

Click on the question or control that you want to resize.

Selection handles appear around the selected object.

Drag the selection handles on the sides and corners to resize the object.

Toresizeal of the controlsin aquestion with asingle action, select the question along

with all of its controls, and then drag the outer question border.

To specify the exact dimensions of an object, modify the Height and Width properties

in the Properties window.

Tip: Text controls will automatically resize to fit their contents if the AutoSizeToFit
property is set to True for the object. To quickly size a newly created object, double-
click onit, edit thetext if necessary, and then click away from the object to deselect it.

By default, AutoSizeToFit is always on unless you turn it off.
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To Align Questions and Controls Using the Properties Window

You can position form objects according to precise coordinates by modifying their Top,
Left, Height, and Width properties. This can be particularly useful when you want to
align multiple objects.

» Todisplay the Properties window, from the Form window menus choose:
View
Properties

» Select the objects that you want to align.
If you select multiple objects, properties common to the selected objects are displayed.

» Edit the Top, Left, Height, and Width properties as needed.
m Toalign selected objects vertically, specify acommon value for the Left property.
m  To align objects horizontally, specify a common value for the Top property.
®  To make objects the same size, specify common values for Height and Width.

To Align Questions and Controls Using the Layout Menu

The Layout menu and formatting toolbar offer anumber of featuresto quickly align or
arrange objectson aform. The primary selection object acts as an anchor, and all other
selected objects are aligned to it based on the chosen position.
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Figure 5-7
Aligning objects with the Layout menu
B Printed Yersion !EB
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In the Form window, select the objects that you want to align.

From the Form window menus choose:
Layout
Align
You can align objects relative to their sides, middles, tops, bottoms, or centers.

Tip: If the results are not as you expected, choose Undo Align from the Edit menu to
reverse the action. For example, depending on the position of the primary selection,
objects may be partially or entirely stacked on top of one ancther.
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To Align Questions and Controls to the Grid

» To turn on Snap to Grid, from the Form window menus choose:

Layout
Snap to Grid

All objects subsequently added to the form are aligned to the nearest grid point.
However, Snap to Grid does not affect existing form objects.

» Toalign existing form objects to the nearest grid point, select the objects and from the
menus choose:
Layout
Align
Align to Grid
Figure 5-8
Aligning questions and controls to the grid
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Tip: Even when Snap to Grid is on, entering values for an object’s Top and Left
properties allows you to place an object exactly where you want it.
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To Layer Questions and Controls on a Form

When questions and controls overlap on aform, you can use the Layout menu to

control which object is on top of which.
Select the objects you want to layer.

From the Form window menus choose;

Layout
Layer
Bring to Front (or Send to Back)

Figure 5-9
Sending an object to the back
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Tip: Text and pictures can be either “inside” of questions or on top of them, depending
on how they are created. If you click thetext or picturetool within an existing question,
the text or picture becomes part of the question. If you want text to be on top of the
question, create the text outside of the question and then drag the text to overlap the
question. (If thetext disappears behind the question, immediately use Bring to Front to

bring it to the top.)
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Grouping Questions

Figure 5-10
Grouped questions
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Grouping questions allows you to move, number, and display questions as ablock. For
example, you may place all of your demographic questions into a group. Grouping
guestions allows you to easily move the group to another section of the form.
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Figure 5-11
Properties of a group
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For more information about tab order, see Chapter 10.

To Create a Group

The group container has the same properties as a question container, such as
background and border color. You can set the group container properties and you can
also select and set the properties of individual questions within the group.

When you group questions, they show up in the tab order of your form as a group.
Y ou can number them individualy or as part of the group.

» Select the question containers of the questions that you want in the group.

» From the Form window menus choose;

Layout
Group
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Note: You can group multiple response setsonly by selecting the multiple response sets
and using the Group menu item.

Alternatively, you can group questions by dragging and dropping a question into
another question’s container.

Or you can use the toolbox to create a question inside of another question’s
container.

If you use the toolbox with questions of the same type, you must right-click inside
of the question container and from the context menu choose Create New Question. If
you simply click your mouse, you will not automatically get a new question. Instead,
you will get additional response items added to your existing question.

Y ou can create agroup of questionswithin agroup. For example, you might have a
group of questions containing personal information, and then within that group, you
might have a group of severa questions that represent an address.

To Ungroup Questions

» Select the group container.

» From the Form window menus choose:

Layout
Ungroup

If you want to remove only certain questionsfrom agroup, you must ungroup the entire
group and then regroup the questions that you want in the group.

Adding Responses to Existing Questions

You can add response choices to an option button or multiple response question by
using the form toolbox to add response controls or by copying and pasting response
controls between questions using the clipboard. You can add response choicesto alist
box or drop-down list question by adding itemsin the List Items dialog box.
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Figure 5-12
Response control added to a question
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®  When you add an additional option button to a question, a corresponding response
item is added to the variable bound to the question.

m  When you add an additional subquestion (with response control) to a multiple

response question, a corresponding variable is added to the multiple response set
bound to the question.

You can a so add subquestionsto amultiple response question by dragging one or more
variables from the Builder window onto the question.

To Add Response Controls to Questions Using the Toolbox

You can add additional response controls to option button and multiple response
guestions using thetoolbox. New controls must match the type of existing controls. For
example, you can't add check boxes to an option button question.

» |f thetoolbox isnot visible, from the Form window menus choose:
View
Toolbox

» Click the question tool for the desired type of response control (option button, check
box, and so forth).
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Optionally, you can drag and release the mouse in the tool well to specify the number
of controls that you want to add.

» Move the mouse pointer over an existing option button or multiple response question
of the same type as the selected tool.

The question is highlighted to indicate that it is receptive to the tool.

» Click inside of the question to add the control.

Figure 5-13
Adding a response control to an existing question
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Tip: To avoid adding new controls on top of existing controls, click near the bottom or
side of the question (on or near the border). The question border expandsto make room
for the new controls.

To Copy and Paste Response Controls
You can copy and paste response control s between option button and multiple response
guestions. The question type must match the control being pasted. For example, you
can't paste a check box control into an option button question.

» Select the controls that you want to copy.
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>

From the Form window menus choose:
Edit
Copy
Select the question to which you want to paste controls, and from the menu choose:
Edit
Paste

The question that you paste to can be on the same form or a different form. You can
even copy and paste to the same question to quickly add an additional response control.

Pasting text. You can copy static text (created with the text tool) and paste it into any
guestion. The text becomes part of the question.

Pasting entire questions. You can also copy and paste entire questions as a shortcut for
creating new questions. For more information, see Chapter 4.

To Add Variables to Multiple Response Questions

>

From the Builder window menus choose:

View
Variables

Select one or more variables. (To select multiple variables, hold down the Shift key or
the Ctrl key asyou click on the variables.)

Hold down the left mouse button to drag selected variables from the Builder window
over the question.

The question is highlighted to indicate that it is receptive to the variables.

Rel ease the mouse button to add the variables.
For each variable, anew subquestion (with aresponse control) isadded to the question.
Tip: To avoid creating new controls on top of existing controls, drop the variable near

the bottom or side of the question (on or near the border). The question border expands
to make room for the new controls.
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To Add or Remove Responses in a List Box or Drop-Down List

» Ontheform, right-click onthelist box or drop-down list that you want to modify and

select Properties.

» Inthe Properties window, double-click in the List Itemsfield.

Figure 5-14
List Items dialog box
Visible Caption [ o |
W Mo answer C |
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Mesw [tam | Delete |

» InthelList Itemsdialog box, use the buttons and arrows to add, delete, and move

individual items.

» Tohidealist item without removing it, deselect the Visible check box.

Adding Responses by Modifying Variable or Set Properties

You can add response choices to single response questions by adding response items
to the variable bound to the question. Similarly, you can add response choices
(subguestions) to multiple response questions by adding variables to the multiple
response set bound to the question. In either case, all questions bound to the variable

or set are automatically updated.

For example, if you have a multiple dichotomy set represented as check boxes,
adding a variable to the set creates a new check box in the question.
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Understanding the Connection between Questions and Variables

Remember that questions and variables are not the same thing in the program, but they
are closely related. You can use the program without ever understanding this
connection, but the many different methods for adding and removing responses from
guestions and variables will make more sense to you if you do.

A question is arepresentation of avariable on aform, and the question text and
response items displayed in questions are actually stored in the variable bound to the
question.

This makes it easy to keep your questions and forms up to date and provides
multiplewaysof doing things. Y ou can edit question text and response choicesdirectly
on your form or in the Variable Properties window. Either way, the result is the same.
Similarly, if you want to remove one of the buttons in an option button question, you
can select and del ete the button right on the form, or you can delete the corresponding
response item in the Variable Properties window. The result is the same, so use
whichever method is convenient for you.

To Add Response Choices by Modifying Variable Properties

>

>

>

You can add option buttons to an option button question or add new itemsto alist box
or drop-down list question by adding response items to the variable bound to the
question.

On the form, right-click on the question and select Variable Properties.

In the Variable Properties window, click the Values tab.

Enter new items in the Response Item column.
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Figure 5-15
Response items displayed in the Variable Properties window
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For each new response item, a corresponding option button or list item is added to the
guestion. All guestions bound to the variable are automatically updated. For more
information about modifying variable properties, see Chapter 7.

To Add Subquestions by Modifying Set Properties

You can add response controls to an existing multiple response question by adding
variables to the set bound to the question.

» Right-click on the multiple response question and select Variable Properties.
» In Set Properties window, click the Members tab.

» Click Insert New Variable to add a new variable, or click the check box of an existing
variable that you want to add to the set.
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Figure 5-16
Set members displayed in the Set Properties window

Set Properties: $shop E2

General Members |

Mame | C. | Label | Format | File Order | -
Bl SHOP1  On Dep.. F20 10

B sHOP2  On Ofi. F20 11

El# SHOP?  On Con.. F20 12

O SaTISF1 O Owe. F20 1

O % RECOM.. Of FRec.. F2.0 :l
O PDELIV.. OF Pef.. F40
O PRELIA.. OF Perf.. F40
O@®aual  Of  Perf.. F4.0

o B ) B N L )

O use Off  Freq.. F20
M & Fall M P =] LI
Inzert Mevs Variable |

Cloze I Help |

For each variable added to the set, a corresponding response control is added to the
question. All questions bound to the set are automatically updated.

For more information about modifying set properties, see Chapter 8.

To Remove Response Controls from a Question
» Click on the response control that you want to remove.

» PressDelete (or choose Cut from the Edit menu).

m |f you delete an option button, the corresponding responseitem is deleted from the
variable bound to the question.

m |f you delete a subguestion (along with response control) from a multiple response
guestion, the corresponding variable is removed from the set. However, the
variableis not deleted from the file (the variable still exists but is no longer
included in the set).
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m  Alternatively, if you delete response itemsfrom avariable or delete variablesfrom
a set, the corresponding response controls or subquestions are deleted from
guestions bound to the variable or set.

Tip: To hide aresponse control without removing it from the variable or multiple
response set, use the Properties window to set the Visible property to False for the
control.

To Change the Response Control Type for a Question

You cannot change the response control type for an existing question—for example,
you cannot change a drop-down list into a group of option buttons. However, you can
create a new question based on the same variable or multiple response set as the
original question but with a different control type.

Figure 5-17
Dragging a variable onto a form
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» From the Builder window menus choose:
View
Variables

» Select the variable or multiple response set bound to the original question.

» Hold down theright mouse button to drag the selected variable or set from the Builder
window onto aform.

» Move the mouse to the desired position on the form and release the mouse button.

» Select the desired response control type from the context menu.

The new question shares the same variable or set as the original question.

» Deletethe original question if desired.

Customizing the Appearance of Questions and Controls

You use the Properties window to modify the appearance of questions and controls.
You can:

m Change the font, size, and color of the text.

m  Apply custom styles, such asflat, raised, or sunken.

m  Change the border style, color, and width.

m  Change the position and aignment of text within controls.

To Change the Font for Form Text
You can specify the font, size, and style for form text in the Fonts dialog box.
» Inthe Form window, click on the text you want to modify.
» From the menus choose:

View
Properties
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» In the Properties window, double-click the Font field.

Figure 5-18
Fonts dialog box
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» Inthe Fonts dialog box, select the desired font, size, and style.
» To change the text color, use the Font Color property.

Notice that the Fonts property is available only when you select objects that contain
text.

To Set the Default Font for a Form

You can specify the default font for text on aform using the Properties window. The
font appliesto text subsequently added to theform; it does not apply to existing objects.
Setting the font before you begin can save alot of time.

» Inthe Form window, click on the form background to select the form.
» From the menus choose:

View
Properties
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» Inthe Properties window, double-click the Font field.

» Inthe Fonts dialog box, select the desired font, size, and style.

To Apply a Custom Style to a Question

You can apply aflat, raised, or sunken style to a question using the Special Effect
property.

» Select the questions or controls that you want to modify.

» From the menus choose:
View
Properties

» Inthe Properties window, edit the Special Effect property.

Note: For option buttons, the Special Effect property choices are flat, sunken, and
square.

To Change the Color or Border Style for Questions or Controls

You can specify the color and appearance of questions and controls using the Back
Color and Back Style properties.

» Select the objects you want to modify.

» From the menus choose:
View
Properties
» In the Properties window, modify the Back Color and Back Style properties.
m  The background color setting is ignored when Back Styleis transparent.

m The Border Color and Border Style properties specify the appearance of the
question border.

m The Font Color property specifies the color of text.
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®  To make text boxes print as underlines on a printed form, set the Border Style to
Underline for the text box.

To Specify the Caption Position for a Check Box or an Option Button

You can specify whether the caption for a check box or an option button control is
positioned to the left or right of the button using the Caption Position property.

Figure 5-19
Left-aligned captions

Did problern resolution meet expectations?
Exceeded expectations

Met expectations O
Fell short of expectations O

Mo response O

Select the check boxes or option buttons that you want to modify.

From the menus choose:
View
Properties

In the Properties window, edit the Caption Position property.

Tip: Changing the caption position may not produce expected results when the
AutoSizetoFit property ison for acontrol. For best results, turn this property off in the
Properties window.

To Specify the Alignment of Text within a Control

You can specify the horizontal alignment (justification) of text within a control by
using the Horizontal Alignment property. For option button and check box controls,
you can also specify the vertical alignment of the caption relative to the control.
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Figure 5-20
Left-, center-, and right-aligned text
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| Center alignment |

| Right alignment |

Select the object that you want to modify.

From the menus choose:
View
Properties

In the Properties window, edit the Horizontal Alignment or Vertical Alignment
property.

Tip: Changing the alignment of text may not produce expected results when the
AutoSizeToFit property ison for acontrol. For best results, turn this property off inthe
Properties window.

To Disable a Question or Control

>

You can disable questions and control s by setting the Enabled property to False. When
acontrol is disabled, it cannot receive the focus in Entry mode. Thisis useful if you
want a question to be visible on the form but don’t want the data in the question to be
modified.

Select the controls that you want to disable (or enable).
From the menus choose:
View

Properties

In the Properties window, set the Enabled property to False (or True).
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To Hide a Question or Control

You can hide aquestion or control by setting its Visible property to False. The control
isno longer visible in Form Entry view. Thisis especially useful if you want to
suppress the display of aresponse control in a question without removing the
corresponding response item or variable.

» Select the controls that you want to hide (or unhide).

» From the menus choose;

View
Properties

» Inthe Properties window, set the Visible property to False (or True).

Setting Visible to False hides the object only in Form Entry view; the object is still
visiblein Design view.

To Specify Status Bar Text for a Question

When a question has the focus, you can specify the text to be displayed in the status
bar using the Status Bar Text property. The specified text is displayed whenever the
user clicks on the question in Entry mode. For multiple response questions, you can
specify different status bar text for each subquestion.

» Select the question.
» From the menus choose:
View

Properties

» Inthe Properties window, specify the desired text for the Status Bar Text property.
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Setting Default Tool Properties before You Create Questions

Tool properties allow you to specify the default properties of questions before you
create them. For example, suppose you want to use a specific font in all of your
guestions. Rather than modify each question after you create it, set the Font property
for your question tools before you create questions. This saves time because you avoid
modifying questions after creating them.

Figure 5-21

Properties for the option button question tool
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» Inthetoolbox, click on the desired tool.

» To display the Properties window, from the menus choose:

View
Properties

» Specify the properties for the tool in the right column of the Properties window.
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The properties are applied to al objects subsequently added to the form with the tool.
Tool properties are saved with the form, so you can specify different defaults for
different forms. Newly created forms inherit tool defaults from the last open form.

Question Numbering

Builder includes a feature that allows you to number your questions, subguestions,
matrices, and text annotations. Question numbers appear in aseparate control. You can
set properties for that control, but you cannot edit the text of the control.

If you are creating anew form, it is easy to use automatic question numbering. Y ou
simply set the form’s AutoNumber property to True. Every question you create is
numbered and the numbers change to reflect actions, such as deleting a question.
Figure 5-22
Applying question numbers to multiple questions
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When you have an existing form of unnumbered questions, you can select individual
guestions and use the Question Number tool from the toolbox to add question numbers.
Or you can select many questions at once and use the Layout menu’s Numbering
submenu to add question numbers. You can select questions in any order since the
order of question numbersis controlled by the tab order of the form.



122

Chapter 5

Question numbering in Builder is dynamic, which means that the numbers
automatically renumber when any of the following happens:

m Thereisachangein the tab order of a numbered question, subquestion, or static
text.

Y ou add a new question number using the toolbox or the menu.
Y ou delete a question number.
Y ou create a new question on aform whose AutoNumber property is set to True.

Y ou delete, cut, or paste aquestion, subquestion, or static text containing anumber.
Note: If you change the order of questions on your form, you must change the tab order
of the questionsin order to have the questions automatically renumber to reflect your
changes.

For more information about tab order, see Chapter 10.

To Number Existing Questions
To add numbers to several questions at once:
» Select the questions that you want to number.
» From the Form menu choose:
Layout

Numbering
Add Question Number

Alternatively, you can use the Question Number tool in the toolbox or you can set the
guestions’ Number property to True.

Modifying the Appearance of Numbers

There are several ways to modify the appearance of question numbers.
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By changing the form’s properties, you can:

Change the delimiter, which is the symbol that appears after the number.
Delimitersinclude the period, comma, semicolon, colon, dash, or slash.

Change the number of levels shown.
Change the style of numbering.

Changethe starting number for theform. Thisishelpful in multi-form surveys. For
example, if thefirst question on Form3 isthe hundredth questionin the survey, you
would set Form3's NumberStartAt property to 100.

By changing a question’s properties, you can:

Add or delete the question number by changing the Number property.
Change the location of the question number.

Mark a question as anew start for numbering. For example, you have aform with
three sections. In each section, you want to restart the question numbering at 1. Y ou
would select the first question in each section and set the NumberRestart property
for each to True.

Figure 5-23
Question control properties
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Numbers have many of the same properties as other controls—background colors,
border styles, font, height, special effect, and alignment. You can change the properties
of anindividual number or multiple numbers at once or change the defaults for the
number tool.

Text Annotations and Question Numbering

You can add question numbers to text annotations. For example, you may have aform
divided into sections, which are titled with text annotations. You can number the text
annotations using the Question Number tool in the toolbox.

Figure 5-24
Adding question numbers to text annotations
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When you add a question number to atext annotation, you create agroup consisting of
aquestion number control and the text annotation. You may del ete the question number
by ungrouping the group or by deleting the question number.
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Y our numbered text annotation appears in the tab order as agroup. If you want to
move your humbered text annotation, you must change its position in the tab order to
update the question number.

For more information about tab order, see Chapter 10.

Example: Numbering Option Buttons

You can give question numbers to questions, subguestions, matrices, and text
annotations. However, you cannot automatically number option button responses
because they are not subquestions. There is away to number option button responses
using text annotations.

» Set your form’s AutoNumber property to True.
» Create atext annotation in front of each option button response.

» When you create the text annotation, it is much bigger than the option button response
and overlaps it. Use your mouse to size the text annotation to a reasonable size.

Figure 5-25
Option button responses with text annotations
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» Using the Question Number tool, add a question number to each of the text
annotations.

» Select each text annotation and in the Property window, delete the word Text in the
Text property field.
Figure 5-26
Numbered option button responses
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Number Aliases
Figure 5-27
Question with a number alias
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You may haveinstructionson aform that ask auser to skip to acertain question. If your

form is using automatic question numbering, you can create anumber aiasfor a

guestion number and paste that aliasinto theinstructions. Then, if the question number

changes, the alias will automatically change to reflect the new question number.

The following rules apply to aliases:

® You can create and paste aliases only from the Layout menu’s Numbering
submenu.

m |f you delete the question number used in the dlias, the dlias is also deleted.

However, you can delete an alias without affecting the question number that the

dliasreferred to.

® Y ou cannot paste aliases between forms unless you al so paste the question the alias

refersto.
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To Use Number Aliases

» Select the number control you would liketo useinthe alias.

» From the Form menu choose:

Layout
Numbering
Create Number Alias

» Select theitem that you would like to have as the dlias (this will usually be atext
annotation).

» From the Form menu choose;

Layout
Numbering
Paste Number Alias
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Creating Scale Button Matrices

A scale button matrix isaset of questions that share acommon set of responseitems.
The matrix provides a mechanism for aligning questions on the form and displaying
shared response text in column labels. Each row is a separate question representing a
separate variable, and each column holds one possibleresponse. For example, a3 x 5

scal e button matrix would represent three questions, each with five response items.

Figure 6-1
Scale button matrix
Please rate your sales representative on the following characteristics:
Excellent Yery Good Good Fair Poor
Helpfulness a a a O a
Promptness | [} [} [} [}
Knowledge of product | [} [} [} [}
Figure 6-2
Matrix with numeric scale displayed
Please rate the imporantance of the following product characteristics:
Important Mot lmpartant
Reliability 1 2 3 4 5
Price 1 2 3 4 5
Range of features 1 9 % 4 5

Tip: Matrix questionsare not multiple response questions. Multipleresponse questions
are questions that can have more than one response (for example, Which of the
following magazines do you read?). By contrast, each row in amatrix is a separate
guestion that can have one and only one response.

129
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Creating a Matrix

You can create amatrix with the form toolbox or by dragging existing variables from
the Builder window onto a form.

To Create a Matrix with the Form Toolbox

» |f theform toolbox is not visible, from the Form window menus choose:

View
Toolbox

» Movethe mouse pointer over the scal e button matrix tool and hold down theleft mouse
button to display the tool well.

» Dragand releasethe mousein the tool well to specify the number of rowsand columns
in the matrix.

» Click ontheform to create the matrix.

A variable isautomatically created for each question (row). By default, al variables
share a common set of response items.

Figure 6-3
Newly created matrix in Design view
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m Dragthe separator bars between row and column marker buttonsto make rows and
columnswider (or narrower). Marker buttonsare visiblein Design view only; they
are never visible when entering data.

m Therow labels display the question text for each variable. Y ou can edit text in the
matrix by double-clicking on the text.
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®  Thecolumn labelsdisplay responseitems. By default, when you edit the response
items in the column header, the response items are updated for all variables
represented in the matrix.

m  Usethetext tool to add text or instructions above the matrix (for example, Please
rate theimportance of the following characteristics). If you want the text to appear
within the matrix, edit the corner header.

Figure 6-4
Modified matrix in Design view
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To Create a Matrix from Existing Variables

You can drag two or more variables from the Builder window onto aform to create a
guestion matrix.

» From the Builder window menus choose:

View
Variables

» Select two or more variables.

» Hold down the right mouse button while dragging the selected variables from the
Builder window onto aform.
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>

Move the mouse pointer to the desired position on the form and rel ease the mouse
button.

When you drag and drop variables using the right mouse button, you are prompted to
specify the type of question you want to create.

Select Scale button matrix from the context menu.

The number of columns depends on the number of response items or value |abels
defined for the variables. The column heads are derived from the response items or
value labels defined for the first variable. If the first variable has no response items or
value labels, two columns are created by default. For more information on creating
questions from existing variables, see Chapter 4.

To Display a Numeric Scale in a Matrix

Figure 6-5
Matrix with numeric scale displayed

Please rate the imporantance of the following product characteristics:

Impartant Mot Important
Reliahility 1 2 3 4 5
Price 1 2 3 4 5
Range of features 1 3 3 4 5

You can modify a scale button matrix to display anumeric scale rather than buttonsin
each row.

Create a scale button matrix with the desired number of rows and columns using the
form toolbox (or by dragging variables from the Builder window).

To display caption text rather than buttonsin each cell, select the button cells and use
the Properties window to set the ButtonStyle property to Caption text for each cell.

To select multiple cells, hold down the Shift key asyou click, or drag arectangle with
the mouse.
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» Edit the default caption text for each cell by double-clicking on the column labels. By
default, when you edit the column labels, al rows are automatically updated (change
Responselteml to 1, Responseltem? to 2, and so forth).

Figure 6-6
Selecting cells by dragging the mouse
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Figure 6-7
Editing the column labels
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To enter the endpoint labelsin the first and last columns (for example, |mportant and
Not Important), you must first break the link between the column labels and the
captionsin each cell.
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» Select theentirematrix by clicking on thelower border, and use the Properties window
to set the ResponseT extUpdate property to False for the matrix.

With ResponseTextUpdate set to False, you can edit the column labels without
updating all rows.

» Edit thelabelsin thefirst and last columns, and delete the text in the labels for the
middle columns.

Modifying Matrices

You can use the Matrix submenu (available on the Edit menu) and the Properties
window to modify matrices in a number of ways. You can:

Hide (or display) row and column marker buttons.
Insert or remove rows and columns.

Display buttons or response item text in cells.
Customize cell borders.

Update responsesin all rows using the Fill Responses option.

You can a'so modify a matrix indirectly by modifying the variables bound to the
matrix. For general information on modifying question and variable properties, see
Chapter 5 and Chapter 7.

To Select Cells in a Matrix
You can select cellsin amatrix using any of the following methods:
» To select the entire matrix, click on the lower border.

» Toselect individua cells within the matrix, click on them with the mouse. To select
multiple cells, hold down the Shift key as you click.

» To select rows or columns of cells, click on the row and column marker buttons.

» Toselect al of the cellsin the matrix, click on the selector button in the upper left
corner.
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» Tosdect all of the cellsin arectangular area, drag a rectangle with the mouse. (Y ou
must start dragging the rectangle outside of the matrix to use this method.)

Figure 6-8
Selecting cells by dragging the mouse
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» To select aquestion, row, column, the entire matrix, or al cells using the menus
choose:
Edit
Matrix
Select

To Insert a Row or Column in a Matrix

» Inthe matrix, select arow, column, or cell to indicate where you want to insert arow
or column.

» From the Form window menus choose:

Edit
Matrix
Insert
Row (Column)

New rows are inserted above the sel ected row. New columns are inserted to the | eft of
the selected column.

®  When you insert rows, anew variableis created for each row.
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®  When you insert columns, a corresponding response item is added to all variables
bound to the matrix.

m Alternatively, you can add rows by dragging variables from the Builder window
and dropping them onto the matrix or add columns by adding responseitemsto one
or more of the variables represented in the matrix.

For more information on modifying variable properties, see Chapter 7.

To Delete a Row or Column from a Matrix

» Inthe matrix, select the row or column that you want to delete.

» From the Form window menus choose;

Edit
Matrix
Delete
Row (Column)
Alternatively, you can deleterows by deleting the corresponding variablein the Builder
window or delete columns by removing the corresponding response item from all

variables represented in the matrix.

To Reorder Rows or Columns
» Inthe matrix, select the rows or columns that you want to move.

» From the Form window menus choose:
Edit
Matrix
Move
Up (Down, Left, or Right)
Alternatively, you can move arow or column using the mouse. Select the row or
column and then click on the selected row or column button and drag.
Thetop row of cellsand thefirst column of cells (row and column labels) cannot be
moved.
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To Display Caption Text in Matrix Cells

Figure 6-9
Matrix with caption text displayed

Please rate the imporantance of the following product characteristics:

Important Mot Impartant
Reliability 1 2 3 4 5
Price 1 2 3 4 5
Range of features 1 2 3 4 5

You can use display caption text rather than buttons in matrix cells by setting the
ButtonStyle property to Caption text. Thisis especialy useful if you want to display a
numeric scale rather than buttonsin each row.

» Select the cells that you want to modify.
» From the menus choose:
View
Properties

» Inthe Properties window, edit the ButtonStyle property.

Tip: The ButtonStyle property is available only when cells containing buttons are
selected (not row and column label cells).

To Edit Response Items in a Matrix

The variables created for a scale button matrix share acommon set of response items,
displayed in the column labels at the top of the matrix.

» To edit column labelsin the matrix, double-click on the text.
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By default, when you edit the column labels, all variables bound to the matrix are also
updated. If you prefer that changes made in the column labels not be propagated
throughout to the matrix, modify the ResponseTextUpdate property as follows:

» Right-click on the lower matrix border to select the matrix, and select Properties from
the context menu.

» Inthe Properties window, set the ResponseTextUpdate property to False.

Tip: To display response item text (rather than buttons) in all rows, select the cells and
change the ButtonStyle property to Caption text.

To Update Response Items for All Rows

» Toforceall responseitemsfor al variablesin the matrix to match the column labels,
including empty cells, select the matrix.

» From the menus choose:
Edit
Matrix
Fill Responses

To Hide Row and Column Marker Buttons

» To hide (or display) row and column marker buttons when in Design view, from the
menus choose:
Edit
Matrix
Row and Column Markers

» Select thisitem again to restore the original setting.

Note: Whether or not row and column markers are displayed in Design view, they are
never visible when entering data.
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To Display Borders in a Matrix

You can specify border style and color using the BorderStyle and BorderColor
properties.

» Select the cells that you want to modify.

» From the menus choose:

View
Properties

In the Properties window, edit the properties for the left, right, top and bottom borders
(LeftBorderStyle, LeftBorderColor, RightBorderStyle, RightBorderColor, and so forth).
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Creating and Defining Variables

Your data—the responses to your questions—are stored in variables. Every question
on aformisbound to at least one variable. In fact, you can think of aquestion asa
representation of avariable on aform. For example, the question “How old are you?’
might be bound to a variable named age. Questions that allow multiple responses are
bound to a named set of variables called amultiple response set, with each
subguestion bound to one of the variables in the set.

While every question on aform must be bound to avariable or amultiple response
set, thereverseis not true—not every variable must be represented by aquestion. Y ou
can have variablesin your filesthat do not appear on any form. Such variables can be
filledinautomatically using Skip & Fill rulesor can be set to adefault value (specified
in the Variable Properties window, General tab).

Figure 7-1
Variables displayed in the Builder window
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Fil= Edit “iew [nzert Rulez Help
Dl=l@l S|6) dlolel oo 2] El M |
El?lx i“‘lﬁql |<.t’-‘«IIForms> -
Yariable/S et | Label | Format | File Order &
33 $product Praduct
ﬂ $shop Shopping Lacations
4> BIRTH Birth ‘Year Mumber(F4.0] 11
@ COMTEAIL Contact Because of Problem MHurmber(F2.0) E
@ COPIER Copier MHurrber(FE.0) 16
4 EDUC Education Level Mumber(FZ.0] 12
@ FAIL Product Operation Failure MHurmber(F2.0) 5
® Fi Fax Machine MurberFE.0) 15
> FINCOME Family Income Mumber(F2.0] 13 =
@ FROBMEET Expectations MHumber(F2.0) 7
> OUAL Overall Quality Mumber(F4.0] 3
@ RECOMMD Recommend Product MHurmber(F2.0) 2
@ REGIOM Region MHurrberF2.0) 14 =
| | _'I_I
Ready |

141



142
Chapter 7

In the Builder window, use the View menu or the toolbar to display the variablesin
your file. Each variable has aname, label, and data format. In addition, variables have
properties, such as question text and response items, that apply to questions bound to
the variable. (This isimportant because variables and questions are closely related—
you can think of a question as a representation of avariable on aform.)

If you view your datain Table Entry view, each variable is a column of data that
measures a particular characteristic, and each row is a case.
Figure 7-2
Data displayed in Table Entry view
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Understanding the Connection between Questions
and Variables

Questions and variables are not the same thing in the program, but they are closely
related. You can usethe program without ever understanding this connection, but it will
make more sense if you do.

A question is arepresentation of avariable on aform. When you create questions
using the form toolbox, you also create variabl es; the question text and responseitems
displayed in questions are actually stored in the variable bound to the question.

This makes it easy to keep your questions and forms up to date and also provides
for multiple ways of doing thingsin the program. Y ou can edit question text and
response choices directly on your form or in the Variable Properties window. Either
way, the result is the same. Similarly, if you want to remove one of the buttonsin an
option button question, you can select and delete the button right on the form, or you
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can delete the corresponding response item in the Variable Properties window. The
result is the same, so use whichever method is convenient for you.

Creating Variables

You can create questions and variables using the form toolbox, or you can create
variables using the Insert menu in the Builder window.

m |f you add questions to a new form using the toolbox, variables and multiple
response sets are created for each question automatically.

m |f you prefer to define your variables before you create questions, use the Insert

menu in the Builder window to add variablesto your file. Y ou can later drag them
onto aform to generate questions bound to those variables.

Regardless of how your variables are initially created, the methods for defining their
properties are the same.

Tip: Copying and pasting variables in the Builder window is an easy way to create
several variableswith similar properties. However, it may be easier to create acomplete
guestion and copy the question rather than copying just the variable.

To Create Questions and Variables Using the Form Toolbox

>

In the Form window, from the menus choose:

View
Toolbox

In the toolbox, click on the desired question tool to select the tool.

Optionally, you can drag the mouse in the tool well as you select the tool to specify the
number and arrangement of controls (for example, arow or column of buttons).
Click on the form to create the question.

Asyou add each question, avariable or multiple response set is automatically created.

To define variable properties, right-click on the question and select Variable Properties.

See Chapter 4 for more information on creating questions.
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To Insert a New Variable in the Builder Window

» |nthe Builder window, from the menus choose;

Insert
Variable...
Figure 7-3
Inserting a variable in the Builder window
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» Inthe Variable Properties window, enter a variable name.

» Specify other variable properties as needed.

To Define Properties for a Variable or Multiple Response Set
Note: You cannot view or edit the variables for long text boxes.
» Inthe Builder window, from the menus choose:
View

Variables

» Right-click on avariable or set and select Variable/Set Properties.
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In the Variable Properties window, specify the variable name and label, question text,
data type, response items, and valid and missing values as appropriate.

» Toaccessvariable propertiesfrom aquestion onaform, right-click onthe question and
select Variable Properties.

Tip: Changes made in the Variable Properties window are applied immediately—you
don't need to close the window after making changes. You can edit multiple variables
by selecting them one after another in the Builder window without closing the Variable
Properties window in between each selection.

General Variable Properties

Figure 7-4
Variable Properties window
Yariable Properties: SATISF E2
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Comments;
Cloze | Help |

Variable name and label. Variable names can be 64 bytes long. You can also enter a
descriptive variable label that can be up to 255 characters. The descriptive labels are
displayed in statistical output when you run analyses.
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Question text. Text isdisplayed in questions bound to the variables. For example, if you
have a variable named age, you might specify “What is your age?’ By default, the
question text isidentical to the variable label, but you can deselect the link if desired.
You can edit question text in the Variabl e Properties window or by editing the question
text directly on aform.

Alias. ThisisaJScript-compliant name used to referencethe variablein rules or scripts.
By default, the alias is the same as the variable name, but if the variable name failsto
comply with scripting-language conventions, you are prompted to specify an
dternative. The alias must start with aletter, must contain only numbers, letters, and
underscores (no specia characters), and must be unique within thefile.

Default value. Value provided to the variable by default. If the variable is bound to a
check box or option button question, thisval ue determinesthe default state of the check
box or option button. For example, if you want the check box to be unchecked by
default, set the default to the unchecked value for the variable (Variable Properties,
Values tab).

Entry Type. Determines how avariable will appear and behave in Double Entry mode.
By default, it is set to Double Enter, which means that the variable will be double
entered. Edit allows a user to edit the variable in Double Entry mode. A user cannot
access a Protected variable in any entry mode. Only arule canfill aProtected variable.

Comments. Comments offer additional information about the variable. Comments are
generally used for “internal” documentation (asdistinct from variablelabels, which are
typically displayed in statistical output).

Variable Names

The following rules apply to variable names:

®  Thename must begin with aletter. The remaining characters can be any letter, any
digit, aperiod, or the symbols @, #, _, or $.

m Variable names can't end with a period.

m  Toavoid conflict with variables automatically created by some procedures, do not
give variables names that end with an underscore.

m  Thelength of the name can’t exceed 64 bytes.
m Blanks and specia characters (for example, !, ?,’, and *) can’t be used.



147
Creating and Defining Variables

The following reserved keywords can’t be used as variable names:

ALL NE EQ TO LE
LT BY OR GT AND
NOT GE WITH

Variable Format

The Format tab specifies the display format or data type for the variable. Available
formats include numeric, comma, dot, scientific notation, date/time, dollar, custom
currency, and string (letters, numbers, and punctuation). The specific options available
in the dialog box depend on the format that you select. For example, some formats
allow you to specify the width and number of decimals; for others, you simply select a
format from a scrolling list of examples.

Figure 7-5
Variable Properties: Format tab

Variable Properties: SATISF E3
General Format |Va|ues| Mizzing Valuesl *alid Valuesl

SPSS Dizplay Format [Type]

width [2

Decimal Places: ID_

Dot

€~ Scientific natation
€ Date

 Dollar

' Custom curency

€~ Sting

Sample
’712
Cloze I Help |

Non-numeric data. The default format for newly created variablesisnumeric (unlessthe
variableis created for atext box question, in which case the default format is string).

Numeric variables accept only numbers; if you want to enter non-numeric data, you'll
need to use a different format.
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However, it isagood ideato use numeric codes even for non-numeric categorical
data because numbers are easier to analyze. Specify value labelsand responseitemsto
describe what the codes mean (for example, codes of 1 and 2 for yes and no).

String and long string variables. |f you specify theformat as string, you can enter letters,
numbers, and punctuation. Numbers are treated as characters rather than values.
Standard string variables are no more than 8 characters in length. If you specify a
longer length—up to 255 characters—the variable is considered along string variable.
Value labels, response items, missing values, and Validation rules are not available for
long string variables.

Custom currency. Applies the custom currency format defined in File Properties
(Builder window, File menu). See Chapter 13 for more information on specifying a
custom currency format.

Input versus Display Formats

Depending on the format, the value that you see displayed on aform may differ from
the actual value as entered and stored internally. Here are some general guidelines:

m  For numeric, comma, and dot formats, you can enter values with any number of
decimal positions (up to 16). Values are rounded to the number of decimals
specified in variable properties for display purposes, but the complete valueis
stored internally.

m  For string variables, all valuesare right-padded to the maximum width. For astring
variable with awidth of 6, avalue of 'No' is stored internally as'No ' and is not
equivalentto' No .

m For date formats, you can enter data using slashes, dashes, spaces, commas, or
periods as delimiters between day, month, and year values, and you can enter
numbers, three-letter abbreviations, or complete names for month values. Dates
of the formats dd/mm/yy and mnvdd/yy are displayed with slashes for delimiters
and numbers for the month. Dates of the format dd-mmm+-yy are displayed with
periods as delimiters. Internally, dates are stored as the number of seconds from
October 14, 1582.

m For timeformats (actually atype of date format), you can enter data using colons,
periods, or spaces as delimiters between hours, minutes, and seconds. Times are
displayed with colons as delimiters. Internally, times are stored as the number of
seconds.
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Variable Level

The Level tab specifies whether the non-text variabl€e's level of measurement is scale
(numeric data on an interva or ratio scale), ordinal, or nominal. Measurement
specification is relevant if you use SPSS to analyze your data.

Figure 7-6
Variable Properties: Level tab
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Level of Measurement (SPSS). If the variable is a non-text variable, there are three
optionsfor the level of measurement:

m Scale. Datavaluesarenumeric valuesonaninterval or ratio scale (for example, age
or income).

m Ordinal. Data values represent categories with some intrinsic order (for example,
low, medium, high; strongly agree, agree, disagree, strongly disagree). Ordina
variablesare numeric valuesthat represent distinct categories (for example, 1 =low,
2 =medium, 3 = high).



® Nominal. Datavalues represent categories with no intrinsic order (for example, job
category or company division). Nominal variables are numeric values that
represent distinct categories (for example, 1 = Male, 2 = Female).

Variable Values

The Values tab specifies descriptive value labels and response items. You can specify
value labels for most variable types, including string variables, but not long string
variables (string variables with a length greater than 8 characters). Value labels are
particularly useful if your data file uses numeric codes to represent non-numeric
categories (for example, codes of 1 and 2 for yes and no). Value labels can be up to 60
characters long.

Value labels are not available for long string variables (those with alength greater
than 8 characters).
Figure 7-7
Variable Properties: Values tab

Yariable Properties: SATISF m
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r— Check Box Value Mapping
Checked: I'I Unchecked: IIJ

Cloze I

Response items. Response items are displayed in questions bound to the variable. For
example, if you create an option button question from the variable, each option button
represents one of the response items. You can edit response items in the Variable
Properties window or by modifying questions directly on aform.

Help |
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Checked and unchecked values. Mapping values are used when avariableis
represented as a check box question. For example, when the check box is selected, the
value of the variableis set to the checked value.

Tip: When you add or remove response items, the corresponding changes are madein
all questions bound to the variable. For example, in the case of an option button
guestion, buttons are added or removed from the question as needed. This ensures that
your questions are up to date (but may cause questionsto overlap on the form as they
expand to accommodate additional response items).

Coding Responses

Responses can be coded as numbers or strings in the data file. For example, yes/no
responses can be entered asyes and no, y and n, or using numeric codes (for example,
1 and 2 for yes and no). It isagood idea to use numeric codes whenever possible
because numbers are easier to analyze in most statistical software programs. Specify
value labels and response items to describe what the codes mean.

If you create questions using the toolbox, numeric codes are often mapped for you.
For example, if you create a question with an option button group, each option button
isautomatically mapped to aspecific value, and adefault valuelabel and responseitem
are created. All you haveto dois customize the text for each value label/responseitem.

Missing Values

The Missing Values tab allows you to define data values as user-missing. It is often
useful to know why information ismissing. For example, you might want to distinguish
between data missing because a respondent refused to answer and data missing
because the question didn’'t apply to that respondent.
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Figure 7-8
Variable Properties: Missing Values tab
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®m You can enter up to three discrete (individual) missing values, arange of missing
values, or arange plus one discrete value. For example, you can specify three
valuesto indicate not applicable, don’t know, and no response. (Click the values
tab in the Variable Properties window to specify descriptive value labels for
discrete missing values.)

m Ranges can be specified for numeric variables only.

Missing values for string variables. For short string variables, you can specify a space
as adiscreet missing value so that “empty” string variables are treated as missing.
Simply click in the edit field and press the space bar. A single space is sufficient; the
value is automatically padded to the defined width of the string variable (up to 8
characters). You cannot define missing values for long string variables with awidth
greater than 8 characters.

Data values specified as user-missing are flagged for special treatment and are
excluded from most calculations in statistical software programs.
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User-Missing Values versus System-Missing Values

User-missing values are not the same as the system-missing (or default) value. The
system-missing value simply indicates that no value has been specified for avariable
for a particular case. User-missing values are values explicitly entered to indicate the
reason that data are missing.

All variables normally default to the system-missing value for new cases (since a
variable cannot be empty for a case). However, you can change this behavior by
specifying a different value as the default (Variable Properties window, General tab).

Valid Values

The Valid Values tab specifies conditions that restrict the values of the variable to
labeled values, missing values, values within a specified range, or whole numbers. If
the user enters aval ue that failsto meet these conditions, the value is not accepted and
the user is prompted to enter adifferent value.

Valid values options are not mutually exclusive. For example, you can specify that
labeled values, response items, and missing values are all valid responses.

Figure 7-9
Variable Properties: Valid Values tab
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Tip: Specificationsmadein Valid Values create asimple Validation rulefor the variable.
You can also create Validation rulesin the Rule Wizard, which offers additional options
not availablein Valid Vaues. For example, the Rule Wizard allowsyouto createarule
that displays a custom message when an invalid value is entered.

To Copy Variables and Multiple Response Sets

You can use the Builder window to copy and paste variables and sets. If you open
multiple files, each file has its own Builder window, allowing you to copy and paste
objects between them.

In the Builder window with the variables that you want to copy, from the menus
choose:
View

Variables

Either select one or more variables or sets and hold down the left mouse button to drag
selected variables from one Builder window to the other, or from the menus choose:
Edit

Copy

In the Builder window in which you want to paste the variables, from the menus
choose:

View
Variables
And then choose:

Edit
Paste

Tip: You can “clone” avariable or set by copying it and pasting it back into the same
file.
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Tips for Copying Variables and Multiple Response Sets

You can use the Builder window to copy and paste variables. If you open multiple
files, each file has its own Builder window, allowing you to copy and paste objects
between them.

When you copy avariable, all of itspropertiesare copied, including any Validation
rules bound to the variable. If you paste avariable into afile where a variable of
the same name already exists, the pasted variable is renamed to avoid a conflict
(since two variables cannot have the same name).

You can “clone” avariable or set by copying it and pasting it back into the same
file. The new variable or set has similar propertiesto the original but isrenamed to
avoid anaming conflict.

If you copy amultiple response set, al of the member variables are copied along
with the set.

If the variable or set you want to copy isalready bound to aquestion, you may save
time by copying the complete question rather than just the variable. When you copy
aquestion, the variable or set bound to the question is also copied.

Y ou can paste a variable or multiple response set onto aform to create a question
based on the variable.

To Copy Properties of a Variable or Set

You can copy and paste properties from one variable or multiple response set to
another. Thisis an easy way to assign the properties of one variable or set to several
others, essentially using the variable as atemplate.

» If necessary, from the Builder window menus choose:

View
Variables

» Select the variable whose properties you want to copy and from the menus choose:

Edit
Copy Properties
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>

Select one or moretarget variables to which you want to paste properties, and from the
menus choose:

Edit
Paste Properties...

Select the properties that you want to apply to the target variable.

Figure 7-10
Paste Properties dialog box
[~ Label [~ Comments
tion bext Mizzi I
[ Question tex [ Missing values — |
[ Walue labels [ Walid values

[ Fesponse items [ Display format Help |

Tip: If you open multiple files, each file has its own Builder window, allowing you to
copy and paste properties between them.

Copying Multiple Response Sets

You can copy and paste multiple response sets as well as variables. When you copy a
set, al of the variables within the set are also copied and renamed if necessary to avoid
conflicts with existing variables. See Chapter 8 for more information on multiple
response sets.

Reordering Variables

Variables are added to your filein the order in which you create them. While the order
of variables has no effect on the order of questions on your form—you can rearrange
your forms as much as you want regardless of the variable order—you may find it
convenient to reorder variables to match the order of aform or questionnaire or to
facilitate your later analysis of the data.

Y ou can reorder variables by opening the file in SPSS (release 7.5 or later), or a
similar program from SPSS Inc.
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To Reorder Variables in Another Program

It is recommended that you make a backup copy before making significant
modifications to any file.

» Open thefile that you want to modify in SPSS (release 7.5 or later).

» Inthe Data Editor, select the column for the variable that you want to move and from
the menus choose:
Edit
Cut

» Click on the column to the right of where you want to insert the variable and from the
menus choose:

Data
Insert Variable

» Select the newly inserted (still empty) column.

» From the menus choose;

Edit
Paste

» Savethefile

To confirm the results, open the filein Builder.
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Multiple Response Questions
and Sets

Sometimes you want to ask a question that may require more than one response. You
might want to know which magazines people read, which products they buy on a
regular basis, or which employee benefit services they have used in the past month.
You can use multiple response questions to obtain more than one answer.

Multiple response questions represent multiple response sets. A multiple response
set isanamed set of variablesthat can be analyzed as agroup and represented on the
form as a multiple response question.

Multiple response sets can be coded as dichotomies or as categories. In aset coded
as dichotomies, each possible choice represents a single variable, and each variable
has one distinct value that means yes, count this response. Typically, that valueisthe
checked value for a check box. In a set coded as categories, each possible response
represents a variable whose value can be any of the legal responses to the question.
Those legal responses might be represented in a set of identical list boxes, and the
respondent chooses once from each. There does not have to be alist box for each
possible choice—just enough to accommodate the maximum number of choicesthe
respondent is expected to make.

Dichotomies are most useful when you have a manageable list of aternative
responses. They are generally preferred for data analysis because you can analyze the
underlying variables apart from the set and recombine them into different sets. Sets
coded as categories are preferable when you have alarge number of choices from
which you expect respondents to select just afew—such as their favorite three
television shows from alist of ahundred. They also allow you to later select top
choices apart from lower choices.

For information on creating questions and defining variables, see Chapter 4 and
Chapter 7.
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Multiple Response Questions Representing Sets Coded
As Dichotomies

Multiple response questions alow you to ask a question and receive more than one
answer. The answers are stored in separate variables. In effect, each optionin a
multiple response question is a subquestion.

For example, consider the question Which of the following products do you own?
with check boxesfor four different products. The respondent can select all of the check
boxes that apply.

Figure 8-1
Multiple response question represented with check boxes

YWhich of the following products do you own?
O Fax Machine

O Copier

O Computer

O Laser Printer

The multiple response question, which represents amultiple response set, is composed
of four subguestions and four separate variables.

Variable Subquestions

Fax Do you own afax machine?
Copier Do you own acopier?
Computer Do you own a computer?

L printer Do you own alaser printer?

The respondent is in effect answering yes or no to each of the subquestions. Each
product listed in the exampl e question functions as a subquestion of the main question,
which represents a multiple response set coded as dichotomies. The yes or no answer
for each product is stored in the underlying variable that is part of the set.
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Multiple Response Sets Coded As Dichotomies

When you want to receive ayes or no answer to a specific set of subquestions, you can
use a multiple response set coded as dichotomies. A set coded as dichotomiesis
composed of the set and as many variables are needed to ask the subquestions.

Figure 8-2
Multiple response set coded as dichotomies
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The following controls are appropriate for representing multiple response sets coded
as dichotomies:

m  Check boxes

m  Single-selection list boxes
m  Text boxes

m  Drop-down lists

To Create a Multiple Response Question Representing a Set Coded
As Dichotomies

» |If thetoolbox is not visible, from the Form window menus choose:

View
Toolbox

» Movethemouse pointer over the check box question tool and hold down theleft mouse
button to display the check box well. (Y ou can also use single-selection list boxes, text
boxes, or drop-down lists.)
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» Drag and release the mouse in the check box well to select as many check boxes as
you need.

» Click on the form to create the question. (If you have chosen list boxes, text boxes, or
drop-down lists, use the right mouse button to create the question and select
Dichotomies - numeric Or Dichotomies - string.)

When you create the multiple response question, the multiple response set is also
created.

» To define the multiple response set, right-click on the question and select
Variable Properties.

» To define the component variables, right-click on the question and select Variable
Properties. Y ou can use Copy Properties and Paste Properties on the Edit menu of the
Builder window to apply the same properties to multiple response variables.

Multiple Response Questions Representing Sets Coded
As Categories

A multiple response question that represents a set coded as categories collects

responses in text boxes, drop-down lists, or single-selection list boxes. For example,
you could use three text boxes to receive the responses and ask the question In order
of frequency, please list the three stores you use for purchasing high-tech equipment.

Figure 8-3
Multiple response question represented with text boxes

In order of frequency, please list the three
stores you use for purchasing high tech
equipment.
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Variable Subquestions

Shopl Which store do you most often use for purchasing
P high-tech equipment?

Shon2 Which store do you second most often use for purchasing
P high-tech equipment?

Shop3 Which store do you third most often use for purchasing
P high-tech equipment?

The respondent is ableto typein the required responses, and each responseis stored inits
own varigble. In this example, each of the responses represents a different store, which,
when analyzed together, represent a multiple response set coded as categories. Note that
string variablesin amultiple response set are limited to eight characters and that string
variables are case sengitive, so that Techshop and TechShop are different values. For that
reason, you may prefer to use numeric variables or short aphabetic codes and have users
select responses from a set of list boxes or enter codes from alist that you provide.

Multiple Response Sets Coded As Categories

When you want to receive open-ended responses or alimited number of responses
selected from predefined categories, you can use a multiple response set coded as
categories. A set coded as categories asks a question and provides a number of text
boxesto collect the responses. Each text box representsavariablethat is part of the set.
You can aso use single-selection list boxes or drop-down list boxes to display
predefined categories.

Figure 8-4

Multiple response set coded as categories
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To Create a Multiple Response Question Representing a Set Coded
As Categories

>

Move the mouse pointer over the text box question tool and hold down the left mouse
button to display the text box well. (Y ou can also use single-selection list boxes or
drop-down lists.)

Drag and release the mouse in the tool well to specify the number and arrangement of
objects.

Right-click on the form and select either Categories - string or Categories - numeric to
create the question.

When you create the multiple response question, the multiple response set is also
created.

To define the multiple response set, right-click on the question and select Variable
Properties.

To define the component variables, right-click on the question and select Variable
Properties. Y ou can use Copy Properties and Paste Properties on the Edit menu of the
Builder window to apply the same properties to multiple variables.

Creating Multiple Response Sets

When you create multiple response questions using the form toolbox, sets are created
automatically. However, you can define sets that do not have questions representing
them. Create and define your set in the Builder window and then create the question
representing it by dragging the set onto the form.
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To Insert a Multiple Response Set

>

>

From the Builder window menus choose:

Insert
Multiple Response Set
Dichotomies... (Categories...)

In the Set Propertieswindow, under the General tab, give the set aname and optionally
alabel and question text. Under the Memberstab, check the variables that you want to
include in the set.

Alternatively, click Insert New Variable once for each new variable that you want to
include in the set and return to the Builder window to select and define properties for
theindividua variablesyou created. Y ou can use Copy Properties and Paste Properties
on the Edit menu of the Builder window to apply the same properties to multiple
variables.

Thereisalimit of 200 setswithin afile.

To Create a Multiple Response Question from an Existing Set

>

From the Builder window menus choose:
View
Variables

Select a set.
Click the right mouse button and drag the set onto aform.

From the context menu, select the type of question that you want to represent your
multiple response set.
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Deleting Multiple Response Sets

Deleting a multiple response set del etes the variable and any questions that represent
the set. The member variables still exist. For example, if you have a multiple response
set question with the set variabl e $service and the member variables atm, teller, online,
phone, and loan, when you delete $service, the other variables are not deleted. If you
don’'t want to use the member variables in your file, you must delete them separately.

Whenever you delete avariable or set, you a so delete any questions or rulesthat are
tied to the variable or set.

To Delete a Multiple Response Set

» From the Builder window menus choose:
View
Variables

» Select the set that you want to delete.

» From the Builder window menus choose:

Edit
Delete

Changing Multiple Response Set Types

If you want to change the type of multiple response set, you must delete it and define
anew one using the same set of variables. If you want to analyze the same variablesin
different types of sets, you can define a new set without deleting the original one.

Multiple Response Set Properties

Properties control several characteristics of sets, including:
m  Set name

m Setdias

m  Setlabel

m  Set question text
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m Comment field
m  Counted value (dichotomies only)
®  Set membership

Figure 8-5
Multiple response set properties

Set Properties: $shop E

General | Membergl

Hame: § Ishop Alias: Ishop

Label: IS hopping Locations

Questiontext: [ Link with zet label

w'hich stores do you shopin? ;I

Counted value for dichotomies: I VI

LComments:

Cloze | Help

To Change Multiple Response Set Properties

» From the Builder window menus choose:
View
Variables
» Right-click on the multiple response set and choose Variable/Set Properties.
» Change the properties.
Changes are applied as they are made.
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Response Set General Properties
Figure 8-6
Multiple response set general properties
General | Membersl
Mame: Ishop Alias: Ishop
Label: ISthping Locations
Question text: [ Link with zet label
Which stores do you shop in? :I

Counted value for dichotomies: I - I

Comments:

Cloze | Help |

Name. All set names must start with a$, which is provided preceding the name entry
field. You do not have to type the $. Set names may not exceed 8 characters, including
the $.

Alias. An dliasisthe aternative name for the set. Because JScript, which isused in the
creation of rules, does not allow names to start with a$, you must create an alias for
usein scripting and rules. The alias must start with aletter, must contain only numbers,
letters, and underscores, and must be a name not used elsewhere in thefile.

Label. The set label allows you to create a description of the set that will appear in
statistical and graphical output when you run analyses on your data.

Question text. Question text is displayed on the form. By default, the question text and
set label are linked.

Link with set label. When checked, the question text and set label are identical, and
changes to one are automatically made to the other. You may want to unlink the
question text and set label for the purpose of having succinct, readable output in your
dataanalysis. For example, if the question text is Which forms of transportation have
you used in the last month?, you may want to unlink your set label and question text
and use “transportation” for your set label.
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Counted value for dichotomies. This specifies the value of interest for analysis. The
counted value normally equal sthe checked value or the value that represents an answer
of yes. The counted value is essential for the analysis of dichotomous sets.

Comments. This allows you to store comments regarding the set.

Multiple Response Set Members Properties

Figure 8-7
Multiple response set members properties
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The Memberstab alowsyou to add and removevariablesfrom your set. A set must include
at least two variables. Thereisalimit of 100 variableswithin aset and 4000 variables across
all sets. Your set must contain variables of the same type. For example, you are not ableto
add astring variableto aset containing numeric variables. If amember’stype changes|later
in the design process, the variable is automaticaly removed from the set.

When you add avariable to a set, it is checked for type consistency with the other
variables. In the interest of good design, in a multiple categories set, the value labels
should be consistent across variables. In a multiple dichotomies set, the variables
checked/unchecked property should be consistent, and the variable labels should be
consistent. Y ou can have inconsistent labels and checked/unchecked propertieswithin
your sets, but they can cause problems during analysis.

Y ou can use the up and down buttonsto reorder set members. Y ou can also click on
avariable and drag it to a position within the list of members.
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The question libraries are a collection of files containing ready-to-use questions on
topics, such as general demographics, customer satisfaction, and customer
preferences. The variables attached to the questions are defined, including value
labels and response items. You can use the questionsin your files. You can also add
files of your own to the question libraries.

Using the Question Libraries

Figure 9-1
Question Library window
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You can access the question libraries from the Edit menu. The Question Library
window displays the contents of the question librariesin levels. At the top level isthe
folder. The QuestLib folder contains al of the question librariesfiles (.qlb) that
accompany the software. Clicking on a plus sign displays the next level. You can
browse through files, forms, and questions.

The Question Library window contains atoolbar, which will alow you to perform
severa tasks. Hold the mouse pointer over atool to display the Tool Tip that briefly
describes what the tool does. The toolbar alows you to:

Add afolder to the question libraries.
Search through text in the question libraries.
Add questions or forms to your file.

Display Help.

®  Open and close the Sample View window.

If you want to view a question or form, you can do so in the Sample View window. To
open the Sample View window, double-click aform or question or click the Show
Sampl e button on the tool bar. Once the Sample View window is open, you can click on
aform or aquestion to display it in the window.

Figure 9-2

Question in the Sample View window

B3| 5 ample Yiew




173

Question Libraries

To Add a Question to Your Form
To open the question libraries:

» From the menus choose:
Edit
Question Library

To add a question to the current form in the current file:
» Inthe Question Library window, click the question that you want to add.

» Click the Add To button on the toolbar.

When you add the question to your form, Builder creates a variable for your question.
You can edit the text of the question, the variable label, and any other variable
properties. For example, you might want to specify missing values for the variable.

Y ou can also add an entire form to your file by using the Add To button. When a
form is added to your file, variables are created for all of the questions on the form.
Y ou can edit the questions or variables on your newly added form.

If you have more then onefile open or have amultiform file, you can use context menus
to add the question to aform other than the current form.

» Inthe Question Library window, right-click the question that you want to add to your
form.

» From the context menu, select Add To.

» Select the appropriatefile.

Searching for a Question in the Question Libraries

You can search through the text of the question libraries to locate an appropriate

guestion. For example, if you arelooking for a question on product recommendations,
you could search for the word recommend. You will see al of the questions containing
the word recommend in the Find Results tab in the Question Library window. You can
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add questionsto your file from that tab, just asyou can from the All Filestab. Click the
All Files tab to return to the question libraries folders.

Figure 9-3
Results displayed in the Find Results tab
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To Search in the Question Libraries
» Click the Find button on the toolbar.
» Specify the words that you want to search for.

» Click oK.
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Adding Files to the Question Libraries

You can add your own files to the question libraries. This alows you to preserve
questions for use in later files. Following are some general tips for creating files that
lend themselves well to the question libraries.

m  Make surethat all variable labels, values, and response items are fully and clearly
defined.

m  Rename your questions so that they have clearly understandable names. For
example, if the default name for a question is Questionl, renaming your question
to Satisfaction will give you an idea of the question’s content.

m  Group questions together on forms according to their purpose and then name the
form accordingly. Thiswill make it easier to find the type of question you need.

m By default, question library files are installed in the QuestLib subfolder, located
under the same directory as your program software. Save all of your question
library filesin the QuestLib folder so that they will automatically appear when you
open the Question Library window. If you decide to add the file to adifferent
folder, you will have to add the folder to the Question Library window.

m  Onceyou have added your fileto the question libraries, you will havetorefresh the
view in the Question Library window.

To Add a File to the Question Libraries
» Open thefile that you want to add to the question libraries.

» From the Builder window menus choose:

File
Add to Question Library...

» Inthe Save In drop-down list, browse to the folder in which you want to save thefile.

» IntheFile Nametext box, enter afilename. Select Question Library Files (.glb) from the
Save as Type drop-down list.

» Inthe Question Library window, right-click on the QuestLib folder and select Refresh
from the context menu.
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By default, question library filesare installed in the QuestLib subfolder, located under
the same directory as your program software. Files in the QuestLib subfolder
automatically appear in the Question Library window. If you saved your new question
library fileto afolder other than QuestLib, you will have to add the folder so that it will
appear automatically when you open the Question Library window.

To add afolder to the Question Library window:
Right-click inside the Question Library window.

From the context menu, select Add Folder.

Note: When you view your new folder in the Question Library window, you will see
only the question library files (.glb). If there are additiona filesin the new folder that
you would like to usein the Question Library window, you will have to open them and
add them as above. You will also have to refresh the view in the Question Library
window by right-clicking in the window and selecting Refresh from the context menu.
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A formisthe device you use to collect and view your data. The form holds the
guestions and response controls used to gather the data. The form is saved as part of
your file when you save your file. There is no need to save only the form.

Figure 10-1
Form window and toolbox
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Before you begin to design your form, you should consider who will use the form,
what they will useit for, and how they will useit. Answering the following questions
will allow you to develop the form(s) that will best suit the needs of your users:

m  Who will use the form? What is their level of expertise?
m  Will they useit on paper or within the data entry program?
m If you want to use a paper form, will someone then enter the data online?
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When Do You Need Separate Versions of a Form?

The program allowsyouto createformsfor both printed questionnaires and online data
entry viaan entry form or a spreadsheet. You can often use the same form for both
printing and online data entry. However, the program allows you to create aternate
versions of forms, linked to the same set of variables. You may want to use two

different forms for a number of reasons.

Figure 10-2
Online form and printed form
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® Your online form might display instructions for the interview that you don’t want
to appear on aprinted form. Or, aprinted form might require moreinstructionsthat
are unnecessary online. For example, rules can automate Skip & Fill patternsin an
online form, but you would need to include written skip instructions on a printed
form.

® Y ouwant to hide questions or responses on a printed form. For example, you don’t
want to have a Didn’t respond option on a printed form.

Some control types, such as drop-down lists, do not work well in print.
Y ou may want your printed form to differ in appearance from your online form.

Y ouwant to create several formswith the same questionsbut in different order. For
example, you want to control the possibility that question order biases responses.

Y ou want to split all of your questions across several forms to make entry easier.
Y ou want to send different groups of respondents different copies of a survey.

To Make a Copy of a Form

» From the Builder window menus choose:

View
Forms

» Select the form you want to copy.

» From the Builder window menus choose:

Edit
Copy

» From the Builder window menus choose:
Edit
Paste

If you copy and paste aform to the samefile, the result is two separate forms bound to
acommon set of variables. You can customize the arrangement and appearance of
guestions on each form as needed. However, if you edit question text or responseitems
or make other changes to your variables, both forms are updated.

If you copy and pasteaform from onefileinto another file, the variableson theform
are also copied into the other file. Changes made to aform in one file are not made to
the form in the other file.
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To Create a Form for Table Entry

Figure 10-3
Form in Table Entry view
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If you don’t want to spend time formatting the appearance or arrangements of
guestionson your form, usethe Auto-create feature, which allowsyou to automatically
create aform, maximized for entry in Table Entry view. To use Auto-create, you must
have defined variables, either from an .sav file created in Builder or in another program
from SPSS. You can use .sav files that already have forms.

» From the Form menu choose:

Layout
Auto Create Questions...

» Select either Create all questions as text boxes Or Create questions based on default types.

Tip: Creating all questions as text boxes makes it easier to enter datain Table Entry
view, since your hands do not have to leave the keyboard to use the mouse.

» If you want to edit the form, deselect Open in Table Entry Mode.

Designing a Form for an Interview

The following are suggestions for adapting aform for use in an interview:

m Usetext annotations to incorporate the script into the form. Y ou can also use text
annotation objects to provide additional instructions to the interviewer.
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Make sure that AutoTab is selected to speed the entry process.
Create Validation and Skip & Fill rulesto speed entry.
Y ou can use multiple formsto display only one question at atime.

Sizetheformto fit your screen. Consider the type of computer and the monitor size
used in the interview. Forms for use on laptop computers should be sized to
accommodate the screen resolution.

Include responses such as Refused to answer and Didn’t know (which would be
suppressed in a printed form).

Designing a Form for Printing

The following are guidelines for designing aform for printing:

Choose afont that is large enough to read.

For questions that require a written response, size the entry areato alow enough
space for handwriting and make sure that the space islong enough to accommodate
responses of reasonable length.

Design the form to include plenty of white space so that the form does not appear
to be cluttered.

Use linesto break the form into sections.

Set the margins and page size large enough to accommodate your form when you
print the form.

Add instructions and graphics to aid the respondent.

Hide response items such as Refused to answer that you may haveincluded onyour
online form. Y ou can hide a response without removing it by setting the Visible
property to False for the response control.

Use the Layout menu or toolbar to ensure the neatness of the arrangement.

Use Print Preview and View Page Breaks to ensure that questions are not split
across pages.

Consider which controls you use because some controls (such as adrop-down list)
will not work on a printed form.

Provide directions for skip patterns, and filling out and returning the form.
Remember, people are likely to fill out aform only if it is clear and easy to use.

Print theformin Form Entry view, either beforeyou enter casesor beforeyou enter
datainto anew case.
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Customizing Forms

This section describes how to specify form properties, set the page size, add headers
and footersto a printed form, and add text labels, lines, rectangles, and pictures.

m  For information on creating questions, see Chapter 4.

m  For information on selecting, modifying, and aligning questions and other objects
on forms, see Chapter 5.

m  For information on question numbering, see Chapter 5.

To Insert a New Form

When you start a session, a blank form is automatically displayed; you don’'t need to
insert a new form unless you want multiple formsin your file.

» Tolisttheformsalready inyour file, from the Builder window menus choose:
View
Forms
» Toinsert anew form in the Builder window, from the menus choose:
Insert
Form
» Toinsert aform inthe Form window, from the menus choose:
File

New Form

» To specify the form name, default font, and other form properties, right-click on the
form’ s background and select Properties.
» Usetheform toolbox to add questions and other objects to the form.

See Chapter 4 and Chapter 5 for more information on creating and customizing
questions.
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To Specify Form Properties

You can use the Properties window to specify the form name, window style, and the
text displayed in the Form window title bar.

» Inthe Form window, right-click on the form’s background and select Properties.
» Enter aform name.
» Enter thetitle bar text and press Enter.

» Torestrict the size of the Form window so that it cannot be resized in Entry view,
change the window style to Fixed.

» If youwant your questions numbered automatically, change the AutoNumber property
to True.

For more information on question numbering, see Chapter 5.

To Copy a Form
To copy a form within the same file:

» From the Builder window menus choose:
View
Forms

» Select the form you want to copy.

» From the Builder window menus choose:
Edit
Copy
» From the Builder window menus choose:

Edit
Paste
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To copy a form between files:
Select the form you want to copy.

Drag and drop it into the other file's Builder window.

If you copy and paste aform to the samefile, the result istwo separate forms bound to
acommon set of variables. You can customize the arrangement and appearance of
questions on each form as needed. However, if you edit question text or responseitems
or make other changes to your variables, both forms are updated.

If you copy and paste aform from onefileinto another file, thevariableson theform
are also copied into the other file. Changes made to aform in one file are not made to
the form in the other file.

Using Find and Replace in the Form Window

In the Form window, you can search through your form'’s questions, variables, and
properties to locate text phrases. You can also replace text in your form’s questions,
variables, and properties. You can search through only one form at atime. If you want
to search through another form, you must open that form. If you want to search through
your entire file, use the Builder window. If you want to search through your data,
search in Form Entry or Table Entry view.

To Find and Replace in a Form

>

From the Form window menus choose;

Edit
Replace...

Specify the text to search for.
Specify the replacement text.
Click OK.

To search through another form, open that form.
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Spell Checking Text in the Form Window

In the Form window, you can check the spelling of your form's questions and text
labels. If aword is misspelled, the spell checking tool suggests alternatives, which you
can select to replace the spelling error. You can check the spelling in only one form at
atime.

To Spell Check Text in a Form

» From the Form window menus choose;

Edit
Spell Check

The Check Spelling dialog box appears if there are any spelling errors. For details
about using it, click Help in the dialog box.

Page Size and Window Size

Page size refers to the size of the page when the form is printed. The form sizeis not
restricted by the page or window size; forms can be as many pages long (or wide) as
you want. To ensure that questions don’t split across pages, you can display page
breaks when designing the form by choosing the Page Breaks optionin the View menu.

Window sizerefersto the size of the Form window. By default, users can resizethe
Form window at will by dragging the sides and corners; you can change this by setting
the window style to Fixed in the Properties window.

Tip: When designing aform for online use, always consider the user’sdisplay size. This
isespecially important if laptop computerswill be used for entering data, since laptops
typically have smaller displays than desktop computers.
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To Set the Page Size for a Form

» From the Form window menus choose;
File
Page Setup...

» Specify the desired page size and margin width.

» Select either the narrow or the wide orientation (portrait or landscape).

To View Page Breaks

To ensure that questions don’t split across pages, you can display page breaks when
designing the form.

» From the Form window menus choose;

View
Page Breaks

Page breaks are displayed as dashed lines whenever the form is open in Design view.

Headers and Footers

You can add custom headers and footers to a printed form. For example, you can use
headers to add contact information or to insert instructions that are necessary only on
aprinted form, such as where to send the form after it is completed. Headers and
footers aso alow you to include pertinent reference information, such as the date,
filename, or identification codes.

To Add Headers and Footers to a Form

» From the Form window menus choose;

View
Headers/Footers...
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Figure 10-4
Header/Footer Settings dialog box
Header/Footer Settings HE
Please fill out the form in ink. =

2[Filename] -l

QK | Cancel | Help |

In the Header/Footer Settings dialog box, enter the text that you want to appear in the
header or footer.

Use the buttons in the dialog box to add the date, time, page numbers, or filenames.
Use the buttons to change the font or justification of your headers and footers.

Choose Print Preview on the File menu to see how your headers and footers will look
on the printed page.
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To Add Text Labels to a Form

Use the text tool to add text that is not bound to any variable. This can be useful for
comments, directions, or codes.

Figure 10-5
Text added to a question

Year you were born |:|

Please enter the year using 4 digits.

If the form toolbox is not visible, from the menus choose:
View
Toolbox

In the form toolbox, click on the text tool.
Click on the form to add the text.

Double-click on the text to edit the text.

m Before editing the text, you may want to make the text label larger by dragging the
selection handles so you can see more text as you type.

m |f youinsert text within an existing question, the text becomes part of the question.
If you move or delete the question, the text goes with it.

m |f youwant text to overlap aquestion but not be part of the question, create the text
on the form (away from the question), and then drag the text over the question.

If necessary, you can move the text on top of the question. From the menus choose:

Layout
Layer
Bring to Front
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To Draw Lines and Rectangles on a Form

You can improve the appearance and usability of forms by drawing lines and
rectangles.

» Select the line or rectangle tool from the toolbox.
» Draw theline or rectangle on the form.

» Tospecify thecolor, thickness, and other properties, right-click on thelineor rectangle
and select Properties.

m  Inthe Propertieswindow, use ArrowStyle to create lineswith arrows on the endsto
illustrate skip patterns on printed questionnaires.

® You can use rectangles to group questions together or to create a background
shadow.

m  Usethe Bring to Front and Send to Back commands to adjust the appearance of
rectangles used for background shadows.

To Add a Picture to a Form

Figure 10-6
Form with picture

& Form1 =] E3

File Edit “iew Data Hules Help
=(E| S| $/mle] of-| 26l =< ok = o]

ZIRINE SO

d

YWhat is your reaction to the logo? j
O I'think it illustrates the product extremely well.

QO I think it illustrates the product moderately well.
QO | have no apinion.

O | think it fails to illustrate the product.

-
1| | »

WARDODDT: [272 B4 Skip & Fil: On  [Auto Check: On |Entry ,?




190

Chapter 10

» |f theform toolbox is not visible, from the menus choose:

View
Toolbox

» Intheform toolbox, click on the picture tool.
» Click on the form where you want the picture to appear.
» Right-click on the empty picture object and select Properties.

» Inthe Properties window, double-click Picture.

Figure 10-7
Load Picture dialog box

Load Picture

Laak jr: Ia Graphics = |‘=_"F| l_ i
DEBUILD bmp
File name: I Open I
Files of topes | All Picture Types j Cancel |
I ursors [Fico” cur :
etafiles [* wmf;* emf]
All files [7.7]

» IntheLoad Picture dialog box, browse for or enter the name of the picture file you
want to open. Y ou can open bitmaps (.bmp), Windows metafiles (.wnmf), icons (.ico),
.gif files, and .jpg files.
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Adding Questions to Forms

You can add questions to your form using the form toolbox or by dragging variables
from the Builder window onto the form.

m  For information on creating questions, see Chapter 4.

m  For information on selecting, modifying, and aligning questions and other objects
on forms, see Chapter 5.

Creating a Form from an Existing Data File

You can generate aform from an existing data file by opening the file in the Builder
window and dragging the variables from the Builder window onto the form. See
Chapter 4 for more information.

Tab Order

Tab order specifies the sequence in which users can move through questions on the
form by pressing Tab (or Shift-Tab) in Form Entry or Table Entry view. You can aso
specify the tab order for subquestions with a multiple response question, or specify the
sequence in which arrow keys cycle through buttons in an option button question. By
default, the tab order corresponds to the order in which your questions are created.

Tab order is extremely important in question numbering. The tab order isthe
sequence used to determine question numbering. If you change the order of the
guestions on your form, you will have to change thetab order to ensure that navigation
is preserved and also that the question numbers reflect the correct order of the
guestions. For more information on question numbering, see Chapter 4.
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To Specify the Tab Order for a Form

Tab order specifies the sequence in which users can move through questions on the
form by pressing Tab (or Shift-Tab) in Form Entry or Table Entry view.

£+ DptionButtonT - Excesded expectatic
E OptionButton? - ket expectations
E OptionB uttan3 - Fell shart of expectat
: el E OptionB uttand - Mo responise

E----'ahl (Questionk - Date of purchase

. Question? - Wwhat is your highest level of

Figure 10-8
Tab Order dialog box
Tab Order and Numbering [ x|
Set the keyboard order, numbering for objects:
JIngie E: Cancel |
E Question - 'Would you recommend this p
E Question2 - How would you rate vour ove Help |
E Questiond - How zatizfied are you with yo
E Questiond - Did problem rezolution meet ¢
f_ [ueztions - Did problem rezolution meet
=
i

| ]

» From the menus choose:
Layout
Tab Order and Numbering...

» Select questions with the mouse and use the arrow buttons to move them up or down
in the tab order, or drag them up or down with the mouse.

m  To specify the tab order for subquestions within a multiple response question,
double-click the question (or click the plus sign [+] icon).

m  To specify the sequence in which arrow buttons cycle through buttons within an
option button question, double-click the question.

The question number appearsin front of the question name. When you change the tab
order of your questions, the question numbers change automatically.
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Rulesincrease the integrity of your data and help make the data entry process more
efficient. Rules enable you to:

Catch invalid values as they are entered.

Check for illogical relationships between variables.

Fill in values for questions based on previously entered values.
Skip questions that are not applicable for particular cases.
Generate reports of invalid or inappropriate values.

Check and clean existing datafiles.

A rule remains inactive until it is triggered by an event that affects the variable or
guestion involved with the rule or until you select amenu option that usesthe rulesto
check the data. A rule attached to the variable PRODUCT, for example, might activate
when an incorrect value is entered for that variable.

Y ou can use rules to verify values and cases as they are entered or to check an
entirefileat once. Y ou can also userulesto clean and verify existing datafilescreated
with data analysis software from SPSS Inc. Checking values as they are entered
enablesyou to catch and fix incorrect valuesimmediately, minimizing the chances of
invalid data getting into your file. Using rules to check an entire file at once allows
you to clean datafiles previously created with such data analysis software. Rules
allow you to easily change and correct any invalid responses.

Three types of rules are available: Validation, Checking, and Skip & Fill. Each
type of ruleisresponsible for different aspects of improving the data entry process, is
triggered by different events, and results in different actions when violated.
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Rules and JScript

Rules are scripts—sets of JScript commands that help you automate your data entry
tasks—written in the JScript programming language and saved in your file. JScript is
Microsoft’'s version of the JavaScript scripting language and is an interpreted, object-
based scripting language.

Y ou can create rules effortlessly using the Rule Wizard—you do not have to know
JScript or any other programming language in order to create powerful rules with the
Rule Wizard. If you are familiar with the JScript programming language, you can
create rules by entering the necessary JScript commands directly into the Rule Scripts
window. Y ou can also use JScript and the Rule Scripts window to edit and extend the
functionality of rules created with the Rule Wizard. See the online JScript help for
more information on using JScript.

Creating Rules

Rules can be created by using the Rule Wizard or by selecting the New Rule option from
the Scripts menu in the Rule Scripts window and directly entering the JScript
commands. Unless you're an experienced JScript user, however, you will probably
want to begin by creating your rules with the Rule Wizard. Once you are familiar with
the JScript code that is created for you by the Wizard, you should be able to edit
existing rules to fit your needs. See Chapter 12 for information on creating rules
without the Rule Wizard.
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Rule Wizard

Figure 11-1
Rule Wizard

Aule Wizard - Start

Thiz wizard creates one or more ules, Rules operate
during data entry and checking.

wihich tppe of rule would pou like to create?
" alidates a single variable [Validation)

Checks a logical relationship between
wanables [Checking)

Give the rule a name: Irule'l

¢ Sets values of variables, and skips to
questions [Skip & Fill)

TEa454

@ Do you want bo zee the rule that the wizard
= generates? Click on the pencil ta wigw it.

< Hack | Mewut » | Cancel | Help |

The Rule Wizard makes it easy to create Validation, Checking, and Skip & Fill rules
by guiding you through each step of the process. After you complete the steps
necessary to create arule and click the Finish button, your new rule is added to the
survey file. Be aware that when you use the Rule Wizard to create arule, you are
actually creating a JScript script—the Wizard creates the script for you.

® You cannot use the Rule Wizard to edit scripts. Once aruleis created, you must
use the Rule Scripts window to reviseit. If you are not familiar with the JScript
language and are uncomfortable with editing a script, it is best to simply delete the
rule and recreate it using the Wizard.
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To View a Rule Script in the Rule Wizard

Figure 11-2
Rule Wizard pencil icon

When you use the Rule Wizard to create arule, you are actually creating a script—the
Wizard writes the JScript code for you. You can view the rule script that is being
created by clicking the pencil icon. However, you cannot edit the script here. To edit a
script, you must compl ete the rule and open the script in the Rule Scripts window.

Validation Rules

Validation rules:

m Help ensure dataintegrity by requiring data to conform to criteria that you select
during rule creation.

m  Areattached to variables and are given the same name (by the software) as the
variable.

m  Aretriggered whenever they encounter an invalid value for a given variable. For
example, if you definethevalid valuesfor AGE as 18 through 90, aValidationrule
will display an alert when you try to enter 150.

You can set Validation rules to verify values during data entry or to check an existing
datafile. If you set the rulesto activate during data entry, an alert is given as soon asan
invalid value is entered. When you want to check an existing data file, use Check File
on the Rules menu in the Builder or Form windows. This produces a report of all the
rules violated, sorted either by case or by rule.

Tip: In some cases, you do not even need a Validation rule. The variable type can aso
determine values that are invalid. For example, the software will not let you enter non-
numeric characters into a numeric field.
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Validation Rule Specifications

There are three main elementsin aValidation rule;

Variables. The variable(s) to which the rule will be assigned. If you are using the Rule
Wizard and you select more than one variable, the Wizard will create a separate rule
for each variable. The scripts of these rules are identical, with the exception of the
variable name.

m A variable can have only one Validation rule attached it. Variables that already
have Validation rules assigned to them are not shown in the Rule Wizard variable
list.

Alert. The type of dert that is given for invalid entries.

Valid value criteria. The criteria that determine which values are accepted as valid.
Values outside of these criteriawill be flagged as they are entered or during case and
file checking. You can choose to restrict valid values to any or al of the following:
values that are labeled or have response items, user-missing values, system-missing
values, arange of values (enter the lower and upper bounds), or whole numbers.

Your new Validation rule will be identified by the variable to which it is attached. For
example, if you create anew rule for the variable SALES, the new ruleislisted in the
Builder ruleslist as SALES

Tip: In some cases, you do not even need a Validation rule. The variable type can also
determinevaluesthat areinvalid. For example, the system will not let you enter astring
variable into a numeric field.

To Create a Validation Rule with the Rule Wizard

» From the Builder or Form window menus choose:

Rules
Rule Wizard...

> Select validates a single variable (Validation).
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Figure 11-3
Rule Wizard-Assigning a Validation rule to a variable

Rule Wizard - ¥alidation Rule Assignment

To which variables would you like to azzign validation rules pou
are creating? Click on the bow to zelect the variable.

Name | c. | Label | Format | File Order = | —Action for an invalid enty—

O® o o F30 1 wihat kind of notification

[ PRODUCT On  Produ.. FZ0 2 do pou want far an

O saTISF1 0O Over. F20 3 imvalid entry?

O# saTISF_2  OfF Over. F20 4

O RECOMMD 0Of ‘woul.. F20 5
3
7
g

* Sound

O @ CAaLL O Spok.. F20 " Standard alert message
O« PoOUITE Of Perfor.. F4.0

O PDELIVER 0O Perfar.. F40

O vallE Of Pefor.. F40 9
O PRELIXBL O Perfar.. F40 10

O IRELAEL  OF Impor.. F4.0 "

I'ié\nncl: ME Parfar  EAM 17 I_ILI
4 3

Yariables which already have validation rules
are not included in this list.

™ Custom alert message:

< Back | Mest » | Cancel | Help I

» Select the variable(s) to which the new rule will be applied by clicking the check box
to the left of the variable. Y ou can create many rules with the same criteria at once by
selecting more than one variable.

» Select thetype of notification that will warn you of invalid entries. If you select Custom
alert message, you must enter the message text.
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Figure 11-4
Rule Wizard-Determining valid values in a Validation rule

Rule Wizard -- ¥arnable Validation

» Select the criteriathat determine which values are valid.
» Click Finish to create the rule.
Tips

m  Click the pencil icon to view the rule script.
m  Use Rule Optionsto determine how and when Validation rules activate.
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Creating Validation Rules with the Variable Properties Settings

A Validation rule is automatically created when you set the acceptable values for a
variable using the Valid Valuestab of the Variable Propertieswindow. Theresult isthe
same as when you create a Validation rule with the Rule Wizard, except that you are

not able to select the type of natification for invalid entries. A sound (the default
notification) is used.

Figure 11-5
Variable Properties—Valid Values tab

Generall Formatl \-"aluesl Missing Values  ValidVYalues |

Check the types of values to be accepted. All others are flagged during
entry and checking. If none are checked, all values are valid.

Check all that apply:
[+ “alues which are labeled and response items
™ Uszer-defined missing values

W System-missing value

Range of values:

Lower bound: I Upper bound: I

[T &l values must be whole numbers

Close | Help |

m Variablesthat already have Validation rules assigned to them are not shown in the
RuleWizard variablelist. If you try to create aValidation rule with the Wizard and
can't see the variable you' re looking for, you may have already created one by
setting the Valid Values. If you want to revisetherule and arefamiliar with JScript,

use the Rule Scripts window. Otherwise, del etethe rule and create anew one using
the Wizard.
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Validation Rule Example

The following example shows you how to create a Validation rule that checksto seeif
arespondent’s age is within an acceptable range. You can find the variable used,
BIRTH, in the Customer Satisfaction Survey, which was installed with the program.

To create therule:

» From the menus choose:

Rules
Rule Wizard...

» Inthe Rule Wizard - Start dialog box, click Validates a single variable (Validation).
» Click Next.

» IntheRule Wizard - Validation Rule Assignment dialog box, click BIRTH, which
selects the variable for the rule.

» Click Standard Alert Message.

» Click Next.

Now that you have selected the rule type and the variable to which the rule applies, the
final step isto specify the criteriafor the rule. Given that thisis a business-oriented
survey, you can assume that your respondents should fall within the ages of 18 to 75.
You will create therule so that it will trigger if someone claimsto be younger than 18
or older than 75.

» Inthe Rule Wizard - Variable Validation dialog box, type 1925 for the Lower bound
and type 1982 for the Upper bound.

» Click Finish.
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Example: Validation Rule Script

You can view the Validation rule you created by clicking the Rulesicon in the Builder
window and then double-clicking on the rule named BIRTH.
For more complex rules, see Chapter 12.

function BIRTH_Validate(thisVar) // Generated by wizard

{

if (thisVar.IsNotvalid())
{

RuleViolation(1)

Checking Rules

Checking rules:
m Ensure data integrity by examining the rel ationships between variables.

m  Are attached to neither variables nor questions. Y ou name Checking rules when
you create them.

m |dentify logical inconsistenciesin combinations of variables by comparing data
with conditional (if-then) statements (such as, if salesare greater than $5,000). For
example, a government tax agency might use a Checking rule that compares
INCOME against AGE to flag tax returns for auditing purposes. It is unlikely that
a 16-year-old would have a personal income of $100,000; a Checking rule would
trigger an alert for such a case.

You can use Checking rules to check values as data are entered or to check an existing
datafile. If you set the rules to activate during data entry, an error message displays
whenever acase with an invalid combination of valuesis committed. When you want to
check an existing datafile, use Check File on the Rules menu in the Builder or Form
windows. This produces areport of al therulesviolated, sorted either by case or by rule.
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Checking Rule Specifications

Checking rules are built on conditional if-then expressions, which consist of one or
more relations. Relations are short mathematical or logical statements that can be
evaluated astrue or false (X<10 isarelation, for example). Checking rules work such
that if the value entered for a given variable meets the conditions in the conditional
expression, then a specified action will take place. Defining the relationsin the if
expression and the resulting action in the then section are the two main stepsin creating
a Checking rule.

Figure 11-6

Checking rules—Specifying relations in the Rule Wizard

Rule Wizard - Checking Rule

—IF
'& Select the: value label

Yariables: Operators:
[nCoME =] [islabeled ] & Valuelsh [$750000rmore 7]
) 4 Eniatle I vl

Combinations
(Elick on a button bo add a relation: A | Or | ‘

[Wars.AGE Walue < 18] &% [Wars.INCOME .l1sLabeled("$75"."000 or more™])

ge the right mouge button to delete, group, or ungroup selected relations.

Specifying relations (if). A relation includes a variable from your file, a comparison
operator, and a value or variable to which the first variable is compared. The
comparison operator can be alogical operator, such as less than, or a method such as
Isvalid. In the Rule Wizard, you can add relations by clicking the And and Or buttons;
you can also right-click in the window to delete, group, or ungroup relations.

For more information on building relations, see * Tips on Using Operators in the Rule
Wizard (Checking and Skip & Fill Rules)” on p. 216.
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Figure 11-7
Checking rules—Specifying actions in the Rule Wizard

Then
V The case: Matification for imealid case:
" Walid " Standard alert

E & |rvalid = Custom alert:

Age-lncome combination unlikely. Check
case.

< Back | Finizh | Cancel | Help |

Specifying actions (then). You can choose to make cases that meet the conditions
invalid or valid; you can also choose a standard or custom alert.

m  TheRule Wizard window displaysthe JScript code asit is being built. Y ou cannot
edit the script here. To revise ascript, you must completeit and openitinthe Rule
Scripts window.

To Create a Checking Rule with the Rule Wizard

» From the Builder or Form window menus choose:
Rules
Rule Wizard...

P Select Checks a logical relationship between variables (Checking) and enter the name of
therule.
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Figure 11-8
Rule Wizard—-Creating a Checking rule

Rule Wizard - Checking Rule

'& [ Select the value label

Wariables: Operators:

[ncoME =] [islabeted ] & valuelsk [s750000rmare x|
[ Variab_le:l vI
i~ Combinations

Click on a button to add a relation: And | Or |

[Wars AGE Walue < 18) &k (Wars INCOME 1sLabeled("$75"." 00D or more"])

Use the right mouse button to delete. group, or ungroup selected relations.

= Valid 7~ Standard alert — :
& Invalid & Custom alert Age-ncome combination unlikely. Check

Caze.

T: =
V The case: Matification for invalid case:
B

¢ Back | Finish | Cancel | Help |

Create an expression that determines when the rule will activate: select avariable, a
comparison operator, and a value or variable to which the first variable will be
compared.

Select Valid or Invalid to determine the status of cases that meet the conditions you just
specified.

Select the type of natification that will occur when an invalid case is found.

Click Finish to create therule.
Click And or Or to expand the if expression with additional relations.

Right-click in the expression box to delete, group, ungroup, or negate expressions.

Click the pencil icon to view the rule script.

Use Rule Options to determine how and when Checking rules are activated.
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Checking Rule Example

The following example shows you how to create a Checking rule that checks for a
logical relationship between age and education level. You can reasonably infer that it
isunlikely that someone under age 22 has compl eted post-graduate work. You can find
the variables used, BIRTH and EDUC, in the Customer Satisfaction Survey, which was
installed with the program.

From the Builder or Form window menus choose:

Rules
Rule Wizard...

In the Rule Wizard - Start dialog box, select Checks a logical relationship between
variables (Checking) and type MyRule for the name of the rule.

Click Next.

In the Rule Wizard - Checking Rule dialog box, select BIRTH from the Variablesist.
In the Operator Ligt, select <=.

In the Value box, type 1978.

Click the And button.

Asyou create the expression, you will seeit appear in the Expression box inthemiddle
of the dialog box. When you clicked the And button, you added two ampersands (the

logical connector) and empty parentheses to accomodate the second expression. Now
you will create the second condition of the statement.

Select EDUC from the Variableslist.

In the Operator list, select IsLabeled.

In the Value box, select Post Graduate.
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You have created a condition that checks to seeif the value in the BIRTH variableis
less than or equal to 1978 and if the value in the variable EDUC is |abeled Post
Graduate. Thisistheif condition of your rule. The next step isto create the then
condition.

» Click valid.
» Click Custom alert.
» Inthe Custom alert box, type This is unlikely. Double-check, please.

» Click Finish.

If your conditionismet, your caseisvalid, but an aert isissued. If you wanted to make
adtricter rule, you would make the case invalid. In this case, you do not have to be so
strict sinceit is not impossible for someone under age 22 to have a post-graduate
degree; it issimply unlikely.

Example: Checking Rule Script

You can view the Checking rule you created by clicking the Rulesicon in the Builder
window and then double-clicking on the rule named MyRule.
For more complex rules, see Chapter 12.

function MyRule_Check() // Generated by wizard
{
if (I(Vars.BIRTH.Value <= 1978) && (Vars.EDUC.IsLabeled("Post Graduate")))
{
RuleViolation("This is unlikely. Double-check, please.")
}
}
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Skip & Fill Rules

Skip & Fill rules:

Speed data entry by skipping questions and filling in data based on previous
responses.

Are attached to questions and are given the same name (by the software) as the
guestion.

Enable you to skip and fill in values for variables that are not applicable or
necessary for aparticular case. For example, if you are entering data for amale
respondent, a Skip & Fill rule enables you to skip a section of questions intended
only for females. The rule activates as soon as the value male is entered for the
question Gender. This same rule could set all of the female-only questionsto not
applicable for this particular case.

Using Skip & Fill rules, you can:

Jump to aquestion on aform. Y ou can navigate though a data entry form by
skipping questions that are not applicable for agiven case. You can also jumpto a
question on a different form.

Fill in or change avaue. Values are automatically filled in so that you don’t have
to enter them manually. You can even fill in variables that are on your survey.

Change properties of questions and controls. For example, you can hide or show
individual questions and change the properties of controls, such as font size and
style and foreground and background colors.

Commit the current case.
Move to the next case.
Create anew case.

Skip & Fill Rule Specifications

Like Checking rules, Skip & Fill rules are built on conditiona (if-then-else)
expressions, which consist of one or more relations. Relations are short mathematical
or logical statements that can be evaluated as true or false (X<10 isarelation, for
example). Skip & Fill ruleswork such that if the value entered for a given question
meets the conditions in the expression, then a specified action takes place, else (if the
expression is false) adifferent action occurs. When building a Skip & Fill rule, you
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must select the question to which the new rule will be attached and then define the
expression (if) and the resulting actions (then-else) for the rule.

® A question can have only one Skip & Fill rule attached it. Questions that already
have Skip & Fill rules assigned to them are not shown in the Rule Wizard question
list.

Figure 11-9
Skip & Fill rules—-Specifying relations in the Rule Wizard

Rule Wizard - S5kip & Fill Bule: Expression 1 of 1

—If
-& Select the value label
Wariables: Operatars:

[FaiL = fistabeled x| & Valelsh [No =l
) Wariable: I vI
— Combinations
Click on a button to add a relation: And dr

[Wars.FAIL. |sLabeled["No™]]

se the right mouse button to delete, group, o ungroup selected relations.

Specifying relations (if). Thisincludesavariablefromyour file, acomparison operator,
and avalue or variable to which the first variable is compared. The comparison
operator can be alogical operator, such aslessthan, or amethod such aslsvalid. Inthe
Rule Wizard, you can add relations by clicking the And and Or buttons. You can also
right-click in the window to delete, group, or ungroup relations.

See “Tips on Using Operatorsin the Rule Wizard (Checking and Skip & Fill
Rules)” on p. 216 for more information on building relations.

Specifying actions (then-else). You can set skip and fill actionsfor valuesthat meet the
conditionsin the expression (then) and for thosethat do not (el se). Skip optionsinclude
skipping to another question or form; fill options enable you to fill in values for other
variables.

m  Yournew Skip & Fill rulewill be identified by the question to which it is attached.
For example, if you create anew rulefor the question Incom 97 on Forml, the new
ruleislisted in the Builder ruleslist as Forml_Questionl.

m  The Rule Wizard window displaysthe JScript code asit is being built. Y ou cannot
edit the script here. To revise ascript, you must completeit and openitinthe Rule
Scripts window.
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To Create a Skip & Fill Rule with the Rule Wizard

» From the Builder or Form window menus choose:

Rules
Rule Wizard...

P> Select Sets values of variables, and skips to questions (Skip & Fill).

Figure 11-10
Rule Wizard-Assigning a Skip & Fill rule to a question

Rule Wizard - Skip & Fill Assignments

Select the guestion which firez a Skip & Fill rule. The rule is fired when a value is entered into the
selected question(z]. Click on the box to select the question.

Question MName | Check. | Farm Mame | (uestion Text |
O age [uli Farml Age of respondent

|:| Fincome f Farrnil Farnily income

O Gender off Farrml GENDER

F = Fai On Farrml Did product ever fail to operate?

Questions which already have Skip & Fill rules are nat included in this list.

< Back | Mext » | Cancel | Help |

» Select each question to which the new rule will be applied by clicking the check box
to the l€eft of the question. Y ou can create many rules with the same criteria at once by
selecting more than one question.
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Figure 11-11
Rule Wizard—-Building a Skip & Fill rule

Rule Wizard - S5kip & Fill Rule: Expression 1 of 1

i
-& Select the value label
Wariables: Operators:

FaIL =l fislabeled =] & Waleels) [Mo =l

£ aratler I vI
- Connbinations
Click on a button to add a relation: And | Qr |

[Vars.FAIL.IsLabeled["Mo™]]

Use the right mouse button to delete, group, of ungroup selected relations.

— Then Elze
V Skip to a Question... | x Skip to a Question... |
3 Filvabes.. | FilValues.. |
< Back | MHest » | Finish | Carcel | Help |

» Create an expression that determines when the rule will activate: select avariable, a
comparison operator, and a value or variable to which the first variable is compared.

» Inthethen section, click Skip to a Question to determine the question and form the
system will skip to if the expression istrue.

See “To Specify Skip Optionsin the Rule Wizard” on p. 213 for more information.
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Figure 11-12
Rule Wizard--Specifying fill options

Fill when Expression is True [ x|

V Tafill a variable, specify the value in the valug colunmn,

Yariable Value e
(o]
PRODUCT
SATISF_1
SATISF_2
RECOMMWD |9
CalLl
PCLITE
PDELIVER
WALLE

PRELI&BEL LI

Prezs the Clear button to delete the fill LClear |

Help | Continue | Cancel |

v
-

» Inthethen section, click Fill Values to select the variables and the values that will be
filled inif the expression istrue.

» Set Skip & Fill optionsfor instances when the expression is false by clicking Skip to a
Question and/or Fill Values in the else section.

» Click Finish to create the rule.

Tips
m Click And or Or to expand the If section with additional relations.
®m  Right-click in the expression box to delete, group, ungroup, or negate expressions.
m Click the pencil icon to view the rule script.
m  Use Rule Options to determine when Skip & Fill rules activate.
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To Specify Skip Options in the Rule Wizard

When you click Skip to a Question in the Then or Else sections of the Rule Wizard, the
default action isto go to the next question on the current form.

Figure 11-13
Skip & Fill-Specifying Skip To options

Skip when Expression is True E3

V when the expression is: True

& Go to next question on curent form

" Skip to question: |<Nextl§!uestion> j

on farm; IFU[m'] j

[T Goto nest case

Help | Continue Cancel

To go to adifferent question or form:

> Select Skip to question.

» If you want to skip to a question on the current form, select the question from the
question drop-down list. The question list contains all of the questions from the
selected form, as well as <First Question> and <Next Question> options.
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Figure 11-14
Skip & Fill--Specifying a particular question

Skip when Expression is True E

V Wwhen the expression is: Tiue

o bo next question on curent form

¥ Skip to question; IFincnme j

o forrm; IFD[m'I j

¥ Gotonest case

Help | Continue | Cancel |

» If you want to skip to aquestion on a different form, select the form from the form
drop-down list, and then select the question from the question list.

» If Go to next case is selected, the skip and fill actions are performed, and the software
automatically moves to the next case.
Tip: To move automatically to the beginning of the current form for anew case, select
<First Question> from the question list and check the Go to next case check box.

Skip & Fill Rule Example

The following example shows you how to create a Skip & Fill rule that will take a
respondent who answers no to question six (Did this product fail to operate?) to
guestion nine and fill in the questions in between with Not Applicable.
Note: If you wish to work through this example yourself in the Customer Satisfaction
Survey that was shipped with the product, you must go to the Builder window and
delete Online_Question6 and Web_Question6.

» From the Builder or Form window menus choose:
Rules

Rule Wizard...
P> Select Sets values of variables, and skips to questions (Skip & Fill).
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Inthe Rule Wizard - Skip & Fill Assignments dialog box, click the check box in front
of Question6.

Click Next.
In the Rule Wizard - Skip & Fill Rule dialog box, select FAIL from the Variables list.
Select IsLabeled from the Operators list.

Select No from the Vaues list.

Asyou create the expression, you will see it appear in the Expression box. You have
created an if statement that checks to seeif the answer to Question6 is no. Now, you
will create the then statement.

Click Fill values.

In the Fill when Expression is True dialog box, type 99 for the variables CONTFAIL
and PROBMEET.

Click Continue.

You have created half of the then statement. If the answer to Question6 is no, the
software will fill in 99, which is code for not applicable as defined in the Variable
Values tab of the Variable Properties window, for the variables CONTFAIL and
PROBMEET. Youwill now createthe second half of thethen statement, which will skip
to Question9.

In the Rule Wizard - Skip & Fill Rule dialog box, click Skip to a Question.

In the Skip when Expression is True dialog box, click Skip to question and select
Question9 from thelist.

Click Continue.

Click Finish.
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Example: Skip & Fill Rule Script

You can view the Skip & Fill ruleyou created by clicking the Rulesicon in the Builder
window and then double-clicking on the rule named Online_Question6.
For more complex rules, see the Chapter 12.

function Online_Question6_SkipFill(thisRespObj, thisVar) // Generated by wizard

{
if (Vars.FAIL.IsLabeled("No")))
{
Vars.CONTFAIL.Value=99
Vars.PROBMEET.Value=99
Forms.Online.Question9.SetFocus()
}
else
{
// by default focus will go to the next question
}

Tips on Using Operators in the Rule Wizard (Checking and Skip & Fill Rules)

Correctly specifying relations in a conditional expression (such asif AGE islessthan
21) isintegral to creating Checking and Skip & Fill rules. Relations contain
comparison operators, which consist of logical operators and object methods. If you
areunfamiliar with JScript, thelogical operators may appear differently fromwhat you
expect. For example, the JScript operator for equal to is == rather than the single
equals sign used in mathematical expressions (=). Different comparison options are
available depending on which operator you choose.
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Logical operators. Six logical operators are available: = (nhot equal), < (less than), <=
(lessthan or equal to), == (equal to), > (greater than), and >= (greater than or equal to).
Once you choose an operator, you must select avalue or variable to complete the
relation. You can select avariable or avalue from their respective drop-down lists or
enter avalue or arithmetic expression.

IsLabeled. Tests avalue by checking it against one of its value labels. When using this
operator, you must select avalue label from the drop-down list. For example, the
relation if (Vars.EDUC.IsLabeled("High school")) tests to see whether the value of
EDUC islabeled “high school ”

Any, NotAny. Any tests whether avalueisamong alist of valuesthat you enter; NotAny
doesthe opposite, testing whether avalue is not among the list of valuesthat you enter.
You must separate each value on the list with acomma. For example, the relation if
(Any(Vars.REGION.Value,1,3,4)) istesting to see whether the value of REGION is
equa to 1, 3, or 4.

IsMissing, IsValid, IsNotValid. These operators test whether avariable'svalueis,
respectively, missing, valid, or not valid. (Valid values are set in the Valid Values tab of
the Variable Properties window.)

Range. Tests whether avalue isin arange of numbers that you enter. For example, the
relation if (Range(Vars.EDUC.Value,3,6)) istesting to see whether the value of EDUC
is between 3 and 6.

To Add Relations in the Rule Wizard (Checking and Skip & Fill Rules)

When you are creating Checking or Skip & Fill rules with the Rule Wizard, you can
click And or Or to add arelation to your if statement. The Wizard inserts the necessary
JScript operator to your expression in the expression window—& & for And, || for Or.

To Modify Relations in the Rule Wizard Expression Window (Checking and
Skip & Fill Rules)

You can use the Rule Wizard expression window to modify relations in Checking and
Skip & Fill rules. You can right-click to group, separate, negate, and remove relations.
Grouping relations can change the meaning of an expression. For example, the
expression X==1 AND Y==1 OR Z==1is different from X==1 AND (Y==1OR
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Z==1). Intheformer, the rule will be activated if X and Y equa 1, or if Z equals 1; in
the latter, the rule will be activate only if X equals 1 and either Y or Z equals 1.

Figure 11-15
Checking and Skip & Fill rules—-Using the Rule Wizard expression window

Rule Wizard - Skip & Fill Rule: Expreszion 1 of 1

If
-& Select the walue label
Wariables: Operators:

[ncoME 7] JisLabeled x| Walue(sk

) anahles I vI
 Combinations
Click on a buttan to add a relatior: and | Or |

[Wars AGE Walue < 18] && [WVars. INCOME_I1sLabeled("$75"."000 or more™])

Remove Relation
Group Relations

Uze the right mouse button to delete, ’ relations.
Separate Relations
—Then MNegate Relation
V Skip to a Question... | x Skip to a Question... |
B il Values... | Fill Values... |

< Back I Hest » | Finish | Cancel | Help |

®  Remove Relation deletes the selected relation(s).

m  Group Relations adds parentheses around selected relations.

m  Separate Relations removes the outermost parentheses from selected relations.
|

Negate Relation insertsa! (Not) operator in front of the selected relation(s). If the
relation is already negated, this removes the ! operator.

To use any of the relations commands:
» Inthe Rule Wizard expression window, use the mouse to select one or more relations.

» Right-click and choose the necessary relations command from the menu.
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To Edit a Rule Created with the Rule Wizard

You cannot use the Rule Wizard to edit rules. Once aruleis created, you must use
the Rule Scriptswindow to reviseit. If you are not familiar with the JScript language
and are uncomfortable with editing arule script, it is best to simply delete the rule
and create a new one using the Wizard. For information on editing rule scripts, see
Chapter 12.

To Delete a Rule

To ensure that you del ete the correct rule, remember that:

m Validation rules are named for the variables to which they are attached.
m  Skip & Fill rules are named for the questions to which they are attached.
®m You name Checking rules when you create them.

Figure 11-16
Rules in the Builder window
% Builder |_ O] %]
File Edit ¥%iew Inzert Bulez Help
olE| 2] plee] ole] 2] ﬁl @Iﬁlﬁ
El?lx-li"'_l |<.-’-‘«IIF-:rrns> ¥ =
Mame I Type
T gatis] Checking
B Form1_Fail Skip & Fill
T age_inc Checking
%=1 REPAIR " alidation
%=1 PRODUCT " alidation
%=1 |NCOME " alidation
Ready HLUM o

» Todisplay rulesin the Builder window, from the menus choose:

View
Rules
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» Select arule and press the Delete key.

Alternatively, you can delete arule by selecting Delete on the Edit menu in the Builder
window or Delete Script on the Scripts menu in the Rule Scripts window.

m When avariableis deleted, any Validation rules associated with it are deleted as

well. Similarly, when aquestion is deleted, any Skip & Fill rules associated with it
are also deleted.

m If you delete any object that isreferenced within arule, theruleis no longer valid.
Y ou must edit or remove the reference.

Rule Options

Rule Options control when rules activate and how they operate.

Figure 11-17
Rules Options dialog box

Rulesz Options E

—%alidation and Checking Rule Properties K
— Data Checking

¥ Data are checked automatically
¥ Data are checked when filled by a rule

Caticel

Help

Pl

— &ction far lreealid Mew D ata

v allow an override for new entries

V¥ Allow new cazes with checking ke vidlations to be saved

— Skip & Fill Propertie
v Test Skip & Fil rules:

& when a question loses focus

" LIpan tabbing fram a field

Validation and Checking Rule Properties. Determine when Validation and Checking
rules take action.

m Data are checked automatically. If selected, Validation rules check vaues as they
are entered, and Checking rules check datawhen a case is committed (Auto Check:
On displaysin the entry form status bar). If this option is not selected, Validation
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and Checking rules are not applied until Check Case or Check File is selected from
the Rules menu.

m Data are checked when filled by a rule. If selected, valuesfilled in by a Skip & Fill
rule are automatically checked by a Validation rule.

m  Allow an override for new entries. Determines whether you can override an invalid
value warning from a Validation rule. If this option is selected, the Override Error
tool and command on the Form window’ s Rules menu are enabled. Choosing
Override Error allows you to move off of afield after aValidation error. If this
option is unchecked, Override Error is disabled, and you cannot move to another
guestion until avalid value is entered.

m  Allow new cases with Checking rule violations to be saved. Determineswhether you
can move to the next case after attempting to commit a new case that has violated
a Checking rule. If this option is selected and you attempt to commit a new case
with a checking error, an aert displays, and you are given the option to go to the
checking report to view the errors or to ignore the errors and continue to the next
case. If you go to the checking report but do not correct the checking error, the aert

will display again.

Skip & Fill Rule Properties. Determine when Skip & Fill rules are activated.

m  Test Skip & Fill rules. You will generaly turn these off when making changesto an
existing datafile (since, presumably, al of the values have been entered into the
file). If When a question loses focus is selected, the rules will activate anytime you
move away from a question, whether it is with the keyboard or mouse. If Upon
tabbing from a field is selected, the rules will activate only when you move away
from a question by using the Tab or Enter keys.

To Set Rule Options

» From the Builder or Form window menus choose:

Rules
Rule Options...

» Select the settings you want.

» Click OK.
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To Check Data Automatically (Validation and Checking Rules)

You can use Validation and Checking rules to check data as they are entered.

» From the Builder or Form window menus choose:
Rules
Rule Options...

» Select Data are checked automatically.

With automatic checking enabled:
m Validation rules will activate immediately after an invalid value is entered.

m  Checking ruleswill activate immediately after a case with an invalid combination
of valuesis committed.

An error message will display the incorrect value(s) and the Validation or Checking
rule that was violated.

Copying and Pasting Rules

You can:
m Directly copy Checking rules from one file to another.

m Copy Vdidation and Skip & Fill rules from one file to another by copying the
variables (for Validation) or questions (for Skip & Fill) associated with thoserules.

m Create many Validation or Skip & Fill rules at once by selecting more than one
variable or question in the Rule Wizard.

m Reusethe same rule script code for multiple rules by creating a procedure and
calling it from many different rules.
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To Copy and Paste a Checking Rule

To copy and paste a Checking rule:

» If the Checking rule you want to copy isin adifferent file, open both files.

Each file hasits own Builder window, allowing you to copy and paste el ements
between them.

» Usethe View menu or the toolbar to display the rulesin each Builder window.

» Select one or more Checking rules and hold down the left mouse button to drag
selected rules from one Builder window to the other. Or, from the Builder window
menus choose:

Edit
Copy

» Inthe Builder window where you want to paste the rule, from the menus choose:
Edit
Paste
Alternatively, you can use Ctrl+C to copy the rule and then Ctrl+V to pasteit. You can
also drag a Checking rule from one Builder window to another.
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Rule Scripts

Rule scripts are short sets of JScript statements. When you create arule with the Rule
Wizard, you are actually creating a rule script—the Wizard writes the JScript syntax
for you. Rule scripts are powerful; you can use them to:

m  Manipulate questions and controls. For example, you can write scriptsto hide or
show questions and response controls (for example, text boxes, option buttons,
etc.). You can also change the visual properties (font family, size, and style or
foreground and background colors) of controls.

m  Compute numbers and dates on the fly. Y ou might compute an overall customer
satisfaction measure by averaging the responsesto five different survey questions.

m  Movethefocusto different cases, questions, and forms. Y ou can write a Skip &
Fill script that will move you to another case, question, or form based on the
response to a previous question.

m Evauate and modify variables. Y ou can check whether values are valid, coded as
system- or user-missing, or equal to a particular value label.

225
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The following is an example of a Validation rule script that checks the variable
PRODUCT for valid values:

Figure 12-1
Example rule script

& Rule Scripts M=l E3
Scriptz  Edit “iew Help
S| @ g sl 2] El] [Frouct_vaidse =

function PRODUCT Validate[thisVar] J}{ Generated by wizard

Ready Ln 3, Cal1 Design 2

if (thisVar.lsNotValid(])

RuleViolation[1]
}

Refer to the online JScript Help for more information on using JScript. If you do not
have the JScript Help installed, run the install program and select Custom Install; then
select JScript Help Reference.

Creating Rule Scripts

You can create rule scripts using the Rule Scripts editor. You can also edit existing
scripts, such asthe scriptsincluded with this software and any scripts you have created
with the Rule Wizard. You must be familiar with JScript in order to customize or create
complex rule scripts.

If you are unfamiliar with JScript or with programming in general, you may want to
create rules in the Rule Wizard and then open them in the Script window. When you
think you understand how a particular rule works, try replacing part of it and see what
happens. Editing existing rules is agood way to learn how JScript works.
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To Create a Rule Script

» From the Builder or Form window menus choose:
Rules
Rule Scripts
» From the Rule Scripts window menus choose:
Scripts
New Rule...

» Or, from the Builder window menus choose:

Insert
Rule...
Figure 12-2
Creating a new rule script—Selecting the type of rule
Rule Type: oK |
&' Validation c I
Varisble:  [FINCOME =] il
" Checking Hel
= p
Rule name: I 4'
" Skip & Fil
Buestion: I j
“wizard... |

» Select validation, Checking, or Skip & Fill.

» Select the appropriate variable (for aValidation rule) or question (for a Skip & Fill
rule), or enter the rule name (for a Checking rule).

» Click OK.

m  TheRule Scriptseditor will display atemplate script. The editor will not allow you
to edit or delete the first line (beginning with the JScript keyword function) or the
outermost set of brackets, as these parts of the script are required by JScript.
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Figure 12-3
Rule script template
#" Rule Scripts M=l E3
Scrptz  Edit Miew Help
S| oo x| @ el alsEl 2] el Fncome vaisae =

function FINCOME_Validate[thisVar]
{

}

Fieady

Lt 3. Cald Design 7

» Complete the script by entering the necessary JScript commands.

» Toautomatically save the script and check it for syntax errors, close the Rule Scripts
editor or use the drop-down list to move to another script.

To Edit an Existing Rule Script

You can modify existing rule scripts using the Rule Scripts editor. The editor works as
abasic word processor in that you can add, cut, copy, and paste text with relative ease.
You can also paste rule script code using the Objects, Functions/M ethods/Constants,

Procedures, Operators, and Statements windows.

m |tisimportant to notethat oncearuleis created, the only way to reviseitisby using
the script editor—you cannot use the Rule Wizard to edit scripts. If you are not
familiar with the JScript language and are uncomfortable with editing ascript, itis
best to simply delete the rule and recreate it using the Wizard.

To edit arule script:

» |Inthe Builder window, double-click on arule.

» Edit the script.

The Rule Scriptseditor will not allow you to edit or del etethefirst line or the outermost
set of brackets, as these parts of the script are required by JScript.
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Alternatively,

» From the Builder or Form window menus choose:

Rules
Rule Scripts

» By default, the script for thefirst ruleis displayed. Choose the script you want to edit
from the drop-down list on the toolbar.

Rule Scripts Window

Figure 12-4

Rule Scripts window
# Rule Scripts M=l &3
Scriptz Edit iew Help
S| =l o] él el a|E =] &l [Proouct_vaidse =

function PRODUCT Validate[thisVar] J}{ Generated by wizard
if [thisVar.lsNotValid[])

RuleViolation[1]

}
}

Ready Ln 3, Call Design 2

Scripts. Use the Scripts menu to create a new rule or procedure, check rule script
syntax, and print and delete scripts.

Edit. Use the Edit menu to cut, copy, and paste text, find and replace text strings, and
change the default display font.

View. Use the View menu to move to another rule, view the Objects,
Functions/M ethods/Constants, Procedures, Operators, and Statements windows, and
change the toolbar and status bar display options.

Help. Use the Help menu to access online Help for the many features available in this
product.
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How Scripts Work

Rule scripts are written in JScript. JScript is Microsoft’s version of the JavaScript
scripting language and is an interpreted, object-based scripting language. Rule scripts
work through OL E automation to manipul ate objects using properties and methods.
Each object class has specific properties and methods associated with it. For example,
guestions are a class of objectsin this product. You can use the SetFocus method to
navigate from one question to another (asin a Skip & Fill rule) or manipulate the
Visible property to hide a question that is being skipped.

Objects, Properties, and Methods

Objects, properties, and methods are central to creating and editing rule scripts.

Objects. Objects are the elements that make up your file, including the file itself.
Classes of objectsthat can be used in rule scriptsinclude files (referred to as
DataEntryDoc in scripts), forms, questions, controls, form objects, and variables.
Objects are manipulated using properties and methods.

Properties. Like real-world objects, objects have features and uses. In JScript
programming terminology, the features are referred to as properties. Properties set or
return attributes of objects, such as the color or cell width.

Methods. Methods are the uses of objects. They perform actions on objects, such as
moving the question focus. For example, you can use the IsValid method to check if a
particular variable value is valid and then use the Value property to change the value.

Object Property (feature) Method (use)
Computer (real-world) speed, amount of memory word processing, spreadsheets
Question (this software) BackColor, Visible Move, SetFocus

Press Ctrl-O any time you are working in the script editor to display the Objects
window, which displays object classes and the properties and methods associated with
each.

See the online Help for more information on individual objects, properties, and
methods.
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Objects Window

To build usable scripts, you need two things: proper syntax and logical, correct
relations. You can use the Objects window to create proper syntax.

The Objects window displays all object classes and the methods and properties
associated with each. Y ou can aso access help on individual properties and methods
and paste selected properties and methods into your script.

To view the Objects window:

» From the Builder or Form window menus choose:

Rules
Rule Scripts

» From the Rule Scripts window menus choose:

View
Objects
Figure 12-5
Objects window demonstrates the object hierarchy
|->->->->F'mperties j ﬁl
E- DataEntrpDoc | | Properties | Type | Arguments -
- Properties @I BackCaolor unzigred short
- Methods BB ackshle unzigred int
B FF”T'S ) @ BarderCalar unzigred shart
i+ Properties BB orderShle unzigred int
Methods @ Barderafidth unzigred int
= F?mﬂ . E4Enabled Boolean
Elr.::?;r;:s @-‘I Height unzigred int
- Fail 1 ﬁ& left unzigred int
EI Gender Hame String
Propetties OptionButton Object
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Objects are hierarchical in nature. Clicking on a plus sign in the Objects window
displays the next level of the hierarchy. In writing arule script, the full name of an
object, property, or method includes all of the objects that come above it in the object
hierarchy.

The general convention is ObjectClass.ObjectName(s).PropertyOr Method. For
example, if you wanted to access the Enabled Property of the question named Gender,
the proper name to use is Forms.Forml.Gender.Enabled.

Any object must have a unique name within itsimmediate container (that is, the
object directly aboveit in the hierarchy). For example, the question Gender cannot
have two option buttons named OptionButtonl, but the questions Gender and Age can
both have option buttons with that name. Form2 cannot have two questions named
Income, but Forml1 and Form?2 can both have questions named Income.

Y ou can use the Objects window to help determine the full name of an object,
property, or method. Y ou can also use the Objects window to paste the full name
directly into your rule script.

To use the Objects window to create proper syntax:
Open the Objects window.

Navigate through the objects on the left side of the screen by clicking on the plus signs
or by using the drop-down list of objects in the upper |eft corner.

Double-click on a property or method on the right of the window to pasteit into the
Rule Scripts editor.

Y ou can also paste a property or method by selecting it and clicking the penicon or
pressing the space bar.

Tip: With the Objectswindow active, hold the mouse pointer over aproperty or method
on the right side of the screen to see a brief description of it.

RuleViolation Method in Validation and Checking Rules

If you are writing a Validation and Checking rule, you must include the RuleViolation
method. This method is used to display alerts and write results to checking reports.
RuleViolation takes a single argument, the results of which differ depending upon
whether you are checking data as they are entered or checking an entirefile at once
(batch checking).
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Thefollowing is an example of a Validation rule that uses the RuleViolation method:

function EDUC_Validate(thisVar)

{
if (thisVar.IsNotValid())
{
RuleViolation("Invalid value. Please reenter.")
}
}
Argument Checking during data entry Batch checking
A standard alert is written to the
0 The system beep sounds. checking file and displayed in the
Checking Report window.
A standard alert is given: L
p . » | A standard alert iswritten to the
1 <ruletype> <rulename> violated" | . coiing file and displayed in the
Example: “Checking rule INC_AGE | checking Report window.
violated.”
“strina® The custom aert is displayed. The custom alert message iswritten to
(custogm dlert) Example: “Invalid value. the checking file and displayed in the
Please reenter.” Checking Report window.

See Chapter 15 for more information.

ClearViolation Method in Validation and Checking Rules

You can use the ClearViolation method turns off aviolation set by RuleViolation
within arule. It turns off any alerts that would otherwise be issued at data entry time
and can also be used to write a message to the checking log. Only one messageis
written to the checking log per rule per case. ClearViolation has the following

arguments:
Argument Batch checking
A standard alert is written to the
0 checking file and displayed in the
Check Case window.
“string” The custom alert message is written
to the checking file and displayed in
(custom &lert) | ¢ Check Case window,
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Note: While you must include the RuleViolation method in Validation and Checking
rules, using the ClearViolation method is optional. You can use the ClearViolation
method to ensure that the warnings are written only to the checking log, which makes
for uninterrupted data entry.

Rule Script Components

In addition to objects, properties, and methods, rule scriptsinvolve the following
components:

Event. Events activate rules and are triggered by actionsin the software. The three
events available for use in rules scripting are Check, SkipFill, and Validate, which
correspond to the three types of rules. Check and Validate events, for example, are
triggered when you select the Check Case command; a SkipFill event is generated
when the value of avariable ischanged. The event isreferenced in thefirst line of each
rule. For example, a Validation rule attached to the variable AGE would begin with
function AGE_Validate (all rules and procedures begin with the JScript keyword
function).

Argument. Arguments are pieces of information that are passed to afunction. They
generally appear within parentheses, as in the date function TimeDays(9).

Predicate (optional). An if-then statement that evaluates to true or false. A predicate
will generally contain an arithmetic or logical expression—for example, if
(Vars. AGE.Value < 21).

Action. Actions change properties of controls, assign values to variables, and apply
methods to controls. For example, the following action sets the font of aform text
object to Courier: Forms.Forml.Text1l.Font.Name = "Courier".

Functions/Methods/Constants Window

The Functions/M ethods/Constants window displays all of the functions, methods, and
constants available within JScript, aswell asfunctionsthat are specific to dataanaysis
software from SPSS Inc. The entries are listed in alphabetical order. You can use this
window to paste selected functions, properties, and methods right into your script.
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Figure 12-6

Rule Scripts—Functions/Methods/Constants window (with description displayed)
Functions/Methods/Constants x|
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Control (String stFormM ame, Sting stiB ezponzeGivpht ame, Sting stiCc
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DataEntrpDoc )

DrateDimy (Integer day, Integer manth, Integer vear)
Dratebour (Integer month, Integer vear]

Datellyr (Integer quarter. Integer year)
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Debugtdezzage [Sting bstitessage)

eval [String sting)

Fire []
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GetDate [String shDateFormat, Stiing shiDate]
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Math. azin (D ouble number)

b ath. atan [Double number]

b ath. ceil [Double nummber]

Math.cos [Double number)

b ath.E

M ath.exp [Double number) =

1 - | vl

To view the Functions/M ethods/Constants window:

From the Builder or Form window menus choose:
Rules

Rule Scripts
From the Rule Scripts window menus choose:

View
Functions/Methods/Constants

With the Rule Scripts window active, you can also press Ctrl-M to bring up the

Functions/M ethods/Constants window.

Double-click on afunction, method, or constant to pasteit into the Rule Scripts editor.

Y ou can also paste an item by selecting it and pressing the space bar.

A question mark (?) is pasted wherever an argument must be filled in for agiven
function or method. For example, the date function DateMoyr is pasted into the script

editor as DateMoyr (?, ?) because it requires two arguments.
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Tip: With the Functions/M ethods/Constants window active, hold the mouse pointer
over afunction, method, or constant to see its description.

See the online JScript Help for more information on using JScript statements.

Operators Window

The Operators window displays the JScript mathematical and logical operators
available for usein rule scripts.

Figure 12-7
Rule Scripts—Operators window (with operator description displayed)

Add [+]

AddE qual [+=]
And [&)
Decrement [--]
Diwe []

DivEqual [/=]
Equiralence [==)
Greater [»]
GreaterE qual (=]
|ncrement [++]
Less (<1
L{Used to increment a number|
od [7)

ModE qual (%=)
Fuilt [¥]
FultEqual [*=)
Mot 1]

MatEqual [1=]
arn

Sub (-
SubEqual [-=]

To view the Operators window:

» From the Builder or Form window menus choose:
Rules
Rule Scripts
» From the Rule Scripts window menus choose:

View
Operators
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With the Rule Scripts window active, you can aso press Ctrl-R to bring up the
Operators window.

» Double-click on an operator to pasteit into the Rule Scripts editor. Y ou can also paste
an operator by selecting it and pressing the space bar.

Tip: With the Operators window active, hold the mouse pointer over an operator to see
its description.

See the online JScript Help for more information on using JScript statements.

Statements Window

The Statements window displays JScript operational statements (also called reserved
keywords) that can be used in rule scripts, such as break, for, and continue.

Figure 12-8

Rule Scripts—Statements window (with description displayed)

Statements =]

break
continue

;J Canlinue on to the next iteration of the loop|
if

FEt

return

this

war

wihile:

with

To view the Statements window:

» From the Builder or Form menus choose:

Rules
Rule Scripts

» From the Rule Scripts window menus choose:

View
Statements

With the Rule Scripts window active, you can also press Ctrl-S to bring up the
Statements window.
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» Double-click on astatement to pasteit into the Rule Scripts editor. Y ou can also paste

a statement by selecting it and pressing the space bar.

Tip: With the Statements window active, hold the mouse pointer over astatement to see
its description.

See the online JScript Help for more information on using JScript statements.

Example: Creating a Skip & Fill Rule Using the Rule Script Editor

In this example, a Skip & Fill ruleis created and attached to the first question, named
Productl, on Forml. Therule skipsto thefirst question on Form?2 if the response to
Productl is*Fax Machine.” This type of rule would be applicable in instances where
the rest of the questions on Form1 pertain only to respondents who have purchased fax
machines.

At the New Rule dialog box, select Skip & Fill and choose the question
Forml_Productl from the drop-down list.

Click OK.

The Rule Scripts editor will display atemplate script that includes the JScript keyword
function, thefull name of the question to which theruleisattached (Forml_Productl),
the event that triggers the rule (SkipFill), the arguments required for a SkipFill event
(thisRespObyj, thisvar), and the opening and closing brackets required by JScript. The
editor will not allow you to edit the JScript code before thefirst bracket or after the last
bracket.

function Form1_Product1_SkipFill(thisRespObj, thisVar)
{
}

Add apredicate statement (an if statement) that checks whether the response (thevalue
of the variable PRODUCT) is labeled “Fax Machine.” Y ou can use the Objects
window to paste the method (Vars.PRODUCT.IsLabeled(?)). Replace the question
mark with the required argument (“ Fax Machine™).

if (Vars.PRODUCT.IsLabeled("Fax Machine"))
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» Add thethen part of the statement in brackets. If the if statement istrue, this statement
will be executed. In this case, the focus will be set to the first question on Form2.

{
Forms.Form2.Question1.SetFocus()

}

» Closing the Rule Scripts editor or using the drop-down list to move to another script
will automatically save the script and check it for syntax errors.

The resulting script looks like this:

Figure 12-9

Creating a rule script

# Rule Scripts _|O] x|
Scriptz Edit Wiew Help

S| o |2 e w2 ﬁ” B A | +I|E|H <55 | [Fomt_Productt_SkigFi j‘

function Form1_Productl_SkipFillfthisRe spObj. thisVar]
if [¥ars.PRODUCT.IsLabeled['Fax Machine']]
Forms.Form2.Question1.SetFocus(

}
}

Ready LnE, Caol B Desigh

Procedures

Procedures are similar to rule scripts in that they are sets of JScript commands.
Procedures are meant to be called from rule scripts and are useful for reusing the same
batch of JScript code for many rules. For example, you might want to change the
background color and text of any question that is skipped due to a Skip & Fill rule.
Rather than insert the necessary JScript commandsinto every Skip & Fill rule, you can
save the commands as a procedure and call that procedure from each rule.
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To Create a Procedure

» From the Builder window menus choose:

Insert
Procedure...

» Enter the name of the new procedure and click OK.

» The script editor will display atemplate procedure. Finish the procedure by entering
the necessary JScript commands.

» Or, from the Rule Scripts window menu choose:

Scripts
New Procedure...

Procedures Window

The Procedures window displaysall of the procedures you have created for the current

file.
Figure 12-10
Rule Scripts—Procedures window

annual (]
comp_int []
todapdat [

To view the Procedures window:

» From the Builder or Form window menus choose:
Rules
Rule Scripts
» From the Rule Scripts window menus choose:

View
Procedures
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With the Rule Scripts window active, you can also press Ctrl-U to bring up the
Procedures window.

» Double-click on aprocedureto pasteit into the Rule Scripts editor. Y ou can also paste
aprocedure by selecting it and pressing the space bar.

Example: Procedure

The following procedure returns the current date.

function todaydat()
{
x = new Date()
str = new String()
y = x.getMonth()
y=y+1
str = y+'/"+x.getDate()+"/"+x.getYear()
return str

}
This script calls the procedure from a Checking rule.

function orderdat_Check()
{
// rule compares order date to current date
/[ if less than today's date, display alert
// call procedure to get today's date
Vars.TODAY.Value=todaydat()
if (Vars.ORDERDAT.Value < Vars.TODAY.Value)
{
RuleViolation("Invalid. Order date must be greater than or equal to current date.")
}
}
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To Debug a Rule Script or Procedure

A script or procedureisautomatically checked for syntax when it losesfocus (you open
another script or close the script window).

Y ou can also debug rule scripts and procedures by checking the JScript syntax in
the Rule Scripts editor.

» Inthe Rule Scripts editor, select the script or procedure that you want to debug.

» From the Rule Scripts window menus choose:
Scripts
Check Syntax

You can debug all of your scripts and procedures at once. From the Rule Scripts
window menus choose:

Scripts
Check Syntax for All Scripts

The script editor will display an aert for each syntax error that is found.
To Delete a Rule Script or Procedure
» Inthe Rule Scripts editor, open the script or procedure that you want to delete.
» From the Rule Scripts window menus choose:

Scripts
Delete Script

You can aso delete rule scripts and procedures from the Builder window by selecting
one and pressing the Delete key.

To Print a Rule Script or Procedure

» Inthe Rule Scripts editor, open the script or procedure you want to print.

» From the Rule Scripts window menus choose:

Scripts
Print...
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Rule Script Examples

The following examplesillustrate many of the tasks you can accomplish with rule
scripts. You can copy these examples from the online Help windows and customize
them for your own files. See the online Help for more script examples.

Example: Moving to Another Form on a Survey with
Multiple Forms

Check a value and move to another form. If you have asurvey with more than one form,
you must use a Skip & Fill rule to move from one form to another. This rule script
checksthe validity of AGE and, if the valueisvalid, moves you from the last question
on Forml to the first question on Form2. GetFirstResponseGlyph() is a method that
returns the name of the first question, in terms of entry order, on aform.

function Form1_Question5_SkipFill(thisRespObj, thisVar)
{
if (Vars.AGE.IsValid())
{
Forms.Form2.GetFirstResponseGlyph().SetFocus)
}
}
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Figure 12-11
Moving from one form to another
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Move without checking. You can also skip to the next form without first checking the
validity of the response.

function Form1_Question5_SkipFill(thisRespObj, thisVar)

{
Forms.Form2.GetFirstResponseGlyph().SetFocusi)

}
Move directly to a particular question. You can go directly to any question on the next
form.

Forms.Form2.Question4.SetFocus()
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Example: Moving to a New Case on a Different Form

Move to the first question, next case. This rule script moves you from the last question
on Form3 to the first question on Forml for the next case.

function Form3_Question7_SkipFill(thisRespObj, thisVar)
{

Forms.Form1.Question1.SetFocus()

NextCase()
}

Example: Modifying the Visible Property of a Question

Modify the Visible property. Questions have a Visible property that can be set to true or
false. This property isuseful for making invisible any questionsthat are not applicable
for arespondent based on his or her previous responses. The following script checks
the value of the question Gender—if the response is male, the script skips two
guestions pertaining to pregnancy and turns them invisible.

function Form1_Gender_SkipFill(thisRespObj, thisVar)
{
if ((Vars.GENDER.IsLabeled("Male")))
{
Forms.Form1.Pregnan1.Visible = false
Forms.Form1.Pregnan2.Visible = false
Forms.Form1.Workstat.SetFocus()
}
}

Disable a question. You can also hide an inapplicable question by disabling it.

Forms.Form1.Pregnan1.Enabled=false.
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Example: Computing the Value of a Variable with a Rule Script

Compute the value of a variable. You can use rule scriptsto compute new variable values
as data are being entered or checked. The following example checks the validity of
responses on a customer satisfaction survey. This Checking rule computes an overall
customer satisfaction rating by taking the average of three different responses and then
comparing the average to another question that asks, “Were you satisfied with our
service?’ If the satisfaction rating is high—in this case, an average of 8 or more on a
scale of 1 to 10—but the answer to the final satisfaction question is negative, a
checking error is generated.

function checkavg_Check()

{
Vars.SAT_AVG.Value=Sum(Vars.SATRATE1.Value,Vars.SATRATE2.Value)/2
if ((Vars.SAT_AVG.Value >= 8) && (Vars.SATFINAL.IsLabeled("No")))

{

RuleViolation("Customer satisfaction average does not match response. Please check case. ")
}
}

Example: Setting Other Properties with a Rule Script

Thefollowing are examples of how you can use rul e scriptsto modify the properties of
guestions, response controls, and text objects.

Change the back color of a question.
Forms.Form1.Question1.BackColor=Color.Blue

Change the text of a question.
Forms.Form1.Question2.QuestionText1.Text = "Enter your last name."

Change the font of the question text.
Forms.Form1.Question2.QuestionText1.Font = "Courier"

Change the caption of an option button.
Forms.Form1.Question2.0ptionButton1.Caption="College degree"
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Managing Data Files

Thisprogram isdesigned to be used in conjunction with statistical software programs
from SPSS Inc.

® You canread your datafilesin and out of recent versions of SPSS programs at
will, including SPSS-format data files (version 7.5 or later). All of your forms,
guestions, variables, and rules are preserved when you read filesin and out of
these newer programs.

®m |InBuilder, you can open SPSS datafiles (*.sav) saved in earlier versions of SPSS
for Windows, as well asfiles from SPSS for Macintosh or UNIX. However, you
cannot read a datafile back into one of these earlier programs without removing
your forms, questions, and rules. (Use Export Data on the File menu to export your
datain aformat that can be read by SPSSfor Windowsversion 6.1.3 through 7.1.)

m |f you want to open a spreadsheet, ASCII, tab-delimited text, database, or
SPSS/PC+ file, openthefilein SPSS, savethe datain SPSSformat, and then open
itin Builder.

m Filessaved in Builder release 2.0 are not readable in earlier releases.

Files in Builder and Station
Builder. When you start Builder, the software opens anew filewith ablank form. You
begin creating a survey or you can open an existing file using the File menu.

Station. When you start Station, the initial dialog box allows you to choose between
opening alocal file or amaster file. The master files are stored on the network server.
To open alocal file, double-click More Files under Open a Data File.

247
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Figure 13-1
Data Entry Station dialog box
Data Entry Station [ x|
—wWhat would vou like to do?
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o]
Eia LConnect to a maszter file on the Data Entry Server
Exporting Data

Forms, questions, and rules are not preserved in the exported datafile.

To Export Data for Analysis in an Older Version of SPSS

You can read data files into and out of recent versions of SPSS programs at will,
including SPSS-format datafiles (version 7.5 or later). If you want to analyze your data
in an earlier version of SPSS, you can export only your data (cases and variables) into
adatafile that can be read by SPSS version 6.1.3 through 7.1.

» From the menus choose:

File
Export Data...

» Inthe Save Copy Asdiaog box, click the Save as Type drop-down list.
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» Select the .sav file format to save the datain aformat that can be read by SPSS6.1.3
through 7.1.

Forms, questions, and rules are not saved in the exported datafile, since these elements
are not recognized by earlier versions of SPSS.

Opening a File Modified in Another Program

You can read datafilesin and out of recent versions of SPSS programs at will,
including SPSS-format datafiles (version 7.5 or later). You can use Builder to open a
file that has been modified in one of these programs. You will be warned that the file
has been modified outside of Builder, and you will be asked if you would like to see
the modification log. A modification log lists the changes that were made to thefile. If
avariable was deleted from the file, any object bound to the variable is also deleted.

If you open asurvey and receive thiswarning, call your survey administrator if you
are in doubt about how to proceed. Y ou can also refer to the modification log for
information about what was deleted.

Itisalwaysagood ideato make abackup copy of afile before opening it in another
program. If some essential variable is accidentally deleted, you will be able to retain
al of your data.

Tips for Managing Data Files

A fileis composed of two main parts: your form(s) and your data. If you find that you
have created aform that meets your data collection needs but you want the data stored
in different files, you can create copies of the file. For example, if you have afile that
you want to use to collect your data but you want the data kept in separate files
according to month, you can make as many copies of the file as you need and then
collect each month’s data with a different file.
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To Make a Copy of a File

Figure 13-2
Copying a file in the Windows Explorer
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Copies the selected itemz to the Clipboard, Use Paste to put them in the new location, o

Open the Windows Explorer.

Search through the directories until you find the file that you want to copy.

From the menus choose:
Edit

Copy
Edit

Paste

Change the name of your copied file.
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To Save a File without Cases

If you forget to make a copy of your file before entering data, you can save a copy of
your file and then delete the data from the file that you want to reuse. It isagood idea
to make a backup copy of your file before you delete your data.

» Openthefile.

» From the Builder window menus choose:
File
Save As...

» Savethefileunder adifferent name.
» Switch to Table Entry view.

» From the Form window menus choose:
Edit
Select All
» From the Form window menus choose;
Edit
Delete

If you want to merge thefiles at alater time, you can use the ADDFILES utility.

File Properties

File propertiesallow you to accessinformation about your survey and to change certain
settings, including:

®  Automatic saving
Automatic backing up
Entry options
Currency formats
Date formats
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Figure 13-3
File Properties dialog box
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To Change File Properties

» From the Builder window menus choose:

File
File Properties

» Click the tab(s) for the properties that you want to change.

» Change the properties to the desired values.
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General Properties

Figure 13-4
General tab
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Always create a backup copy. Creates a backup copy whenever you open afile. The
backup copy is not updated as you add datato your file. The copy is given the same
name as your file, with a.bak extension. If for some reason you want the original data
back, you can open the .bak file. Backupsare stored in the current directory and remain
there until removed or overwritten.

Automatic backup. Automatically saves a copy of your file at a specified interval. For
example, if you enter three new cases and change the name of your file, acopy of your
file containing the new cases and with the new namewill be saved at the specified time
interval. When you close the program, the autosave file will be removed. The autosave
file appearsin your directory only if the program terminated abnormally.

Save file when moving from Design to Entry. Saves the file automatically when you
switch from Design to Entry view.

New cases can be entered. Controlswhether you caninsert or append new casesto your
file. Deselect this option to suppress the addition of new cases (for example, if you
want to preserve your file and ensure that no data will be added).
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Existing cases can be deleted. Controls whether a case can be deleted during entry
mode. Deselect this option to prevent the deletion of cases.

Initial form. Theinitial form istheform first opened when thefileis opened for an entry
session. You can specify which form you want to act as the initial form.

Currency Formats

Figure 13-5
Currency tab
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You can define up to five custom currency display formats that can include special
prefix and suffix characters and special treatment for negative values.

Thefive custom currency format namesare CCA, CCB, CCC, CCD, and CCE. You
cannot change the name of a currency format.

To define a custom currency format:
» From the Builder window menus choose:

File
File Properties
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» Click the Currency tab.
» Select one of the currency formats from thelist (CCA, CCB, CCC, CCD, or CCE).

» Enter the prefix, suffix, and decimal indicator values.

Date Formats

Figure 13-6
Dates tab
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Set Century Range for 2-Digit Years. Definesthe range of yearsfor date-format variables
entered and/or displayed with atwo-digit year (for example, 10/28/86, 29-OCT-87).
The automatic range setting is based on the current year, beginning 69 years prior to
and ending 30 years after the current year (adding the current year makes atotal range
of 100 years). For a custom range, the ending year is automatically determined based
on the value you enter for the beginning year.
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Entering Data

You can enter datain Form Entry view or Table Entry view.

Form Entry view. You enter the data by selecting or typing in the controls provided on
the form. The form collects the data and stores it in your file. You can use the
keyboard, mouse, or Navigation toolbar to move through the controls on your form.
You can print your datawhile in Form Entry view, but the controls of your form are
printed for each case.

Table Entry view. You enter the datainto atable that resembles a spreadsheet, with each
column representing aquestion and each row representing acase. In Table Entry view,
you enter and move through data in essentially the same way asin Form Entry view,
only the appearance and speed of entry differ. Printing from Table Entry view gives
you a spreadsheet-like view of your data. Table Entry view allows you to view and
print multiple cases.
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To Enter Data in Form Entry View

Figure 14-1
Form in Form Entry view
&/ Online Entry Form - (O] x|
File Edit Yiew Data RBules Help
TIKIE > il @] ] 5]
Customer Satisfaction Survey ~
Praduct (select all that apply) Would you recommend this product?
O Yes
O Copier QO Mo
How would you rate your overall Did the product ever fail to operate?
satisfaction with this product? O Yes
O Very satisfied O Mo Ifno plegse skip to e next section
QO Somewhat satisfied
O Somewhat dissatisfied Did you contact us to fix the problem?
O Very Dissatisfied QO Yes
QO Mo Answer O Mo
a| | 3
Ready [3/2 FiSkip&Fi On  [Auto Check: On P

» From the Form window menus choose;
View
Form Entry

» Enter datainto the response controls by typing or clicking on option buttons or list box
selections.

» Pressthe Tab key to move between questions or to move from the last question to a
new case.

» Pressthe arrow keys to move between option buttons or to move within a drop-down
list.

» Use the space bar to select check boxes.

» Usethe space bar or the mouse to deselect a selected check box.
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» Use Shift-Tab to move back to the previous question.

» Usethe checking facility to examine your data for errors.

To Enter Data in Table Entry View

Figure 14-2
Form in Table Entry view

&/ Online Entry Form [ _ (O] |

Fil= Edit “iew Data Bulez Help
L3 =]

=8| S| flsl@| of| 2H]

M| ][ M| | £l
Tax

copier satisf Tail contfail | recommd birth -
1 Mo Yes Wery satizfied Mo Yes
2 Mol es Somewhat satisfied es i [n] e 1961
3 Mo Yes Wery satizfied Mo Yes 1965
4 Yes Yes Somewhat satisfied es Mo Mo 1951
a3 es Mol Somewhat dissatisfied [ills] Mol 1934
5] s} Yes Wery satizfied iy Yes 1549
7 ~|
1«] | *

[7/7 RiSkip&Fil On  [AutoCheck: On  [Enty 7

» From the Form window menus choose:

View
Table Entry

» Enter the datainto the cells and press the space bar; then, use the arrow keys to look
through the options, and use the Enter key to enter information.

» Click on acell to select the cell. Click on the row number to select the entire case.
» Drag the separator bar to make columns wider.
» Press Tab or the arrow keys to move between cells.

» Usethe checking facility to examine your data for errors.
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Tip: If you accidentally hide a column in Table Entry view by resizing it so that it
disappears, you can double-click on the column separation bar to make the column
reappear.

To Enter Values in Table Entry View

You can enter the value of aresponseitem in Table Entry view, instead of selecting the
response item in the cell.

» From the Form window menus choose;
View
Table Entry
» From the Form window menus choose;
Data
Display Response Items

» Make surethat Display Response Items does not have a check mark by it.

» Enter data by using the values for response items.

To Turn on AutoTah

In Table Entry view, AutoTab automatically moves you to the next question after a
specified number of characters have been entered. AutoTab works on text box cells.

» From the Form window menus choose;
View
Table Entry
» From the Form window menus choose;

Data
AutoTab
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To Use the Navigation Toolbar

Figure 14-3
Navigation toolbar

1 «]p AL

» Usethe Arrow toolsto move through your cases or to add a new case.

» UsetheFirst Case and Last Case buttons to go to the first or last case.

» Enter anumber into the box to go to a specific case number.

» Usethe Next Case with Error button to go to the next case with an error.

» Usethe Override Error tool to override an error if the rules of your file alow it.

» If you are entering data into a master file, you can use the Send Case button to send a
caseto the network server.

» Use Toolbars on the View menu to hide and display the Navigation toolbar.

Overriding Errors

There may be instances where you receive arule violation error and need to override
the error. For example, you may have entered the respondent’s answer to aquestion, or
you may have to commit the case before it is complete. Depending on the design of
your file, you may be able to override the error and move on to the next question or
case. For more information on checking and rules, see Chapter 15.
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Keyboard Shortcuts for Entering Data

Tab

Enter
Shift-Tab
Arrow keys
Ctrl-T
Ctrl-E

F8
Shift-F8
Space bar
Page Up
Page Down

Alt-Home

Alt-End
Ctrl-Page Up
Ctrl-Page Down

Ctrl-Alt-Page Up
Ctrl-Alt-Page Down

Move to the next question.

Move to the next question.

Move to the previous question.

Move through the option buttons.
Switch to Table Entry view.

Switch to Form Entry view.

Copy the value from the previous case.
Copy al values from the previous case.
Select check boxes.

Move to first question on prior page.
Move to first question on next page.

Move to the first question on this page. If you have text selected for
editing, move to the first character in the selected text.

Move to the last question on this page. If you have text selected for
editing, move to the last character in the selected text.

Move to the current question on the previous case.

Move to the current question on the next case. If there is no next case,
the current case is committed and anew caseis created.

Moveto the first question on the first case.
Move to the last question on the last case.

Using Cut, Copy, and Paste

You can use Cut, Copy, and Paste on the Edit menu to enter datainto your file. You can
cut, copy, or paste from Form Entry view or from Table Entry view. Cut removes the
selected value from your file and copies the value to the clipboard. Copy copiesthe
selected value to the clipboard. Paste copies the contents of the clipboard, in whole or
part depending on the situation, to the variable bound to the sel ected question. You can
cut, copy, and paste data both inside and outside of your file. You can copy:

m A singlevalue.

A case.

|
m  The previous case or one of its values.
|

A value from an outside source, including text or binary interchange format (BIF),
which isthe format used in spreadsheets. If you have selected more than one
spreadsheet cell, only the first value is copied into your question’s variable.
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To Copy and Paste Values
» Select the text that you want to copy.
» From the Form window menus choose:

Edit
Copy

» Click inthe area where you want the text to appear.
» From the Form window menus choose:

Edit
Paste

To Cut a Value
» Select the value that you want to cut.
» From the Form window menus choose:
Edit
Cut
To Copy and Paste a Case
You can copy and paste cases in either Form Entry view or Table Entry view. The

method of selecting acase differsin the two views. Copying and pasting casesisfaster
in Table Entry view.

Table Entry View

» Select the case that you want to copy.

» From the Form window menus choose:

Edit
Copy
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» Select the case you want to paste into. Y ou can paste into a blank case or a case with
values.

» From the Form window menus choose;

Edit
Paste

Form Entry View

» Display the case that you want to copy.

» From the Form window menus choose;
Edit
Select Case
» From the Form window menus choose;
Edit
Copy

» Display the case you want to pasteinto. Y ou can paste into ablank case or acase with
values.

» From the Form window menus choose;

Edit
Paste

To Paste Data from the Previous Case
» Select the question in the current case you want to copy the value into.
» From the Form window menus choose;

Edit
Copy Value from Previous Case

If you want to copy all valuesinto the current case, you can press Shift-F8.
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To Insert a Case between Existing Cases

» Select any question in the case before which you want the new case to appear.

» From the Form window menus choose:

Data
Insert Case
Before Current (After Current, At End)

To Delete a Case

» From the Form window menus choose:
Edit
Delete Case
Deleting a case leaves you on the case immediately preceding the case that was just
deleted.

Tip: You can also delete casesin Table Entry view. Thisisespecially useful for deleting
arange of cases or deleting al cases.

Committing versus Saving Cases

Committing a case validates the case and enters it into memory. You can actively
commit a case by using the Commit Case command on the Data menu, by using the
Navigation toolbar, or by pressing the Tab key on the last question in a case. Cases are
also committed when you move from one case to another, save your data, open a
different file, add anew case, or trigger a Skip & Fill rule.

Even when you have committed a case, you must still save your datafile. Saving
records more information than just your data, including information such as window
sizeand location. Y ou must saveyour file before you exit the session. Thereisno undo
for committing a case. For more information, see Chapter 15.
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To Commit a Case Manually

» From the Form window menus choose;

Data
Commit Case

» The caseisnow validated and entered into memory.

» You will need to save the file upon exiting. It is also a good ideato save your file
regularly to protect against data loss.

Continuing Where You Left Off

If, for some reason, you need to stop entering data and continue at a later time, your
best option isto finish entering the data for your current case, save your file, and exit
the program. However, if it is necessary for you to stop in the middle of a case, you
may be able to commit the case, save what you have already entered, exit the program,
and, at alater time, continue where you left off.

Whether you are able to do this depends on the rules specified for your file. If there
arerulesin your file that prohibit you from continuing to the next case until you have
entered datain the current case, you will haveto finish entering the datafor the current
case. For example, a Checking rule may be defined that prevents an incomplete case
from being committed.

For afilewithout rules requiring answersto all questions, you can commit your
incomplete case and save your file. When you open your file next time, your
incomplete caseis the current case. Y ou can tab to where you left off and resume
entering data.
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Using Find and Replace

Figure 14-4
Find and Replace dialog box

Replace : Questionl Forml EHE

Find what: | Eiridlhfezt |
Replace with: I Heplase |
Feplaredl |

Caticel
¥ Match case 4|

Find and Replace finds all instances of a response stored within your file's variables
and changes them. You can use Find and Replace to locate a string, anumber value, or
adate. The search continues through your file and wraps around to the beginning.

When searching for anumber, the search is not case-sensitive, and amatch is made
only for the entire value. For example, if you enter 30,000 while searching a question
that represents a variable for wages, a match happens only for that exact number.
Numbers such as 130,000 would not match.

A string search could consist of |etters, numbers, and punctuation or only letters. For
example, asearch for John in a name box and JL-1002-88-2321 in adriver's license
number box are both string searches. Y ou have the option of case-sensitive string
searches.

When searching for dates, you have multiple options for the format of the date. For
example, the program will accept 5/30/97 or 5-30-97 or May 30, 97. Date searches are
not case-sensitive.

Y ou can also search for blanks and system-missing data.

Find and Replace can be auseful tool for fixing typing or low-level entry errors. For
instance, if you entered abbreviations for “Drive” and “ Street” in addresses and then
had to put in the full words, you could use Find and Replace to complete the task
quickly.
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To Find and Replace a Value
» Select thefield in which you want to locate the item.

» From the Form window menus choose;
Edit
Replace...

» Enter the value that you want to find and the value that will replaceit.

Printing in Form Entry View

Printing your datain Form Entry view printsthe form controlsaswell asdata. Only the
current case is printed in Form Entry view. If you want to print all of your cases, you
can print the file from Table Entry view.

Page Setup allows you to specify several properties of the printed form, such asthe
paper size and source, the orientation of the page, and the margins.

To Print a Form

» Switch to Form Entry view.

» To preview your form, from the Form window menus choose:
File
Print Preview
» To print your form, from the Form window menus choose:

File
Print...

Tips
m |f youwant to usetheform asaprinted questionnaire, you can either print from the

Form Entry view before you enter cases or add anew case and then print the empty
case.

m |n cases where adefault value has been changed or Skip & Fill rules have been
activated, a case may not print out blank.
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To Print All Cases in Table Entry View

» From the Form window menus choose;
View
Table Entry
» From the Form window menus choose:

File
Print...

To Specify Page Size and Orientation
» From the Form window menus choose:
File
Print...

» InthePrint dialog box, specify page size and orientation.
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Use the Rules menu to check your datafor rule violations. The rules are created and
saved by the survey designer. You can check asingle case or an entire file. Checking
by case allows you to examine a case quickly and correct it easily at any time during
the entry process. Checking an entire file gives you a detailed report of all of therule
violationsin thefile. If you need to find and correct arule violation, check by case. If
you need a detailed report of the state of al of your data, check by file.

To Check a File

» From the Form window menu choose:

Rules
Check File

» Select either By Cases or By Rules.
» To correct errors, display the case with the error.
» Tab to the question with the error and correct it.
Tips
m If youwant to easily view and correct rule violations, select the report by cases. If

you are interested in evaluating the effectiveness of your rules, select the report
by rules.

® You can open an existing data file and check it for errors.
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Checking Report by Case

Figure 15-1
Checking report by case
&4 Checking Report _ (O] x|
File Edit Help
S(@|8| |ole| o

11-17-97 5:37:41 FY ;I
Caze 1

Validation rule BIRTH wiclated

Case 2
Validation rule BIRTH wiclated

Casze &
Validation rule BIRTH wiclated

Ready |

KN

Thefirst two lines of the report list the name of the file and the date and time the report
was run. The report then lists the case number for each case with rule violations. The
name of the violated ruleislisted on a separate line below the case number.

If you want to view a case listed in the report or make changes to it, you can open

the case in your form and make your changes. The changes are reflected in the report
when you run a new Checking report.

Checking Report by Rule

Figure 15-2
Checking report by rule

i Checking Report =]
File Edt Help

=S|@|s| 5| o

cust=at  =av
11,1797 5:39:13 M
EIRTH

1. 2. &

Fieady
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Thefirst two lines of the report list the name of thefile and the date and time the report
was run. The report then lists the name of each rule that was violated. Below the rule
nameisalist of all of the casesthat violate the rule.

To Save the Checking Report

You can save a Checking report for later use or for administrative purposes. Reports
are saved inrich text format (.rtf).

» From the Checking Report window menus choose:

File
Save
To Check a Case
Figure 15-3
Checking Report window for a single case
Caze: B
\Validation rule BIRTH wiclated ;I

I

Mest Caze with Errar |

» From the Form window menus choose:

Rules
Check Case

» If youwant to keep arecord of the errorsyou find, the most efficient way istoruna
Checking report by case. However, you can copy theruleviolationsin the Checking Report
window by selecting the text and pressing Ctrl-C and then pasting it into atext file.

» Click Next Case with Error to see the report for the next case containing rule violations.
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Minimizing Errors with
Double Entry and Compare Versions

If you have datathat require accurate entry, you can use Checking and Validation rules
to uncover many errors. However, rules cannot uncover all errors. Typos, incorrect
data, and skipped cases can still escape detection. The Double Entry and Compare
Versions facilities can give you another way to verify the accuracy of your data.

With Double Entry, you specify which variables you want to have verified. After
auser enters datainto thefile, a second user opens thefile in Double Entry mode and
enters just the variables specified as double entry variables. When differences are
found, the user isimmediately notified and is able to correct the discrepancy on the
spot.

With Compare Versions, you can compare two versions (entered by different
people) of the same file to minimize the possibility of errors. Onefile acts as the
verification file and the other file is compared against the verification file. Thefiles
are checked for case, variable, and value consistency. Discrepancies are recorded in
the comparison log file, which you can use to correct the data.

Designing a File for Double Entry
When you create your form and define your variables, you can specify which

variables you want to have double entered by setting the Entry property of the
variable.
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Figure 16-1
Variable Properties dialog box
General I Formatl \r"aluesl Mizzing \r"aluesl Walid Valuesl
Yarniable name: IW Alias: l—
Y ariable label; IHow would you rate your overall satisfaction with this pro
Question test: [ Link with variable label
4. How would you rate your overall satisfaction with this product? ;I
[
Default value: IU j
Entry Type: IDoubIe Enter j
LComments;
Cloge | Help |

There are three possible designations for the Double Entry property:

Double Enter. Allows the entry of a second value when in Double Entry mode. Thisis
the default.

Edit. Allows anyone to change the values of variables during normal entry or double
entry.

Protected. Prevents any entry for variablesin all entry modes. Protected variables can
only befilled by rules (for example, an ID field that is incremented with each new
case).

You cannot set the Entry property viaarule.

You can open your existing .sav files and al the variables are ready for double entry.
You can change the Double Entry state for variables you don’t want to have double
entered. If thefile already has datain it, you can double enter that data.

Tip: Double Entry is not appropriate for long, open-ended text questions.
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Double Entering Data

After theinitial data entry is complete, you can double enter the file in either Form or
Table Entry view. You access the Double Entry mode via the Data menu. In Double
Entry mode, you are moved automatically between the variables whose Entry
properties are set to Double Entry.

Figure 16-2
Double Entry dialog box

Double Entry
Incongistent entry detected, please select one:

Firzt ety € 1-3 times a week

Second enty: o 45

Ok, I Cancel

When adifference in the data is found, you must select the correct response from the
Double Entry dialog box. Any rules attached to the variable will fire after the
correction.

To Double Enter a File

To double enter the datain afile:
» Create afile with variables designated for double entry.
» Have someone enter data into thefile.

» Whentheinitia entry iscompleted, ask another user to open thefilein either Form or
Table Entry view.

» From the Form menu choose:

Data
Double Entry

» Enter datainto thefile.
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» When differences occur, select the correct response from the Double Entry dialog box.

» Or, click Cancel to enter adifferent response.

Using Compare Versions

At the beginning of the entry process, you should create two copies of thefile and have
two different people enter the datainto the files. When the data entry is compl ete, open
the file whose datayou want to save permanently. Thisisthe activefile, which you can
edit to correct any discrepancies found by the comparison. You can use Compare
Versions only in Form Entry or Table Entry view.

Figure 16-3

Compare Entry Files dialog box

Compare Entry Files

Lompare active file to venfication file: akK

IE:\may_dee.sav Browse... |
Cancel

¥ Match cases by Case 1D variable:

i,

Help

MHame | Label | Format | File Order | -
@ SATISF Owerall Satiz... F2.0 1

#» RECOMMD Recommen... F2.0 2

> aUasL Overall Qualy  F4.0 3

@ USE Frequencpo.. F2.0 4

@ FAIL Product Op...  F2.0 5 -
@ COMTFAIL  Contact Bec... F2.0 3

4> PROBME... Espectations F2.0 7

4 SHOM Department ... F2.0 8

> SHOPZ Dffice Produ...  F2.0 | hd|

¥ Sort active file by Case 1D variable

Verification file. Specify the name of the file you want to compare to the activefile.

Match cases by Case ID variable. This ensures that cases are matched when comparing
files. If youdon't haveacase D, your fileis compared sequentialy. If filesdo not have
an equal number of cases, the comparison stops when the shorter file has run out of
cases. You can use the case ID variable to compare a subset of the cases. For example,
if you specify acase ID variable, you can have someone randomly enter 20 selected
cases to compare with afile of 1000 cases.
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Sort active file by Case ID variable. Sorting is required for a comparison keyed by the
case ID variable. Thisoption indicateswhether acopy of the activefileis sorted on the
case | D for comparison. If you select this option, the active file is permanently sorted.
If you do not, atemporary copy of thefileis sorted for the comparison. If current case
order is not important to you, select this option—it is faster and uses less disk space.
Thefileisnot sorted if acase ID variable is not specified.

To Compare Versions

>

>

Create two copies of the file without cases.

Have someone enter the datainto one of thefiles.
Have someone el se enter the data into the other file.
Open the file that you want to use as the activefile.
Switch to Table Entry or Form Entry view.

From the Builder window menus choose:

File
Compare Versions...

Enter the name of the file that you want to use as the verification file.

If you have a case ID and you want to use it in the comparison, select Match cases by
Case ID variable.

If you are using acase | D variable and you don’t mind the file being permanently
sorted by the case ID variable, select Sort active file by Case ID variable.

When the comparison iscomplete, check the comparison log for the differencesin your data

For each difference, decide which entry is correct. If the active fileis correct, do
nothing. If the verification fileis correct, edit the activefileto match the verificationfile.
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Using the Comparison Log

Figure 16-4
Compare Files log

&4 Compare Files H=] 3
File Edt Heln

={8(a] [4=e] o

Active file: C:wmay_data. =av
Verification file: C:~may_dble. sav
11-21-97 7:42:01 PH

Warning: Value mismatch for Casz= ID = 1.
Yariable Aotive Verification
SATISF

Warning: The active file does not contain a matching case with the
Case ID of 1.

Warning: Value mismatch for Casze ID = 2.

Yariable Aotive Verification

EIRTH 1656

Warning: Value mismnatch for Casze ID = 2.

Yariable Active Verification

COHTFAIL 2

Warning: The active file contains fewer cases than the verification
file.
Ready [ T 4

The comparison log shows you the warnings and errors that were generated as a result
of the file comparison. You can save and print the comparison log. Following are the
basic types of mismatches and errors:

m Variable mismatch. Reports variables missing from the verification file, variables
missing from the active file, and whether there are no common variables to
compare.

®m Value mismatch. Reports by case with the caseidentified by the case number within
an activefile. If the case ID is specified, it is used instead of the case number.

m Case mismatch. If the key variable is used, reports whether cases are missing in a
file. The report stops when it runs out of casesin either file.

For each difference, decide which entry is correct. If the active fileis correct, do
nothing. If the verification fileis correct, edit the active fileto match the verification file.
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Merging Data Files

with ADDFILES

ADDFILES is astand-alone utility that allows you to merge data from several files.
ADDFILES reads atext file of commands and uses the parameters as a guide to
concatenate the files. Cases are added one after the other. The files are added in the
order in which they are given in the commands. You could use ADDFILES in the
following instances:

m  Youcreatefive copiesof afileand havefive different clerks entering datainto the
files. At the end of the study, the five files are returned to you. Y ou can use
ADDFILES to combine the five files into one new file.

m  You havefive copiesof afileand five different clerks entering datainto the files.
At the end of each day, each clerk savesthefile under anew name and givesit to
you. Y ou can merge the files into one new file with ADDFILES each day. If the
clerks use the same new filename each day, you can usethe same syntax file every
time you run ADDFILES.

® You can use ADDFILES to do spot analysis on the data entered. Y ou can get copies
of thedatafilesfrom your clerk and use ADDFILES to combinethefilesinto anew
file for analysis.

Run ADDFILES at the DOS prompt. Running ADDFILES requires a plain text file of
ADDFILES commands, which is named as a command line argument. ADDFILES
produces alog file; everything in the log file except the commandsis printed as a
comment, so if you accidentally delete your file of commands, you can run ADDFILES
using thelog file.

Y ou can also mergefilesinyour statistical analysis program from SPSSInc. If you
need to reorder cases, you can do so by opening the file in your statistical analysis
program.
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ADDFILES isinstalled as part of the custom installation. If you do not currently have
ADDFILES installed on your computer, rerun the setup program and choose the custom
installation.

To Merge Data Files

Imagine the following scenario: You want to collect al of your sales data for the year
into an overal file, sales98.sav. You have salesdatafor thefirst two months of the year,
jansales.sav and febsales.sav. Thisisthefirst time you are merging the files, so you
will not use the MASTER subcommand. You will use the SAVE subcommand, which
will create the sales98.sav file.

» Open Notepad or asimilar text editor.

Figure 17-1
Syntax file in Notepad

Bl =yntax. txt - Notepad [_ O] x|
File Edit Search Help

ADD =]
FILES = "jansales.sav' "febsales.sav"/
SAVE = "sales%8.sav"/

SOURCEVAR = sal. -
q ol

» Onthefirst line, type ADD.

» TypeFILES = "jansales.sav" "febsales.sav"/ (names of the data files you want to
merge).

> Type SAVE = "sales98.sav"/ (name of the product of the merge).

» Type SOURCEVAR = sal. (rootname of the variablethat will tell which fileavariable
came from).

» Savethe syntax file as syntax.txt.
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Figure 17-2
Running ADDFILES in DOS

ME Command Prompt H=] E3

Microsoft(R> Windows NI{TM>
(C>» Copyright 1985-1996 Microsoft Corp.

C:v>cd Program Filess Data Entry

C:“Program Files- Data Entryraddfiles /s syntax.txt
Log syntax.L0G created.

Iidclf:i.les ended normally.
C:sProgram Filess Data Entry>

» At the DOS prompt, type ADDFILES /s syntax.txt.

Tips
m  To get usage help on using ADDFILES, type ADDFILES /? at the DOS prompt.

m |f you omit the optional commands, such as MASTER, make surethat your last line
in the syntax file ends with aperiod (.); otherwise, use aslash (/).

ADDFILES Command Syntax

ADD

MASTER [=] "filename"/

FILES [=] "filename" "filename" .../
[SAVE [=] "filename"]
[SOURCEVAR [=] rootname].

MASTER. You use amaster file for collection purposes and for dictionary information
differences should they arise. When you specify amaster file, thefilesyou are merging
are added to the end of the master file. The MASTER subcommand is optional. When
you are merging filesfor thefirst time, you do not use the subcommand. You can either
specify thefina file in the SAVE subcommand or use one of the files you are merging
asthefinal file. For example, you are merging jansales.sav and febsal es.sav. You want
to save thefiles to sales98.sav, which will contain al of your salesinformation for a
year. The first time you merge your files, you do not use the MASTER subcommand.
You usethe SAVE subcommand and specify sales98.sav. The next timeyou mergefiles,
you will usethe MASTER subcommand and will specify sales98.sav asthe master file.
In the subsequent merge, you will not use the SAVE subcommand.
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FILES. Specifies the files that you want to merge. If you are not using the MASTER
subcommand, be sure the file whose dictionary information you want to use is
specified first. If you are not using the SAVE subcommand, be sure the file that you
want your files saved to is specified first.

SAVE. Namesthefina file. Thiscommand isoptional. If you do not specify asavefile,
thefinal fileinformation is saved to the master file. If you do not specify asavefileand
do not have amaster file, thefirst file specified in the FILES subcommand is used.

SOURCEVAR. This command is optional. The source variable allows you to know the
origin of every case in your merged file. You specify arootname for your output
variables. Therootname cannot result in avariable name greater then 8 characters. The
numbering system starts with 1 and leading zeros are used to create an 8-character
name. For example, if you use march as your source variable and are merging three
files, you create the variables march001, march002, and march003. The value of the
source variableis 1 if the case came from the file and O if it did not. You will have a
source variable for each file, and the final file should contain the same number of
source variables as the number of files merged.

ADDFILES Log

ADDFILES produces aplain text log file of its actions during the course of afile merge.
The log file can show you what went wrong with an incomplete merge. Since the
commands that ADDFILES executed are written to the log in the proper syntax format
and the other itemsin the log are written as comments, you can use alog file asthe
syntax command file the next time you run ADDFILES. If you often merge the same
files, you can use the log file from your first successful merge as your syntax filein
subsequent merges.

Figure 17-3
ADDFILES log file

ﬁ syntax.L0OG - Notepad M= E
File Edit Search Help

ApD -
FILES = "jansales.sav" "febsales.sav" /

SAVE = “sales98._sav™ /

SOURCEVAR = sal .

* Reading file jansales.sau which has 80 cases.

* Source variable sal@8881 has been created.

* Reading file febsales.sav which has 117 cases.

* File sales98.s5av has been saved with 197 cases.

* End of file merging. -

El 2
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Introduction to Data Entry
Enterprise Server

The appendices describe the SPSS Data Entry Enterprise Server, whichisacollection
of softwarethat providestoolsto allow teamsat your site to gather datafrom surveys.
It supports all stages of the process—from survey design through data collection and
storage. The Data Entry Enterprise Server allows multiple users to connect and add
data simultaneously.

The Data Entry Enterprise Server consists of two separate server components:. the
Data Entry Network Server and the Data Entry Web Server. The Data Entry
Network Server receives survey casesfrom clients' personal computers running Data
Entry Builder, Data Entry Station, or Web browsers. The Data Entry Web Server
allows end users to respond to your surveys from Web browsers.
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Figure A-1
Overview of steps to conduct a survey with Data Entry Enterprise Server

Data Entry Builder SPSS statistical software

3 2. Deploy v

— —
- >
e ™
[ 0
1000000 gooooon

Data Entry Web Server Data Entry Network Server

| connect to

master file

"ML form

Web browser

—
——
JE

HTM forms paper surveys

Data Entry Station

» Design. Use Data Entry Builder to design the survey questions, valid responses, and
forms.

» Deploy. Use Data Entry Builder to register the master file for the survey on Network
Server, which deploys the survey for users of Data Entry Station and enables data
collection viathe Web. Optionally, export the Survey asHTML and copy it to the
publish directory of Data Entry Web Server, which deploys the survey on the Web.

» Collect data. Use Data Entry Station to connect to Data Entry Network Server, obtain
acopy of the master survey file, and enter responses from paper forms. Optionally,
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distribute the URL to the Web survey. Responses are automatically sent from Data
Entry Web Server to Data Entry Network Server. The response data are stored in the
master file by Data Entry Network Server.

» Clean data. Get the data from Data Entry Network Server and use Data Entry Builder
to clean the data.

» Analyze the cleaned data. Save the clean data with Data Entry Builder and openitin
SPSS dtatistical analysis software.

Software Components

The full suite of Data Entry Enterprise products includes the following software
components:

Builder. Data Entry Builder alows the survey administrator to design surveys. Survey
data can a so be sent from Builder using the Design or Table view. Builder istypicaly
installed on the survey designer's personal computer.

Station. Data Entry Station supports a subset of Builder features. Station allows data
entry clerksto enter data from completed surveys. Station istypically installed on the
dataentry clerks persona computers. The use of Station is optional.

Network Server. Data Entry Network Server allows survey analysts and administrators
to register surveys and extensions. It also has an Administrator utility that supports
some configuration of Data Entry Enterprise Server. Once a survey is registered, the
Network Server receives cases as they are sent from Station (or Builder) and,
optionally, a respondent’s Web browser. The Network Server istypicaly installed on
an analytic server (aserver that is used to run analytic applications).

Web Server. Data Entry Web Server, runs within Orion application server to deploy
surveysasHTML formsto aWeb browser, collect responses, and send responsesto the
Network Server. The Web Server is an optional part of the Data Entry Enterprise
Server. The Web Server istypically installed on an HTTP server; however, it can be
installed on the same computer as the Network Server. The use of Data Entry Web
Server is optional.

Analysis software from SPSS. Statistical software products from SPSS Inc. alow the
survey analyst to do further analysis of the survey responses after they are collected.
The use of SPSS analysis softwareis optional.



288

Appendix A

Appendix Overview

The appendices that follow describe how to perform the following tasks:
m Designing afile for use as amaster file

m  Sending datato the network server

m Creating and deploying a Web survey



Appendix

Designing a File for Use As
a Master File

Thisappendix exploresissuesrelating to filesthat you want to register as master files,
including:

Making decisions about when rules are to be activated
Creating arule that will track which user entered each case
Registering a master file

Editing a master file

Double-entry and master files

Master Files and Rules Activation

When you design afile that you will use as amaster file, you should make a decision
about who will be responsible for cleaning the data. By setting the rules options, you
can either require users to enter data that pass your Checking rules or allow them to
override Checking rule errors, which would leave you to clean the datalater. Thinking
about this distinction before you register the master file may eliminate the need to
change the rules options in the master file later.
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Figure B-1
Rules Options dialog box

Rules Dptions I

—%alidation and Checking Rule Properties g |
— Data Checking
¥ Data are checked automatically Canes! |

¥ Data are checked when filed by a e Help

—&ction for [nvalid Mew Data

v &llow an overide for new entries

W allow new cazes with checking rule violations to be saved

— Skip & Fill Properties
¥ Test Skip & Fill rules:
= when a question lozes focus

™ Upon tabbing from a field

If you want the users to clean the data, make sure that Data are checked automatically iS
selected and that Allow an override for new entries is deselected. If you want to clean the
dataat alater time, make sure that Data are checked automatically is deselected and that
Allow an override for new entries is selected. When the survey is completed, you can run
achecking report and clean the data.

Tracking Cases

You can use the following Checking rule to track who entered each case and at what
time the case was committed. A caseis committed either when it is sent or when the
user moves to the next case. To use this rule, you must create in your file two
additional variablesto store the user ID and the time. Both of these variables should
be strings. In this example, the variables are named USERID and DATE. The
Checking rule is named Track.
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function Track_Check()

{

Vars.USERID.Value = UserID
x =new Date ()

y = x.toLocaleString ()
Vars.DATE.Value =y

}

To Create the Checking Rule to Track Cases

>

Create two string variables, USERID and DATE, to hold your information.

For more information on creating variables, see Chapter 7.

From the Builder window menus choose:

Insert
Rule...

Select Checking asthe rule type, enter aname, and click OK.

In the Rule Script window, enter the following:

Vars.USERID.Value = UserlD
x =new Date ()
y = x.toLocaleString ()

Vars.DATE.Value = y

Close the Rule Script window.

From the Builder window menus choose:

View
Rules

Your rule appears in the Builder window.
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Registering a Master File

When you have a survey file that you want users to access using Data Entry Network
Server, you must register it asamaster file. A master fileison the server and open to
users. When users accessamaster file, they are actually making acopy of thefile. Each
user enters datainto the copy of the file and sends cases back to the server.

To register amaster file, the following conditions must be met:

m Thefile must be adataentry file, created in Data Entry Builder, release 1.0.4 or
later. If the file was created in a previous release of Builder, you can openitin
release 1.0.4 of Builder and saveit. If you open thefilein SPSS, you must open it
in release 1.0.4 of Builder and save it before registering it.

Note: Files saved in Builder release 2.0 are not readable in earlier releases.

m |f thefileisstored anywhere other than on the server system, you must map adrive
to that system.

® You must have physical access to the server to register a master file.
Registering a master file is discussed in Appendix A.

When afileisregistered, it isopen to users of both Builder and Station, who can enter
and send cases to the server. The cases are stored in the master file. Users cannot view
the cases on (or make changes directly to) the master file, sincethe server locksthefiles
for its own use.

To Map a Drive

The directory containing the file must be shared. To share the directory:
Open an Explorer window on the system on which the file is stored.
Right-click on the directory and select Properties from the context menu.
In the Properties dialog box, click the Sharing tab and select Share As.
To map adrive to the shared directory:

On the server, right-click on the My Computer icon.



293

Designing a File for Use As a Master File

» Select Map Network Drive from the context menu.
» Choose adrive letter for the network drive.
» Select the appropriate computer and directory from the Shared Directories list.

» Make sure that Reconnect at Logon is selected. If the drive does not automatically
connect, thiswill cause problems for users who want to connect to the file.

Editing a Master File

If you need to make changes to the master file: unregister it, make the changes using
Builder, and then reregister the file. Like registering, unregistering a master file
requires physical accessto the server.

If users have connected to the master file and sent casesto it, you should notify them
that you are making changes to the file. Once the master fileis changed and
reregistered, they will not be able to send cases back to the server viathefile they
originaly connected to and saved locally. They must reconnect and get a copy of the
new master file. If the users have saved casesin the locd files, they cannot send those
cases back to the master fileif it has been modified since they originally connected to
it. Theloca files, however, can be merged with the master file using the ADDFILES
utility.

Note: There isalimitation to using ADDFILES to add cases to the master file. To use
ADDFILES, you must unregister the master file. When you are finished using
ADDFILES, you must open thefilein release 1.0.4 or later of Builder and resave it
before you can register it as amaster file. The best course of action isto wait until the
end of the data collection process to use ADDFILES.

If you decide it is necessary to make changes to the master file, following these steps
should provide a smooth transition:

m  Establish atime period during which you will change the master file.

m Inform the users of thistime period and encourage them to send their cases to the
server before the master file arrives.

m  After the new master fileisregistered, allow the usersto connect to the new master
file.

For more information on ADDFILES, see Chapter 17.
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Double-Entry Verification and Master Files

The Network Server is designed only to receive data; it cannot send data to Builder or
Station. If you want to perform double-entry verification on a master file, you must
follow this procedure:

Create afile with variables designated for double entry.

Register the file as a master file on the Network Server.

Ask auser to connect to the master file on the Network Server.

When the user finishes entering the data, he or she sendsall of the casesto the Network
Server.

Unregister the master file and make a copy of it.

Delete al of the cases from the copy of thefile.

Register the copy of the file as a master file on the Network Server.

Give the copy of thefile to a second user.

The second user opens the file locally and switches to double-entry mode.

The second user enters datainto the file and all variables designated for double entry
are verified.

When the second user has finished entering the data, he or she sends all of the casesto
the Network Server.

Y ou have now verified datain the master file.
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Sending Data to the
Network Server

This appendix explores:

m  Connecting to the network server using Builder and Station
m  Sending datato the network server

m Deding with send failures

Connecting to the Server

You can connect to the Data Entry Network Server using either Builder or Station.
When you start Station, the initial dialog box allows you to choose between opening
alocal file or amaster file. The master files are stored on the server.

Figure C-1
Data Entry Station dialog box

Data Entry Station

—what would you like to do?

(]9

b,
W Open & dats file Cancel

Mare Files...

il

Help

% LConnect to a magter file on the Data Entry Server
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Double-clicking More Files under Connect to a master file on the Data Entry Server will
open the Select Server Master File dialog box, which will allow you to specify aserver
address and view the names of the master files.

If you are using Builder or if you aready have Station open, you can connect to the
server by choosing Connect to Master File on the File menu, which will open the Select
Server Master File dialog box.

Figure C-2
Select Server Master File dialog box

Select Server Master File
Server name: e |
localhost -
I J Cancel |

i RefeshFile List

Master files: Help |

C:MEntry FileshCable T S atisfachion. saw
C:AEntry FileshCustomer S atisfachon. zav
C:AEntry Filesh\Employee Survey. zav

The first time that you connect to the server, you must set the server system address.
The server system address is the name or the | P address of the system on which the
Data Entry Network Server isinstalled. Contact your survey administrator if you do
not know the server system address. Once you have specified a server system address,
you will not have to do so again unless the server location changes or you need to
connect to a different network server on adifferent system.

Note: If you use the server name for the address, do not use slashes. For example, if the
server name is DESERVR, you should enter DESERVR. Your survey administrator
may specify a port number. If you should use DESERVR, port 1277, you should enter
DESERVR:1277 asthe address.

After you specify the server address, click the Refresh File List button. Then you can
select the master file that you want to open.

When you open afile on the server, you are actually creating alocal copy of thefile
without any casesinit. If you save the copy immediately, you can then access that copy
for subsequent entry sessions. This allows you to download the copy only once and
enter datafor aslong as the master fileis registered.
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To Connect to a Master File

» Inthe Station dialog box, double-click More Files under Connect to a master file on the
Data Entry Server.

or

» From the Station window menus choose:

File
Connect to Master File...

» Inthe Server dialog box, enter the server system’s name or | P address.
» Click the Refresh File List button.
» Inthe Master fileslist, double-click the file that you want to open.

» You can now enter cases into your copy of the master file.

Sending Cases Back to the Server

The datayou enter are stored in your copy of the master file. Periodically, you should
send your data back to the server. When you send casesto the server, they are stored in
the master file and are not available for recall or viewing.

When you begin asession, send your first completed case to the server to make sure
the server and the file are both available. Y ou can send cases to the server as often as
you wish. When you end the session, you will be asked if you want to save thefile.
Although you can save the file and send the cases back later (aslong as the registered
file has not changed), it is recommended that you send any remaining cases to the
server before ending a session.

Note: If you receive the error message Cannot connect to the Data Entry Server, you
should save your file locally. Contact your survey administrator. When the network
server isavailable, you should restart Builder or Station, open the local file, and send
your cases to the server.
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To Send Cases Back to the Server

» From the Form window menus choose;

Data
Send Case

or
Data
Send All Cases

» Alternatively, to send just one case, you can use the Send Case icon on the toolbar.

Note: After you send cases to the server, you are unable to access them.

Dealing with Send Failures

There may be occasionsin which you will receive notices of send failures. The server
may be unreachable, in which case you should try to send the cases at alater time.

If you receive awarning indicating that there is no matching master file on the
server, you should contact the survey administrator. It is possible that the master file
was moved or changed. Save your filelocally, since your survey administrator can use
the ADDFILES facility to combine the data with the file.
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Creating and Deploying a
Web Survey

With Data Entry Web Server, you can create surveys, deploy them on the Web, and
automatically manage your data collection and cleaning.

Data Entry Web Server works in conjunction with your Web server software and
our data collection server, known as the Network Server. Y our Web server displays
your survey asanorma HTML page. When an Internet user answers your survey and
submits the information, the Data Entry Web Server collects the data and sends it to
the Network Server, whereit is saved in amaster filein .sav format. When your
survey is complete, you can open the .sav file in SPSS for data analysis or in SPSS
Data Entry Builder for cleaning.

This appendix explores:

m Creating a survey for the Web
Rules and the Web

Exporting your fileto HTML
Registering amaster file

Deploying your survey on the Web

Creating a Survey for the Web

The processfor creating aform for the Web isthe same as that for creating any form.

Place questions on the form, define your variables, and, if you choose, create rules.
When you export aform to HTML, the questions on your form are exported in the

order in which they appear on theform. Questions are exported from left to right. The

299



300

Appendix D

order in which you create the questions and the tab order of the questions have no
bearing on the order of questionswhen they are exported. The browser controlsthe tab
order of questions.

Question numbers are exported. Lines and rectangles are not exported. If you want
toinclude linesin your HTML page, you can edit the HTML file.

When you create aform that you plan to export to HTML, you should keep in mind
certain browser limitations. Although you can achieve two-dimensional layout in
HTML, browsers do not support pinpoint placement of controls the way Builder does.
Also, do not overlap questions or place controls inside one another.

People are more likely tofill out aformif itiseasy to use. Following are sometipsfor
making an online form easier to use:

m The SPSS Data Entry Web Server works with Microsoft Internet Explorer
(versions 4.0 and higher). Although Netscape Navigator (versions 4.0 and higher)
isgenerally supported, certain versions may not function optimally. Y ou may want
to include atext annotation on your survey that tells users which browser to use.

m  Addinstructionsin text annotationsto aid the user. Y ou should instruct the user to
use the Previous Form and Next Form buttons to navigate between pages, instead of
the Web browser’ s Back and Next buttons. (The Previous Form and Next Form
buttons are created automatically when you export your survey to HTML.)

Note: If users use the Web browser’s Back and Next buttons, rules may not behave as
expected.

m  Break the form into pages by inserting forms.

m Design the form with plenty of white space so that it does not appear cluttered.
Unlike paper forms, you are not restricted to a single page or asingle form. You
can place many questions on a form and when the form appears in the browser,
respondents can scroll easily through the questions.

m  Avoid creating disabled questions, since there is no way to disable and enable
questions in the Web browser.

m Useonly theletters A—Z and numbers 0-9 in your filenames. Avoid using spaces.

m Linesandrectanglesarenot exportedto HTML. If youwant linesin your form, you
can edit the HTML file to include lines.

m If you want to password-protect your survey, ask your Webmaster or system
administrator to create alogin and password facility compatible with your Internet
server software. Y ou can a so specify that the survey is secure when you export. If
you do this, contact your Data Entry Enterprise Server administrator.
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Graphics and the Web

You can include graphics on aform you are designing for the Web. The graphic file
must bein either .jpg or .gif format.

When you export afile that contains images, the graphics files are copied to the
exported WebFilesfolder. The graphicsfiles are renamed according to their Form and
Name propertiesin Builder. For example, a graphics file may be named
FormilPicturel.jpg.

Tip: Use the Name property in the Properties window to change the default name for
pictures to something more descriptive or more closely matching the origina filename
of the graphic.

Defining Variables for a Web-Based Survey

Defining variablesfor aWeb-based survey isessentially the same as defining variables
for an online or paper-based survey. You specify the name and type of the variable and
can then specify variable values, missing values, and valid values.
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Figure D-1
Variable Properties General tab
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However, there is one mgjor difference in defining variables for Web-based surveys.
When you select the default value using the General tab of the Variable Properties
window, you may only use System missing or a defined number or string, such aso or
Internet user. Same as previous case and Increment previous by 1 are not supported in
surveyswhen exported to HTML and will be replaced with System missing during export.

Creating Rules for the Web

Rulesbehave dlightly differently for Web formsthan for conventional dataentry forms.
To account for these differences, you must set your Rule Options carefully. The specia
settings are as follows:
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Figure D-2
Rules Options dialog box
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Data Checking. \WWhen Data are checked automatically is selected, Validation rules are
activated when the I nternet user answersthe question, and Checking rules are activated
when the Internet user submits a case or uses the Next Page button to advance to
another form. If you do not select Data are checked automatically, your Validation and
Checking rules are not exported to HTML. If you select Data are checked when filled by
arule, Vaidation rules are activated when a question is filled as part of a Skip & Fill
rule. This setting is optional for forms that you want to export to HTML.

Action for Invalid New Data. You do not need to select Allow an override for new entries.
This option is hot applicable to Web forms. Allow new cases with checking rule violations
to be saved controls whether auser can submit a case when a Checking ruleisviolated.
How you set thisoptionisamatter of personal preference. However, you may want your
rules to be lenient for the Internet user, since people may not take the time to correct
answers and may just abandon the survey if their initial answers are not accepted.

Skip & Fill Properties. If Test Skip & Fill rules is not selected, none of your Skip & Fill
rules are exported to HTML. When a question loses focus and Upon tabbing from a field
are not applicable to rules on the Web.
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You should a so keep the following guidelinesin mind to create better rulesfor the Web:

m You are strongly encouraged to use the Rule Wizard to create rules that you plan
to export with Web surveys. Rules created with the Wizard will always work on
the Web.

m People are going tofill out surveysonly if they are easy to use and efficiently
designed. If you create rules that are too strict, you may not get a good response
rate because people may abandon a survey that is difficult or demanding.

m  Toavoid confusion when you use Checking rules, questionsthat are being checked
in relation to each other should appear on the same form.

m  When you create a Checking or Validation rule, always specify a custom alert
message that will make sense to aWeb user. In your custom alert, you should
specify the question number or question text aswell asahint that will help the user
enter acorrect value. Two examples are: Your answer to question 5 is invalid; please
enter a number only Or Your answer to the question “How old are you” is invalid; you
must enter a number between 1 and 100.

Note: Before exporting your fileto HTML, you should alwaystest your rulesin Builder
to ensure that they are working correctly.

Advanced Issues in Bule Creation

You can use the Rule Scripts window to create rules for the Web or to edit rules created
inthe RulesWizard. You must be familiar with JScript to create complex or custom rules,
and you should take special care in testing your rulesin Builder and then on the Web.

Note: You can use all functions, methods, and constants to create rules for the Web,
with the exception of the color constants. For example, NMiss, Any, or NotAny are
functions you can use in rules for the Web.

The following global methods are supported:
FormCount()
GetCurrentForm()

SetCurrentForm(name)
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The following global properties are supported:
Forms

Vars

The following properties and methods are supported for forms:
FormObjects

Name(+ Question, Set, Matrix Objects)

SetFocus()

GetFirstResponseGlyph()

GetNextResponseGlyph()

The following properties and methods are supported for questions:
Name

Varset

SetFocus()

GetDictltem()

The following properties and methods are supported for matrix questions:

Name(+ Question Objects)

The following properties and methods are supported for multiple response set
guestions:

Name(+ Question Objects)
VarSet
SetFocus()

GetDictltem()
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The following properties and methods are supported for variables:

Value

Name(only get...)
IsValid()
IsNotValid()
IsMissing()

IsLabeled()

To Export to HTML

» From the Builder menus choose:

File
Export
To HTML...

Figure D-3
Export to HTML dialog box
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In the Export to HTML diaog box, select the forms that you want to export.

If necessary, click the arrow buttons to change the order of the forms. The order in

which they appear on the list is the order in which they will be exported and linked
together with the Previous Form and Next Form buttons. The Previous Form and Next
Form buttons are created automatically when you export your survey to HTML.

Select the options for the chart export:

Prevent multiple submissions by the same user. This option prevents ballot stuffing.
When the user submits a survey, the Data Entry Web Server puts a cookie on the user's
computer to prevent the user from accessing the survey again.

Display the question focus marker. This option displays an arrow in the HTML survey
to indicate the current question.

Secure survey. This option limits access to the survey to only specific users. A user list
must be imported into the mySQL database for Data Entry Enterprise Server. For more
information about importing users, refer to the SPSS Data Entry Enterprise Server
Administrator's Guide. The user will be prompted for a user name and password when
accessing the Web survey. Secure surveys also provide users with a button for backing
up the user's current responses and stopping the survey. When the user logs back in, the
survey begins where the user left off.

Inthe DataEntry Collection Server section, typethe address of the Data Entry Network
Server—for example, deserver. If you do not know the address of the Network Server,
contact your system administrator.

Click OK.
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Exported Files

When you export to HTML, you create two folders: WebFiles and Master. The two
folders are created as subfolders of afolder named after the survey.

Figure D-4
Files for the Web server

& C:\Program Files\SP5S Data Entry\CustS at\WebFiles
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loadform.js
|& obizct(s) |264KE &

The files found in the WebFiles folder include:

Formname.jsp. For each form in the survey that you export, you generate a JavaServer
Page (JSP) file, which is named after a specific form. For example, if your survey
contains two forms named GenderFrom and AgeForm, the name of the JSP filesis
Gender Form.jsp and AgeForm.jsp, respectively.

Index.htm. Sets up the frames and controls how the form files are displayed in the
browser.

Thankyou.htm. Thefinal file that the user sees after submitting answers. You may want
to edit thisfileto display contact or company information or to provide additional links
to direct users after they have finished taking your survey. For example, you can
provide alink to take users back to your company’s home page.

Wait.htm. The message that the user seeswhilewaiting for the browser to load the survey.

Filename.js. A JavaScript (JS) filethat containsthe rulesfor the survey. It isnamed after
the name of the file you exported to HTML. For example, if the file you exported was
named CustSat.sav, the Java Script fileisnamed CustSat.js. You should not edit thisfile.
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Image Files. If your survey includes images, copies of the files are placed in the
WebFiles folder.

Figure D-5
Files for the network server

& C:\Program Files\SP55 Data Entry\CustS at\M aster
File Edit “iew Help
| 3 Master =l Bl $@E «| X
CustSat zav
CustS at.ser
|2 object(s) [120KE 4

The files found in the Master folder include:

Filename.ser. Animportant filethat must reside with the .sav filein order to collect data
properly.

Filename.sav. When you export afileto HTML, you create acopy of your original data
entry file (.sav) in the Master folder. Thisisthefile that you will register as a master
file on the Network Server.

Filename.js. For each file that you export, you generate a JavaScript (JS) file, whichis
named after your file. For example, if the name of your fileis WebSurvey, the name of
your JSfile is WebSurvey.js.

Note: The original file remains on your system after your export to HTML, in addition
to the copy in the Master folder. If you want to make substantial changes, such as
deleting avariable, you should delete your exported folders, open your original filein
Builder, make the changes, and export your fileto HTML. When making changes, itis
recommended that you edit your original .sav file and reexport instead of editing the
copy of the survey created during the export process.
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Export Log

Figure D-6
Export log

Export To HTML : Complete

Your survey has been exported to HTML

Save Log.. Frint Log

Ok |

Log started Tuesday, June 08, 1939 10:07
Files created during the process :
File 'C:\Program FileshSPSS Data EntryhCustS athwebFilesindes_ htm'
File 'C:\Program Filez\5P55 Data EntohCustS athw'ebFileghmeszage. him'
File 'C:\Program FileshSPSS Data Entryh CustS atvwebFiles\CustS at s’
File 'C:\Program Filez\5P55 Data EntihCustS athw'ebFileghawait, him'
File 'C:\Program FileshSPSS Data Entryh CustS athwebFiles \thankpou. htm'
File 'C:\Program Filez5PS5 Data EntihCustS athw'ebFileshiw/ebS urvep. him'
File 'C:\Program FileshSPSS D ata Entny\CustSathMasters\CustS at. zer’
File 'C:\Program Filez\5P55 Data EntihCustS athwebFileshepzawcl jar'
File 'C:\Program FileshSPSS Data EntryhCustS athhd aster\CustS at savy'
Log stopped Tuesday. June 08, 1999 10:07

You can use the export log as a diagnostic tool for examining problems with your
exported forms and also to see exactly what was and was not exported.

After you export your fileto HTML, you can view the log by clicking the View Log
button in the Export Statusdial og box and save the log by clicking the Save Log button.
It is recommended that you save your logs with unique names to avoid overwriting
previous logs.
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Editing Your HTML

Once you export your fileinto HTML, you can view thefile locally on your browser
by dragging the file from an Explorer window into your browser. Open filename.htm
instead of index.htm becauseindex.htmwill not allow you to see your questions. If you
want to make changesto theway it looks, you can edit the HTML file. Before you edit
your HTML file, you should save a copy of it.

Y ou can edit your HTML filesin an HTML editor or in atext editor. When
manually editing HTML files, you should make only minor or cosmetic changes. For
example, you can add lines to enhance the appearance of your survey or change the
colors. If you want to make substantial changes, such as deleting a question or
changing the order of the questions, you should delete your exported folders, open the
origina filein Builder, make your revisions, and reexport the fileto HTML.

Deploying Your Survey Online

Deploying your survey online is a two-step process.
m  Register your dataentry file as a master file on the Network Server.
m  Place the WebFiles folder in your Web server’s public HTML directory.

Registering Your Master File

In order to receive datainto your file, you must register it as a master file on the
Network Server.

To register amaster file, the following conditions must be met:

m  Thefile must be adata entry file created in release 1.0.4 or later of Builder.

m |f thefileisstored anywhere other than the server system, you must map adriveto
that system.

® You must have physical accessto the server to register a master file.

To access the Network Server, double-click the SPSS Data Entry Network Server icon
in the Control Panel.
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To Register a Master File

» From the Windows Start menu choose:

Settings
Control Panel

» Double-click the SPSS Data Entry Network Server icon.
» OntheFilestab of the Server dialog box, click the Add button.
» Inthedialog box, browse to find the file you want to register as a master file.

> Select thefile and click Open.

Note: I thefile you want to register is stored anywhere other than on the server system,
you must map adrive to that system.

For more information on registering files and the Network Server, see Appendix A.

Deploying Your Survey on the Web

After you export your datafileto HTML, you must place the WebFiles folder in your
Web server’s designated public directory, which is the area where your Web server
software storesthefilesit displays on the Web. If you do not know which directory this
is, contact your system administrator. Once the survey isdeployed on the Web, you can
then publicize the link. Internet users will take the survey and submit the datato the
Web server, which will then transmit the datato the master file on the Network Server,
whereit is saved in SPSS format.

If the survey designer identified the survey as a secure survey when exporting it to
HTML, users must enter the correct user names and passwords before being able to
accessthe survey. Additionally, users can exit the secure survey at any timeby clicking
Stop and return later. Clicking this button saves the user’ s responses up to that point.
When the user logs back in to the survey, the survey starts where the user |eft off.
Clicking Stop and return later does not transmit the survey responses to the master file.

Completion of Data Collection

Once you have completed your Web survey, you can clean your datain Builder or
SPSS, or you can analyze them in SPSS.
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